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Safety warning notice

/A WARNING! To reduce the possibility of heat-related injuries or of overheating the computer, do not
place the computer directly on your lap or obstruct the computer air vents. Use the computer only on a
hard, flat surface. Do not allow another hard surface, such as an adjoining optional printer, or a soft
surface, such as pillows or rugs or clothing, to block airflow. Also, do not allow the AC adapter to contact
the skin or a soft surface, such as pillows or rugs or clothing, during operation. The computer and the
AC adapter comply with the user-accessible surface temperature limits defined by the International
Standard for Safety of Information Technology Equipment (IEC 60950).
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1 Product description

Category Description 14” UMA/ 14” UMA/ 14~ 15.6” 15.6” 15.6”
GL40 GL45 discrete UMA/ UMA/ discrete
GL40 GL45
Product HP ProBook 4410s Notebook N
Name PC
HP ProBook 4411s Notebook N
PC
HP ProBook 4510s Notebook \/ N N
PC
Processors Intel® Core™2 Duo processors
e T96002.80-GHz, 6-MBL2 < N N N N N
cache, 1066-MHz front
side bus (FSB)
e T94002.53-GHz,6-MBL2 < N N N N N
cache, 1066-MHz FSB
e P87002.53-GHz,3-MBL2 < N \/ \/ N N
cache, 1066-MHz FSB
e P86002.40-GHz,3-MBL2 < N N N N N
cache, 1066-MHz FSB
e P75702.26-GHz, 3-MBL2 N N N N
cache, 1066-MHz FSB
e P73702.0-GHz,3-MBL2 < N N N N N
cache, 1066-MHz FSB
e T66702.2-GHz, 2-MB L2 N \/ N N
cache, 800-MHz FSB
e T65702.1-GHz, 2-MB L2 < N N N N N
cache, 800-MHz FSB
e T58702.0-GHz, 2-MB L2 < N N N N N
cache, 800-MHz FSB
Intel Celeron® M processors
e 9002.20-GHz, 1-MBL2 < N N N
cache, 800-MHz FSB
e 5852.16-GHz,2-MBL2 < \/ \/ N

cache,800-MHz FSB

Intel Pentium® Dual-Core processors




Category Description 14” UMA/ 14” UMA/ 14~ 15.6” 15.6” 15.6”

GL40 GL45 discrete UMA/ UMA/ discrete
GL40 GL45
e T44002.2-GHz, 1-MBL2 RN v v N \/
cache, 800-MHz FSB
e  T43002.1-GHz, 1-MBL2 v v v N N
cache, 800-MHz FSB
e  T42002.0-GHz, 1-MB L2 v v v N N

cache, 800-MHz FSB

Intel Celeron Dual-Core processors

e T31001.9-GHz, 1-MBL2 v v N
cache, 800-MHz FSB

e T30001.8-GHz, 1-MB L2 v v N
cache, 800-MHz FSB

e T17001.83-GHz,1-MBL2 < v v N
cache, 667-MHz FSB

e T16001.66-GHz,1-MBL2 + v v N
cache, 667-MHz FSB

Chipsets Northbridge: Intel GL40 with up v
to 667-MHz FSB

Northbridge: Intel GM45 with up v v
to 1066-MHz FSB

Northbridge: Intel PM45 with up v v
to 1066-MHz FSB

Southbridge: Intel ICHOM v v v N N N

Graphics Intel Universal Memory v v v N
Architecture (UMA) graphics
subsystem integrated with
shared video memory
(dynamically allocated)

AMD Discrete Graphics ATI- v 3
M92S2LP w/Hypermemory
support
Panels All display assemblies support v v v v N
privacy filter
e  14.0-in HD AntiGlare v v v
e  14.0-in HD BrightView \ \ \
e  14.0-in HD AntiGlare with V V
webcam
e  14.0-in HD BrightView \ \ \
with webcam
e  15.6-in HD BrightView v N N
e  15.6-in HD BrightView v N N

with webcam

e  15.6-in HD BrightView v v \/
with webcam and WWAN
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Category Description 14” UMA/ 14” UMA/ 14" 15.6” 15.6” 15.6”
GL40 GL45 discrete UMA/ UMA/ discrete
GL40 GL45
e  15.6-in HD+ AntiGlare y J J
with webcam
e  15.6-in HD+ AntiGlare x/ J J
with webcam and WWAN
Memory 2 customer-accessible/ N N N N N N
upgradable memory module
slots
Supports dual-channel memory \/ v v J J
Supports up to 4 GB of system v
RAM
Supports up to 8 GB of system \/ N \/ \/
RAM
PC2-5300, 800-MHz, DDR2 V V 3 x/ V V
Supports the following N N N N
configuration in all countries
and regions except Brazil:
e  8192-MB total system
memory (4096 x 2, dual-
channel)
Supports the following \/ N \/ \

configurations in all countries
and regions except Brazil:

e  4096-MB total system
memory (4096 x 1, dual-
channel)

e  4096-MB total system
memory (2048 x 2, dual-
channel)

e  3072-MB total system
memory (2048 + 1024)

e  2048-MB total system
memory (1024 x 2, dual-
channel)

e  2048-MB total system
memory (2048 x 1)

e  1024-MB total system
memory (1024 x 1)




Category Description 14” UMA/ 14” UMA/ 14~ 15.6” 15.6” 15.6”

GL40 GL45 discrete UMA/ UMA/ discrete
GL40 GL45
Supports the following v v v \/
configurations only in Brazil:
e  3072-MB total system
memory (2048 x 1024,
dual-channel)
e  2048-MB total system
memory (2048 x 1)
e  2048-MB total system
memory (1024 x 2, dual-
channel)
e  1024-MB total system
memory (1024 x 1)
PC3-10600, 1333-MHz, DDR3 \ y y 3 V
Supports the following v v N N
configurations in all countries
and regions except Brazil:
e  8092-MB total system
memory (4096 x 2, dual-
channel)
Supports the following v v v v N N
configurations in all countries
and regions except Brazil:
e  4096-MB total system
memory (4096 x 1)
e  4096-MB total system
memory (2048 x 2, dual-
channel)
e  3072-MB total system
memory (2048 + 1024,
dual-channel)
e  2048-MB total system
memory (2048 x 1)
e  2048-MB total system
memory (1024 x 2, dual-
channel)
° 1024-MB total system
memory (1024 x 1)
Supports the following \ \ y y y y

configurations only in Brazil:

e  3072-MB total system
memory (2048 + 1024,
dual-channel)

e  2048-MB total system
memory (2048 x 1)
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Category Description 14” UMA/ 14” UMA/ 14" 15.6” 15.6” 15.6”
GL40 GL45 discrete UMA/ UMA/ discrete
GL40 GL45
Hard drives  Supports 9.5-mm, 6.35-cm \/ \/ v v \/ J
(2.50-in) hard drives
Customer-accessible \/ \/ N N \/ \/
Serial ATA J J v v J J
Supports the following drives: \/ v v J J
° 500-GB, 7200-rpm
e 500-GB, 5400-rpm
e 320-GB, 7200-rpm
° 320-GB, 5400-rpm
e  250-GB, 7200-rpm
e 250-GB, 5400-rpm
e 160-GB, 7200-rpm
e 160-GB, 5400-rpm
HP 3D DriveGuard (not v v v v v v
available on Linux)
Optical drives  Fixed v v v v J J
12.7-mm tray load \/ \/ v 3 \/ V
Supports option of no optical v N N N N N
drive
Supports the following drives:
e DVD-ROM Drive V 3 v v v v
e DVDRW and CD-RW V 3 v v v v
SuperMulti Double-Layer
Combo Drive with
Lightscribe
e  Blu-ray ROM DVD+RW V v V V
SuperMulti DL Drive
Diskette drive Supports external USB diskette \/ v v \/ \/
drive only
Audio HD audio - ADI1984 J J v V J J
Modem 56K V.92 3.8 cm (1.5-in) data/ v v v v J
fax modem
Supports no modem option N N N N N N
Ethernet 10/100/1000 Ethernet network J v V J J
interface card (NIC)
$3/S4/S5 wake on LAN: AC - v v v v v
yes
Wireless Integrated WLAN options by way of wireless module:
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Category Description 14” UMA/ 14” UMA/ 14~ 15.6” 15.6” 15.6”
GL40 GL45 discrete UMA/ UMA/ discrete
GL40 GL45
2 WLAN antennas built into v v v v v v
display assembly
Support for no-WLAN option v v v v N N
Support for the following WLAN v/ v v v N N
formats:
e Broadcom 802.11a/b/g/n
e  Broadcom 802.11b/g
e Intel 802.11 a/blg v v v v \/ \/
e Intel 802.11 a/b/g/n
e Intel Wi-Fi Link 1000, 3 3 3 3 v v
802.11b/g
e Intel Wi-Fi Link 1000,
802.11 b/g/n
Integrated personal area network (PAN) options by way of Bluetooth® module:
Support for no-WPAN option v v v N N
Bluetooth 2.1 x/ \/ \/ \/ v v
Bluetooth 2.0 x/ \/ \/ \/ v v
Integrated WWAN options by way of HP Mobile Broadband Module:
WWAN module UNDP with 2 3 v v
antennas (not available with
Linux)
External One ExpressCard/54 slot v v v v N N
media cards
Media Card Reader supporting v v v v v
Memory Stick (MS), Memory
Stick Pro (MSP), Secure Digital
(SD) Memory Card, Secure
Digital High Capacity (SDHC)
Memory Card, MultiMediaCard
(MMC), and xD-Picture Card
formats
Ports Audio-in (stereo microphone) v v v N N
Audio-out (stereo headphone) v v v v v
RJ-11 (modem) v v v v v v
RJ-45 (Ethernet, includes link v v v N N
and activity lights)
USB 2.0 (4) v v v v \/ \/
VGA (Dsub 15-pin) supporting \ \ \ V 3

1600 x 1200 external resolution
at 75-GHz (hot plug/unplug with
auto-detect)
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Category

Description

14” UMA/
GL40

14” UMA/
GL45

14”
discrete

15.6”
UMA/
GL40

15.6”
UMA/
GL45

15.6”
discrete

Multi-pin AC power

\/

\/

HDMI

\/

\/

Keyboard/
pointing
devices

14.0-in keyboard with
TouchPad

15.6-in keyboard with
TouchPad

TouchPad only, with 2
TouchPad buttons and vertical
scrolling (taps enabled as
default)

Power
requirements

65-W AC adapter with localized
cable plug support (3-wire plug
with ground pin)

90-W AC adapter with localized
cable plug support (3-wire plug
with ground pin)

6-cell, 47-Wh Li-ion battery

8-cell, 63-Wh Li-ion battery

6-cell, 47-Wh Li-ion battery

Security

Supports Kensington security
lock

Operating
system

Preinstalled with Microsoft®
Office:

Windows 7 Home Basic 32 with
Office 2007 Ready (excludes
Japan)

Windows 7 Home Premium 32
with Office 2007 Ready
(excludes Japan)

Windows 7 Home Premium 32
E with Office 2007 Ready
(excludes Japan)

Windows 7 Home Premium 32
with Office 2007 Personal
(Japan only)

Windows 7 Home Premium 32
E with Office 2007 Personal
with PowerPoint (Japan only)

Windows 7 Home Premium 32
with Office 2007 Professional
(Japan only)

Windows 7 Professional with
Office 2007 Ready (excludes
Japan)
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Category

Description

14” UMA/
GL40

14” UMA/
GL45

14”
discrete

15.6”
UMA/
GL40

15.6”
UMA/
GL45

15.6”
discrete

Windows 7 Professional with
Office 2007 Ready (excludes
Japan)

\/

Windows 7 Professional with
Office 2007 Personal (Japan

only)

Windows 7 Professional with
Office 2007 Personal with
PowerPoint (Japan only)

Windows 7 Professional with
Office 2007 Professional
(Japan only)

Windows Vista® Home Basic
32 with Office 2007 Ready

Windows Vista Home Basic 32
with Office 2007 Personal
(Japan only)

Windows Vista Home Basic 32
with Office 2007 Personal with
PowerPoint (Japan only)

Windows Vista Home Basic 32
with Office 2007 Professional
(Japan only)

Windows Vista Home Premium
32 with Office 2007 Ready

Windows Vista Business 32
with Office 2007 Ready

Windows Vista Business 32
with Office 2007 Personal
(Japan only)

Windows Vista Business 32
with Office Personal with
PowerPoint (Japan only)

Windows Vista Business 32
with Office Professional (Japan
only)

Windows Vista Business 32
(with XP Pro images) with
Office 2007 Ready

Windows Vista Business 32
(with XP Pro images) with
Office 2007 Personal (Japan
only)

Windows Vista Business 32
(with XP Pro images) with
Office 2007 Personal with
PowerPoint (Japan only)
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Category Description 14” UMA/ 14” UMA/ 14" 15.6” 15.6” 15.6”

GL40 GL45 discrete UMA/ UMA/ discrete
GL40 GL45

Windows Vista Business 32 N N N N N \/
(with XP Pro images) with
Office 2007 Professional
(Japan only)
SuSE Linux d V \/ \/ V V
Preinstalled:
Windows 7 Professional 32 N N N N N N
(Japan only)
Windows 7 Home Premium 32 N N N N \/
(Japan only)
Windows Vista Home Basic 32 N N N N N
with MS Basics (Japan only)
Windows Vista Business 32 N N N N N N
with MS Basics (Japan only)
Windows Vista Business 32 N N N N N \/
(with XP Professional images)
with MS Basics (Japan only)
FreeDOS N N N N N N
RedFlag Linux (People's \/ \/ N N \/ \/

Republic of China only)

Restore media:

Windows 7 Home Basic 32 N N N N N N
Windows 7 Home Premium 32 N ~ N N N
Windows 7 Home Premium 64 N \/ N N N
Windows 7 Professional 32 \/ v ~ N N N
Windows 7 Professional 64 N N N N N N
DRDVD Windows 7 N N N N N N
Windows Vista Home Basic 32 y N N N N
Windows Vista Home Premium N N N N N
Windows Vista Business 32 \/ N N N N N
Windows® XP Professional N N N N N N
SuSE Linux \ N N N N N
Red Flag Linux (in the People's N \ ~ N N N
Republic of China only)

DRDVD Windows Vista V N N N N N
DRDVD Windows XP Pro N N N N N N
Windows Vista Office Ready N N N N N N

DVD




Category Description 14” UMA/ 14” UMA/ 14~ 15.6” 15.6” 15.6”

GL40 GL45 discrete  UMA/ UMA/ discrete
GL40 GL45
Certified: Microsoft® WHQL v v v v v
Web Support: \/ \/ \/ \/ \/ \/
All Windows Vista versions y y y y y \/
Windows XP Professional v v v v v v
SUSE Linux v v v v v v
Serviceability End-user replaceable parts:
AC adapter v v v N
Battery (system) v v v N
Hard drive \ \ \ y
Memory module v v v N
Optical drive v v v v
WLAN module v v v v
WWAN module v v v
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2 External component identification

Windows Vista and Windows XP

Display

Bf NOTE: Your computer may look slightly different from the illustration in this section.

Q

Component Description
(1) Internal display switch Turns off the display if the display is closed while the power is on.
(2) Internal microphone Records sound.

(3) Webcam light (select models only)

On: The webcam is in use.

(4) Webcam (select models only)

Records audio and video and captures still photographs.

Windows Vista and Windows XP 11



Top components

Pointing devices

1 3
2 4
Component Description

(1) TouchPad*

Moves the pointer and selects or activates items on the screen.

(2) Left TouchPad button*

Functions like the left button on an external mouse.

(3) TouchPad scroll zone

Scrolls up or down.

(4) Right TouchPad button*

Functions like the right button on an external mouse.

*This table describes factory settings.

To view or change pointing device preferences in Windows Vista, select Start > Control Panel > Hardware and Sound >
Mouse. To view or change pointing device preferences in Windows XP, select Start > Control Panel > Printers and Other

Hardware > Mouse.
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Lights

Bf NOTE: Your computer may look slightly different from the illustration in this section.

Component

Description

()

Caps lock light

On: Caps lock is on.

)

Info Center/QuickLook light

On: The computer is on.
Blinking (5 times):

° When the computer is on, press button to launch Info
Center.

° When the computer is off or in Hibernation, press button
to launch QuickLook.

Off: The computer is off or in the Sleep state (Windows Vista)
or Standby (Windows XP).

()

Power light

On: The computer is on.

Blinking: The computer is in the Sleep state (Windows Vista)
or Standby (Windows XP).

Off: The computer is off or in Hibernation.

Windows Vista and Windows XP 13



Buttons, switches, and speakers

B NOTE: Your computer may look slightly different from the illustration in this section.

Component

Description

(1)

Speakers (2)

Produce sound.

(2

Internal display switch

Turns off the display if the display is closed while the power is on.

(3)

Info Center/Quick Look button

Launches Info Center or QuickLook.

4

Power button

e  When the computer is off, press the button to turn on the
computer.

e  When the computer is on, press the button to shut down the
computer.

e  When the computer is in the Sleep state (Windows Vista) or
Standby (Windows XP), press the button briefly to exit Sleep
or Standby.

e  When the computer is in Hibernation, press the button briefly
to exit Hibernation.

If the computer has stopped responding and Windows shutdown
procedures are ineffective, press and hold the power button for at
least 5 seconds to turn off the computer.

To learn more about your power settings and how to change them,
select Start > Control Panel > System and Maintenance >
Power Options.
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Keys

Bf NOTE: Refer to the illustration that most closely matches your computer.

&)

—

Component Description

(1) esc key Displays system information when pressed in combination with the
fn key.

(2) fn key Executes frequently used system functions when pressed in
combination with a function key, the num Ik key, or the esc key.

(3) Windows logo key Displays the Windows Start menu.

(4) Windows applications key Displays a shortcut menu for items beneath the pointer.

(5) Embedded numeric keypad keys When the keypad has been enabled, the keys can be used like the
keys on an external numeric keypad.

(6) Function keys Execute frequently used system functions when pressed in

combination with the fn key.

Windows Vista and Windows XP
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Component Description

(1) esc key Displays system information when pressed in combination with the
fn key.

(2) fn key Executes frequently used system functions when pressed in
combination with a function key or the esc key.

(3) Windows logo key Displays the Windows Start menu.

(4) Windows applications key Displays a shortcut menu for items beneath the pointer.

(5) Integrated numeric keypad keys Can be used like the keys on an external numeric keypad.

(6) Function keys Execute frequently used system functions when pressed in

combination with the fn key.
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Front components

Component

Description

(1) Drive light

e  Blinking turquoise: The hard drive or optical drive is being
accessed.

e  Amber: HP 3D DriveGuard has temporarily parked the hard
drive.

(2) Wireless switch

Turns the wireless feature on or off but does not establish a
wireless connection.

NOTE: You mustsetup oraccess a wireless network to establish
a wireless connection.

(3) Wireless light

° Blue: An integrated wireless device, such as a wireless local
area network (WLAN) device and/or a Bluetooth device, is on.

e  Amber: All wireless devices are off.

(4) Media Card Reader

Supports the following optional digital card formats:

e  Memory Stick (MS)

° Memory Stick Pro (MSP)

e  MultiMediaCard (MMC)

° MultiMediaCard 4.2 (MMC Plus, including MMC Plus HC)
e  Secure Digital (SD) Memory Card

e  Secure Digital High Capacity (SDHC) Memory Card

e  Secure Digital High Speed (SDHS) Memory Card

e  xD-Picture Card (XD)

e  xD-Picture Card (XD) Type H

e  xD-Picture Card (XD) Type M

(5) Audio-out (headphone) jack

Produces sound when connected to optional powered stereo
speakers, headphones, ear buds, a headset, or television audio.

NOTE: When a device is connected to the headphone jack, the
computer speakers are disabled.

(6) Audio-in (microphone) jack

Connects an optional computer headset microphone, stereo array
microphone, or monaural microphone.

Windows Vista and Windows XP
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Right-side components

Component

Description

1) USB ports (2)

Connect optional USB devices.

(2) RJ-11 (modem) jack (select models only)

Connects a modem cable.

(3) Optical drive (select models only)

Reads optical discs and, on select models, also writes to optical
discs.

(4) Optical drive light (select models only)

Blinking: The optical drive is being accessed.

(5) Battery light

Amber: A battery is charging.
Turquoise: A battery is close to full charge capacity.

Blinking amber: A battery that is the only available power
source has reached a low battery level. When the battery
reaches a critical battery level, the battery light begins blinking
rapidly.

Off: If the computer is plugged into an external power source,
the light turns off when all batteries in the computer are fully
charged. If the computer is not plugged into an external power
source, the light stays off until the battery reaches a low
battery level.

(6) Power connector

Connects an AC adapter.
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Left-side components

Component

Description

()

ExpressCard slot

Supports optional ExpressCards.

)

Security cable slot

Attaches an optional security cable to the computer.

NOTE: The security cable is designed to act as a deterrent, but
it may not prevent the computer from being mishandled or stolen.

(&)

RJ-45 (network) jack

Connects a network cable.

(4)

Vent

Enables airflow to cool internal components.

NOTE: The computer fan starts up automatically to cool internal
components and prevent overheating. It is normal for the internal
fan to cycle on and off during routine operation.

&)

External monitor port

Connects an external VGA monitor or projector.

(6)

HDMI port

Connect an optional HDMI device.

(@)

USB ports (2)

Connect optional USB devices.

Windows Vista and Windows XP
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Bottom components

Component Description
1) Battery release latches (2) Release the battery from the battery bay.
(2) Battery bay Holds the battery.
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Wireless antennas

Component Description

(1) WWAN antennas (2)* (select models only) Send and receive wireless signals to communicate with wireless
wide-area networks (WWAN).

(2) WLAN antennas (2)* Send and receive wireless signals to communicate with wireless
local area networks (WLAN).

*To see wireless regulatory notices, refer to the section of the Regulatory, Safety and Environmental Notices that applies to
your country or region. These notices are located on the User Guide disc that has been provided with your computer.

Bf NOTE: The antennas are not visible from the outside of the computer. For optimal transmission, keep
the areas immediately around the antennas free from obstructions.
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Additional hardware components

F

Component Description
(1) Power cord* Connects an AC adapter to an AC outlet.
(2) Battery* Powers the computer when the computer is not plugged into

external power.

(3) AC adapter Converts AC power to DC power.

*Batteries and power cords vary in appearance by country or region.
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Linux

Display

Bf NOTE: Your computer may look slightly different from the illustration in this section.

®

Component

Description

()

Internal display switch

Turns off the display if the display is closed while the power is on.

)

Internal microphone

Records sound.

()

Webcam light (select models only)

On: The webcam is in use.

(4)

Webcam (select models only)

Records audio and video and captures still photographs.

Linux
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Top components

Pointing devices

1 3
2 4
Component Description

1) TouchPad

Moves the pointer and selects or activates items on the screen.

(2) Left TouchPad button

Functions like the left button on an external mouse.

(3) TouchPad scroll zone

Scrolls up or down.

(4) Right TouchPad button

Functions like the right button on an external mouse.
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Lights

Bf NOTE: Your computer may look slightly different from the illustration in this section.

Component Description
(1) Caps lock light On: Caps lock is on.
(2) Info Center/QuickLook light e  On: The computer is on.

e  Blinking (5 times):

° When the computer is on, press button to launch Info
Center.

° When the computer is off or in Hibernation, press button
to launch QuickLook.

e  Off: The computer is off or in the Suspend or Hibernation state.

(3) Power light e  On: The computer is on.
e  Blinking: The computer is in Suspend.

e  Off: The computer is off or in Hibernation.
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Buttons, switch, and speakers

B NOTE: Your computer may look slightly different from the illustration in this section.

Component

Description

(1)

Speakers (2)

Produce sound.

(2

Internal display switch

Turns off the display if the display is closed while the power is on.

(3)

Info Center/QuickLook button

Launches Info Center or QuickLook.

4

Power button

e  When the computer is off, press the button to turn on the
computer.

e  When the computer is on, press the button to shut down the
computer.

e  When the computer is in Suspend, press the button briefly to
exit Suspend.

e  When the computer is in Hibernation, press the button briefly
to exit Hibernation.

If the computer has stopped responding and operating system
shutdown procedures are ineffective, press and hold the power
button for at least 5 seconds to turn off the computer.

To learn more about your power settings and how to change them,
select Computer > Control Center > System > Power
Management.
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Keys

Bf NOTE: Refer to the illustration that most closely matches your computer.

Component Description

(1) esc key Displays system information when pressed in combination with the
fn key.

(2) fn key Executes frequently used system functions when pressed in
combination with a function key, the num Ik key, or the esc key.

(3) Function keys Execute frequently used system functions when pressed in

combination with the fn key.

(4)

Embedded numeric keypad keys

When the keypad has been enabled, the keys can be used like the
keys on an external numeric keypad when pressed in combination
with the fn and num Ik keys.

Linux
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Component Description

(1) esc key Displays system information when pressed in combination with the
fn key.

(2) fn key Executes frequently used system functions when pressed in

combination with a function key or the esc key.

(3) Function keys

Execute frequently used system functions when pressed in
combination with the fn key.

(4) Integrated numeric keypad keys

Can be used like the keys on an external numeric keypad.

Front components

Component

Description

(1) Drive light

Blinking turquoise: The hard drive or optical drive is being
accessed.

(2) Wireless switch

Turns the wireless feature on or off but does not establish a
wireless connection.

NOTE: You mustsetup oraccess a wireless network to establish
a wireless connection.

(3) Wireless light

e  Blue: An integrated wireless device, such as a wireless local
area network (WLAN) device and/or a Bluetooth device, is on.

e  Amber: All wireless devices are off.

(4) Media Card Reader

Supports the following optional digital card formats:

e  Memory Stick (MS)

e  Memory Stick Pro (MSP)

e  MultiMediaCard (MMC)

e  MultiMediaCard 4.2 (MMC Plus, including MMC Plus HC)
e  Secure Digital (SD) Memory Card

e  Secure Digital High Capacity (SDHC) Memory Card

e  Secure Digital High Speed (SDHS) Memory Card

e  xD-Picture Card (XD)

e  xD-Picture Card (XD) Type H

o  xD-Picture Card (XD) Type M

28 Chapter 2 External component identification



Component

Description

®)

Audio-out (headphone) jack

Produces sound when connected to optional powered stereo
speakers, headphones, ear buds, a headset, or television audio.

NOTE: When a device is connected to the headphone jack, the
computer speakers are disabled.

(6)

Audio-in (microphone) jack

Connects an optional computer headset microphone, stereo array
microphone, or monaural microphone.

Right-side components

Component

Description

()

USB ports (2)

Connect optional USB devices.

()

RJ-11 (modem) jack (select models only)

Connects a modem cable.

(3)

Optical drive (select models only)

Reads optical discs and, on select models, also writes to optical
discs.

(4)

Optical drive light (select models only)

Blinking: The optical drive is being accessed.

©)

Battery light

e  Amber: A battery is charging.
e Turquoise: A battery is close to full charge capacity.

e Blinking amber: A battery that is the only available power
source has reached a low battery level. When the battery
reaches a critical battery level, the battery light begins blinking
rapidly.

e  Off: If the computer is plugged into an external power source,
the light turns off when all batteries in the computer are fully
charged. If the computer is not plugged into an external power
source, the light stays off until the battery reaches a low
battery level.

(6)

Power connector

Connects an AC adapter.

Linux
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Left-side components

Component

Description

(1)

ExpressCard slot

Supports optional ExpressCards.

)

Security cable slot

Attaches an optional security cable to the computer.

NOTE: The security cable is designed to act as a deterrent, but
it may not prevent the computer from being mishandled or stolen.

@)

RJ-45 (network) jack

Connects a network cable.

(4)

Vent

Enables airflow to cool internal components.

NOTE: The computer fan starts up automatically to cool internal
components and prevent overheating. It is normal for the internal
fan to cycle on and off during routine operation.

(5

External monitor port

Connects an external VGA monitor or projector.

(6)

HDMI port

Connects an optional HDMI device

™

USB ports (2)

Connect optional USB devices.
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Bottom components

Component Description
(1) Battery release latches (2) Release the battery from the battery bay.
(2) Battery bay Holds the battery.
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Wireless antennas

Component Description

(1) WWAN antennas (2)* (select models only) Send and receive wireless signals to communicate with wireless
wide-area networks (WWAN).

(2) WLAN antennas (2)* Send and receive wireless signals to communicate with wireless
local area networks (WLAN).

*To see wireless regulatory notices, refer to the section of the Regulatory, Safety and Environmental Notices that applies to
your country or region. These notices are located on the User Guide disc that has been provided with your computer.

Bf NOTE: The antennas are not visible from the outside of the computer. For optimal transmission, keep
the areas immediately around the antennas free from obstructions.
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Additional hardware components

07

Component Description
(1) Power cord* Connects an AC adapter to an AC outlet.
(2) Battery* Powers the computer when the computer is not plugged into

external power.

(3) AC adapter Converts AC power to DC power.

*Batteries and power cords vary in appearance by country or region.
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3 lllustrated parts catalog

Service tag

When ordering parts or requesting information, provide the computer serial number and model
description provided on the service tag.

(1) Product name: This is the product name affixed to the front of the computer.
(2) Serial number (s/n): This is an alphanumeric identifier that is unique to each product.

(3) Part number/Product number (p/n): This number provides specific information about the product's
hardware components. The part number helps a service technician to determine what components and
parts are needed.

(4) Model description: This is the alphanumeric identifier used to locate documents, drivers, and support
for your computer.

(5) Warranty period: This number describes the duration of the warranty period for this computer.

- product & X0000000000 00000
= sin 2 xocococoees  NHHTINNRTRNAEER0NNETH
L pn 2 sk xxsooc ][I A0 L

Tha) Service | xxoouoo
. tag | warranly x year
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Computer major components

Item

Description Spare part number

()

Display assembly (includes 2 WLAN antenna transceivers and cables and, on select computer models, 2 WWAN
antenna transceivers and cables)

NOTE: WWAN is available only on 15.6-in models.

For use only with black computers with 15.6-in displays

e  15.6-in HD WXGA BrightView display assembly (1366x768 resolution) 535850-001

e  15.6-in HD WXGA BrightView display assembly for use in computers equipped with a 535853-001
webcam (1366x768 resolution)
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Item Description Spare part number

e  15.6-in HD WXGA BrightView display assembly for use in computers with a webcam and 535854-001
WWAN module (1366x768 resolution)

e  15.6-in HD WXGA AntiGlare display assembly (1366x768 resolution) 535849-001

e  15.6-in WXGA HD AntiGlare display assembly for use on computers equipped with a 535851-001
webcam (1366%768 resolution)

e  15.6-in WXGA HD+ AntiGlare display assembly for use on computers equipped witha  535855-001
webcam (1600x900 resolution)

e  15.6-in WXGA HD AntiGlare display assembly for use in computers with a webcam and 535852-001
a WWAN module (1366%768 resolution)

e  15.6-in WXGA HD+ AntiGlare display assembly for use in computers with a webcam and 535856-001
a WWAN module (1600%900 resolution)

For use only with red computers with 15.6-in displays

e  15.6-in HD WXGA BrightView display assembly (1366x768 resolution) 572716-001

° 15.6-in HD WXGA BrightView display assembly for use in computers equipped with a 572719-001
webcam (1366x768 resolution)

e  15.6-in HD WXGA BrightView display assembly for use in computers with a webcam and 572720-001
WWAN module (1366x768 resolution)

e  15.6-in HD WXGA AntiGlare display assembly (1366%768 resolution) 572715-001

e 15.6-in WXGA HD AntiGlare display assembly for use on computers equipped with a 572717-001
webcam (1366x768 resolution)

e  15.6-in WXGA HD+ AntiGlare display assembly for use on computers equipped witha  572721-001
webcam (1600%900 resolution)

e  15.6-in WXGA HD AntiGlare display assembly for use in computers with a webcam and 572718-001
a WWAN module (1366%768 resolution)

e  15.6-in WXGA HD+ AntiGlare display assembly for use in computers with a webcam and 572722-001
a WWAN module (1600%900 resolution)

For use only with black computers with 14.0-in displays

e  14.0-in WXGA HD BrightView display assembly 535844-001

e 14.0-in WXGA HD BrightView display assembly for use in computers equipped with a 535847-001
webcam

e  14.0-in WXGA HD AntiGlare display assembly 535843-001

e  14.0-in WXGA HD AntiGlare display assembly for use in computers equipped with a 535846-001
webcam

For use only with red computers

e  14.0-in WXGA HD BrightView display assembly 572710-001
e 14.0-in WXGA HD BrightView display assembly for use in computers equipped with a 572713-001
webcam
e  14.0-in WXGA HD AntiGlare display assembly 572709-001
e  14.0-in WXGA HD AntiGlare display assembly for use in computers equipped with a 572712-001
webcam
(2) Switch cover
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Item Description Spare part number

For use in black computers with 15-in displays 535861-001

For use in red computers with 15-in displays 572726-001

For use in black computers with 14-in displays 535860-001

For use in red computers with 14-in displays 572725-001
(3) Keyboard

NOTE: For a detailed list of available keyboards, see Sequential part number listing on page 48.

For use in computers with 15-in displays 536537-xxx

For use in computers with 14-in displays 536410-xxx
(4) Palm rest (includes TouchPad)

For use in black computers with 15-in displays 535868-001

For use in red computers with 15-in displays 572728-001

For use in black computers with 14-in displays 535867-001

For use in red computers with 14-in displays 572727-001
(5) Power button board

For use in computers with 15-in displays 574513-001

For use in computers with 14-in displays 574514-001
(6) Speakers

For use in computers with 15-in displays 536598-001

For use in computers with 14-in displays 536420-001
(7) Top cover

For use in computers with 15-in displays 535866-001

For use in computers with 14-in displays 535865-001
(8) Modem module

NOTE: The modem module spare part kit does not include a modem module cable. The

modem module cable is included in the Cable Kit, spare part numbers 536539-001 (for

computers with 15-in displays) and 536538-001 (for computers with 14-in displays). See Cable

Kit on page 45 for more Cable Kit spare part information.

For use in all countries and regions except Australia and New Zealand 510100-001

For use only in Australia and New Zealand 510100-011
(9) Fan 535766-001

Heat sink
(10a) For use in computers with discrete graphics subsystems 535767-001
(10b)  For use in computers with UMA graphics subsystems 535859-001
(11) System board (includes replacement thermal material)

For use only in computers with DDR2 memory that include a WWAN module:
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Item Description Spare part number

e  GL47 system board with UMA graphics subsystem memory 535858-001
e  GL40 system board with UMA graphics subsystem memory 535857-001
e  System board with discrete graphics subsystem memory 535756-001

For use only in computers with DDR2 memory that do not include a WWAN module:

e  GL47 system board with UMA graphics subsystem memory 574510-001
e  GL40 system board with UMA graphics subsystem memo 574509-001
e  System board with discrete graphics subsystem memory 574508-001

For use only in computers with DDR3 memory that include a WWAN module:

o  GM45 system board with UMA graphics subsystem memory 583081-001
e  GL40 system board with UMA graphics subsystem memory 583080-001
e  System board with discrete graphics subsystem memory 583082-001

For use only in computers with DDR3 memory that do not include a WWAN module:

o  GM45 system board with UMA graphics subsystem memory 583079-001
e  GL40 system board with UMA graphics subsystem memory 583078-001
e  System board with discrete graphics subsystem memory 583077-001

(12) Bluetooth module

HP Integrated module with Bluetooth 2.0 wireless technology 483113-001
HP Integrated module with Bluetooth 2.1 wireless technology 537921-001
(13) Processor (includes replacement thermal material) (not illustrated)

Intel Core2 Duo processors

e  T5870 2.0-GHz (2-MB L2 cache, 800-MHz FSB) 535835-001
e T6570 2.1-GHz (2-MB L2 cache, 800-MHz FSB) 513598-001
e T6670 2.2-GHz (2-MB L2 cache, 800-MHz FSB) 572927-001
e P7370 2.0-GHz (3-MB L2 cache, 1066-MHz FSB) 507966-001
e P7570 2.2-GHz (2-MB L2 cache, 800-MHz FSB) 572930-001
e P8600 2.40-GHz (3-MB L2 cache, 1066-MHz FSB) 507961-001
e P8700 2.53-GHz (3-MB L2 cache, 1066-MHz FSB) 507960-001
e  T9400 2.53-GHz (6-MB L2 cache, 1066-MHz FSB) 507954-001
e T9600 2.8-GHz (6-MB L2 cache, 1066-MHz FSB) 507952-001

Intel Celeron M processors

e 5852.16-GHz (1-MB L2 cache, 667-MHz FSB) 519898-001

e 900 2.2-GHz (1-MB L2 cache, 667-MHz FSB) 534419-001

Intel Pentium Dual-Core processors

e T4200 2.0-GHz (1-MB L2 cache, 800-MHz FSB) 513599-001
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Item

Description

Spare part number

e T4300 2.1-GHz (1-MB L2 cache, 800-MHz FSB)

572929-001

e T4400 2.2-GHz (1-MB L2 cache, 800-MHz FSB)

584296-001

Intel Celeron Dual-Core processors

e T1600 1.66-GHz (1-MB L2 cache, 667-MHz FSB)

532324-001

e T1700 1.83-GHz (1-MB L2 cache, 667-MHz FSB)

534084-001

e T3000 1.8-GHz (1-MB L2 cache, 800-MHz FSB)

572926-001

e T3100 1.9-GHz (1-MB L2 cache, 800-MHz FSB)

572925-001

(14)

Optical drive connector

535862-001

(15)

WLAN module

Intel Wi-Fi Link 5100 802.11a/b/g/n WLAN module (for use in all countries and regions
except Pakistan, Russia, and the Ukraine)

480985-001

Intel Wi-Fi Link 5100 802.11a/b/g WLAN module

482957-001

Broadcom 4322 802.11a/b/g/n WLAN modules

e  Foruse in Antigua and Barbuda, Barbados, Belize, Canada, the Cayman Islands, Guam,
Puerto Rico, Trinidad and Tobago, the U.S. Virgin Islands, and the United States

504664-001

e  For use in Afghanistan, Albania, Algeria, Andorra, Angola, Antigua and Barbuda,
Argentina, Armenia, Aruba, Australia, Austria, Azerbaijan, the Bahamas, Bahrain,
Bangladesh, Barbados, Belarus, Belgium, Belize, Benin, Bermuda, Bhutan, Bolivia,
Bosnia and Herzegovina, Botswana, Brazil, the British Virgin Islands, Brunei, Bulgaria,
Burkina Faso, Burundi, Cameroon, Cape Verde, the Central African Republic, Chad,
Chile, the People's Republic of China, Colombia, Comoros, the Congo, Costa Rica,
Croatia, Cyprus, the Czech Republic, Denmark, Djibouti, Dominica, the Dominican
Republic, East Timor, Ecuador, Egypt, El Salvador, Equitorial Guinea, Eritrea, Estonia,
Ethiopia, Fiji, Finland, France, French Guiana, Gabon, Gambia, Georgia, Germany,
Ghana, Gibraltar, Greece, Grenada, Guadeloupe, Guatemala, Guinea, Guinea-Bissau,
Guyana, Haiti, Honduras, Hong Kong, Hungary, Iceland, India, Ireland, Israel, Italy, the
Ivory Coast, Jamaica, Jordan, Kazakhstan, Kenya, Kiribati, Kyrgyzstan, Laos, Latvia,
Lebanon, Lesotho, Liberia, Liechtenstein, Lithuania, Luxembourg, Macedonia,
Madagascar, Malawi, Malaysia, the Maldives, Mali, Malta, the Marshall Islands,
Martinique, Mauritania, Mauritius, Mexico, Micronesia, Monaco, Mongolia, Montenegro,
Morocco, Mozambique, Namibia, Nauru, Nepal, the Nether Antilles, the Netherlands, New
Zealand, Nicaragua, Niger, Nigeria, Norway, Oman, Pakistan, Palau, Panama, Papua
New Guinea, Paraguay, Peru, the Philippines, Poland, Portugal, the Republic of Moldova,
Romania, Russia, Rwanda, Samoa, San Marino, Sao Tome and Principe, Saudi Arabia,
Senegal, Serbia, the Seychelles, Sierra Leone, Singapore, Slovakia, Slovenia, the
Solomon Islands, Somalia, South Africa, South Korea, Spain, Sri Lanka, St. Kitts and
Nevis, St. Lucia, St. Vincent and the Grenadines, Suriname, Swaziland, Sweden,
Switzerland, Taiwan, Tajikistan, Tanzania, Togo, Tonga, Trinidad and Tobago, Tunisia,
Turkey, Turkmenistan, Tuvalu, Uganda, Ukraine, the United Arab Emirates, the United
Kingdom, Uruguay, Uzbekistan, Vanuatu, Venezuela, Vietham, Yemen, Zaire, Zambia,
and Zimbabwe

504664-002

Broadcom BCM4312 802.11b/g WLAN modules:

° For use in Antigua and Barbuda, Barbados, Belize, Canada, the Cayman Islands, Guam,
Puerto Rico, Trinidad and Tobago, the U.S. Virgin Islands, and the United States

504593-003

Computer major components
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Item

Description

Spare part number

For use in Afghanistan, Albania, Algeria, Andorra, Angola, Antigua and Barbuda,
Argentina, Armenia, Aruba, Australia, Austria, Azerbaijan, the Bahamas, Bahrain,
Bangladesh, Barbados, Belarus, Belgium, Belize, Benin, Bermuda, Bhutan, Bolivia,
Bosnia and Herzegovina, Botswana, Brazil, the British Virgin Islands, Brunei, Bulgaria,
Burkina Faso, Burundi, Cameroon, Cape Verde, the Central African Republic, Chad,
Chile, the People's Republic of China, Colombia, Comoros, the Congo, Costa Rica,
Croatia, Cyprus, the Czech Republic, Denmark, Djibouti, Dominica, the Dominican
Republic, East Timor, Ecuador, Egypt, El Salvador, Equitorial Guinea, Eritrea, Estonia,
Ethiopia, Fiji, Finland, France, French Guiana, Gabon, Gambia, Georgia, Germany,
Ghana, Gibraltar, Greece, Grenada, Guadeloupe, Guatemala, Guinea, Guinea-Bissau,
Guyana, Haiti, Honduras, Hong Kong, Hungary, Iceland, India, Ireland, Israel, ltaly, the
Ivory Coast, Jamaica, Jordan, Kazakhstan, Kenya, Kiribati, Kyrgyzstan, Laos, Latvia,
Lebanon, Lesotho, Liberia, Liechtenstein, Lithuania, Luxembourg, Macedonia,
Madagascar, Malawi, Malaysia, the Maldives, Mali, Malta, the Marshall Islands,
Martinique, Mauritania, Mauritius, Mexico, Micronesia, Monaco, Mongolia, Montenegro,
Morocco, Mozambique, Namibia, Nauru, Nepal, the Nether Antilles, the Netherlands, New
Zealand, Nicaragua, Niger, Nigeria, Norway, Oman, Pakistan, Palau, Panama, Papua
New Guinea, Paraguay, Peru, the Philippines, Poland, Portugal, the Republic of Moldova,
Romania, Russia, Rwanda, Samoa, San Marino, Sao Tome and Principe, Saudi Arabia,
Senegal, Serbia, the Seychelles, Sierra Leone, Singapore, Slovakia, Slovenia, the
Solomon Islands, Somalia, South Africa, South Korea, Spain, Sri Lanka, St. Kitts and
Nevis, St. Lucia, St. Vincent and the Grenadines, Suriname, Swaziland, Sweden,
Switzerland, Taiwan, Tajikistan, Tanzania, Togo, Tonga, Trinidad and Tobago, Tunisia,
Turkey, Turkmenistan, Tuvalu, Uganda, Ukraine, the United Arab Emirates, the United
Kingdom, Uruguay, Uzbekistan, Vanuatu, Venezuela, Vietnam, Yemen, Zaire, Zambia,
and Zimbabwe

504593-004

Broadcom 4322 AGN 802.11a/b/g WLAN module

For use in Afghanistan, Albania, Algeria, Andorra, Angola, Antigua and Barbuda,
Argentina, Armenia, Aruba, Australia, Austria, Azerbaijan, the Bahamas, Bahrain,
Bangladesh, Barbados, Belarus, Belgium, Belize, Benin, Bermuda, Bhutan, Bolivia,
Bosnia and Herzegovina, Botswana, Brazil, the British Virgin Islands, Brunei, Bulgaria,
Burkina Faso, Burundi, Cameroon, Cape Verde, the Central African Republic, Chad,
Chile, the People's Republic of China, Colombia, Comoros, the Congo, Costa Rica,
Croatia, Cyprus, the Czech Republic, Denmark, Djibouti, Dominica, the Dominican
Republic, East Timor, Ecuador, Egypt, El Salvador, Equitorial Guinea, Eritrea, Estonia,
Ethiopia, Fiji, Finland, France, French Guiana, Gabon, Gambia, Georgia, Germany,
Ghana, Gibraltar, Greece, Grenada, Guadeloupe, Guatemala, Guinea, Guinea-Bissau,
Guyana, Haiti, Honduras, Hong Kong, Hungary, Iceland, India, Ireland, Israel, Italy, the
Ivory Coast, Jamaica, Jordan, Kazakhstan, Kenya, Kiribati, Kyrgyzstan, Laos, Latvia,
Lebanon, Lesotho, Liberia, Liechtenstein, Lithuania, Luxembourg, Macedonia,
Madagascar, Malawi, Malaysia, the Maldives, Mali, Malta, the Marshall Islands,
Martinique, Mauritania, Mauritius, Mexico, Micronesia, Monaco, Mongolia, Montenegro,
Morocco, Mozambique, Namibia, Nauru, Nepal, the Nether Antilles, the Netherlands, New
Zealand, Nicaragua, Niger, Nigeria, Norway, Oman, Pakistan, Palau, Panama, Papua
New Guinea, Paraguay, Peru, the Philippines, Poland, Portugal, the Republic of Moldova,
Romania, Russia, Rwanda, Samoa, San Marino, Sao Tome and Principe, Saudi Arabia,
Senegal, Serbia, the Seychelles, Sierra Leone, Singapore, Slovakia, Slovenia, the
Solomon Islands, Somalia, South Africa, South Korea, Spain, Sri Lanka, St. Kitts and
Nevis, St. Lucia, St. Vincent and the Grenadines, Suriname, Swaziland, Sweden,
Switzerland, Taiwan, Tajikistan, Tanzania, Togo, Tonga, Trinidad and Tobago, Tunisia,
Turkey, Turkmenistan, Tuvalu, Uganda, Ukraine, the United Arab Emirates, the United
Kingdom, Uruguay, Uzbekistan, Vanuatu, Venezuela, Vietnam, Yemen, Zaire, Zambia,
and Zimbabwe

518434-001
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Item Description Spare part number

e  For use in Afghanistan, Albania, Algeria, Andorra, Angola, Antigua and Barbuda, 518434-002
Argentina, Armenia, Aruba, Australia, Austria, Azerbaijan, the Bahamas, Bahrain,
Bangladesh, Barbados, Belarus, Belgium, Belize, Benin, Bermuda, Bhutan, Bolivia,
Bosnia and Herzegovina, Botswana, Brazil, the British Virgin Islands, Brunei, Bulgaria,
Burkina Faso, Burundi, Cameroon, Cape Verde, the Central African Republic, Chad,
Chile, the People's Republic of China, Colombia, Comoros, the Congo, Costa Rica,
Croatia, Cyprus, the Czech Republic, Denmark, Djibouti, Dominica, the Dominican
Republic, East Timor, Ecuador, Egypt, El Salvador, Equitorial Guinea, Eritrea, Estonia,
Ethiopia, Fiji, Finland, France, French Guiana, Gabon, Gambia, Georgia, Germany,
Ghana, Gibraltar, Greece, Grenada, Guadeloupe, Guatemala, Guinea, Guinea-Bissau,
Guyana, Haiti, Honduras, Hong Kong, Hungary, Iceland, India, Ireland, Israel, Italy, the
Ivory Coast, Jamaica, Jordan, Kazakhstan, Kenya, Kiribati, Kyrgyzstan, Laos, Latvia,
Lebanon, Lesotho, Liberia, Liechtenstein, Lithuania, Luxembourg, Macedonia,
Madagascar, Malawi, Malaysia, the Maldives, Mali, Malta, the Marshall Islands,
Martinique, Mauritania, Mauritius, Mexico, Micronesia, Monaco, Mongolia, Montenegro,
Morocco, Mozambique, Namibia, Nauru, Nepal, the Nether Antilles, the Netherlands, New
Zealand, Nicaragua, Niger, Nigeria, Norway, Oman, Pakistan, Palau, Panama, Papua
New Guinea, Paraguay, Peru, the Philippines, Poland, Portugal, the Republic of Moldova,
Romania, Russia, Rwanda, Samoa, San Marino, Sao Tome and Principe, Saudi Arabia,
Senegal, Serbia, the Seychelles, Sierra Leone, Singapore, Slovakia, Slovenia, the
Solomon Islands, Somalia, South Africa, South Korea, Spain, Sri Lanka, St. Kitts and
Neuvis, St. Lucia, St. Vincent and the Grenadines, Suriname, Swaziland, Sweden,
Switzerland, Taiwan, Tajikistan, Tanzania, Togo, Tonga, Trinidad and Tobago, Tunisia,
Turkey, Turkmenistan, Tuvalu, Uganda, Ukraine, the United Arab Emirates, the United
Kingdom, Uruguay, Uzbekistan, Vanuatu, Venezuela, Vietnam, Yemen, Zaire, Zambia,
and Zimbabwe

Intel Wi-Fi Link 1000, 802.11b/g/n WLAN module:

For use in Andorra, Antigua and Barbuda, Argentina, Aruba, Australia, Austria, Azerbaijan, the 572520-001
Bahamas, Barbados, Belgium, Bolivia, Bosnia and Herzegovina, Brazil, Brunei, Bulgaria,
Canada, Cayman Islands, Chile, China, Colombia, Costa Rica, Croatia, Cyprus, the Czech
Republic, Denmark, the Dominican Republic, Ecuador, Egypt, El Salvador, Estonia, Finland,
France, French Guiana, Guadeloupe, Guam, Georgia, Germany, Ghana, Greece, Guatemala,
Haiti, Honduras, Hong Kong, Hungary, Iceland, India, Indonesia, Ireland, Israel, Italy, Ivory
Coast, Jamaica, Japan, Jordan, Kenya, Kuwait, Kyrgyzstan, Latvia, Lebanon, Liechtenstein,
Lithuania, Luxembourg, Malawi, Malaysia, Malta, Martinique, Mauritius, Mexico, Monaco,
Montenegro, Morocco, the Nether Antilles, the Netherlands, New Zealand, Nicaragua, Nigeria,
Nigeria, Oman, Pakistan, Panama, Paraguay, Peru, the Philippines, Poland, Portugal, Puerto
Rico, Quatar, Romania, San Marino, Saudi Arabia, Senegal, Singapore, Slovakia, Slovenia,
South Africa, South Korea, Spain, Sri Lanka, Sweden, Switzerland, Taiwan, Tanzania,
Thailand, Trinidad and Tobago, Turkey, United Arab Emirates, the United Kingdom, the United
States, Uruguay, the U.S. Virgin Islands, Venezuela, and Vietnam

(16)  RTC battery 449137-001

(17) Memory modules

For use in computers with DDR2 memory modules:

e 1-GB (PC2-6400, 800-MHz, DDR2) 536427-001

e 2-GB (PC2-6400, 800-MHz, DDR2) 536428-001

For use in computers with DDR3 memory modules:

e 1-GB (PC3-10600, 1333-MHz, DDR3) 587830-001
e 2-GB (PC3-10600, 1333-MHz, DDR3) 587831-001
(18) HP Mobile Broadband Module 483377-002
(19) Subscriber identification module (SIM) 536599-001
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Item Description Spare part number

(20) Base enclosure
For use in computers with 15-in displays 535864-001
For use in computers with 14-in displays 535863-001

(21) Hard drive (includes hard drive bracket)

500-GB, 7200-rpm 575195-001
500-GB, 5400-rpm 536414-001
320-GB, 7200-rpm 575194-001
320-GB, 5400-rpm 536413-001
250-GB, 7200-rpm 538972-001
250-GB, 5400-rpm 536412-001
160-GB, 7200-rpm 538971-001
160-GB, 5400-rpm 536411-001

(22) Optical drive (includes bezel)

DVD-ROM Drive 536415-001
DVD+RW Double-Layer Drive with LightScribe 536416-001
Blu-ray Disc ROM Drive with SuperMulti DVD+R/RW Double-Layer 536417-001
Rubber Kit (not illustrated, contains 8 computer feet and 8 display bezel screw covers) 535793-001

(23) Battery

8-cell, 63-Wh for use in computers with 15-in displays 535753-001
6-cell, 47-Wh for use in computers with 15-in displays 536418-001
6-cell, 47-Wh for use in computers with 14-in displays 572032-001
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Display assembly components
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Item  Description

Spare part number

(1) Display bezel

For use in computers with 15-in displays with a webcam 536421-001

For use in computers with 15-in displays without a webcam 536424-001

For use in computers with 14-in displays with a webcam 536423-001

For use in computers with 14-in displays without a webcam 536422-001
(2) Display Hinge Kit

For use in computers with 15-in displays 535872-001

Display assembly components
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Item Description Spare part number
For use in computers with 14-in displays 535871-001

3) Webcam module 535797-001
Display Cable Kit
For use in computers with 15-in HD displays 536433-001
For use in computers with 14-in displays 536430-001

(4a) Microphone cable

(4b) WLAN antenna transceivers and cables

(4c) WWAN antenna transceivers and cables

(4d) Display/webcam cable

(5) Display enclosure
For use in black computers with 15-in displays 536426-001
For use in red computers with 15-in displays 572724-001
For use in black computers with 14-in displays 536425-001
For use in red computers with 14-in displays 572723-001

Plastics Kit

o—

F

Item Description Spare part number
Plastics Kit: 535780-001

(1) ExpressCard slot bezel

(2) Optical drive bezel
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Cable Kit
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Item

Description

Spare part number

Cable Kit:

For use in computers with 15-in displays

536539-001

For use in computers with 14-in displays

536538-001

()

TouchPad cable

()

RJ-45 cable

()

Bluetooth cable

(4)

Power button board cable

®)

USB cable

(6)

Power cable

@)

RJ-11 (modem) jack cable

Cable Kit
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Mass storage devices

Item  Description Spare part number

(1) Hard drive (includes bracket)

500-GB, 7200-rpm 575195-001
500-GB, 5400-rpm 536414-001
320-GB, 7200-rpm 575194-001
320-GB, 5400-rpm 536413-001
250-GB, 7200-rpm 538972-001
250-GB, 5400-rpm 536412-001
160-GB, 7200-rpm 538971-001
160-GB, 5400-rpm 536411-001

(2) Optical drive (includes bezel)

DVD+RW Double-Layer Drive with LightScribe 536416-001
DVD-ROM Drive 536415-001
Blu-ray Disc ROM Drive with SuperMulti DVD+R/RW Double-Layer 536417-001
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Miscellaneous parts

Description Spare part number

AC adapters

65-W AC adapter 463958-001
90-W Slimline AC adapter (for use in all countries and regions except India) 463955-001
90-W Slimline NPFC AC adapter (for use in India) 463956-001
90-W Slimline PFC AC adapter (for use in India) 535593-001

Power cords

For use in the United States 246959-001
For use in Australia and New Zealand 246959-011
For use in Europe, the Middle East, and Africa 246959-021
For use in the United Kingdom 246959-031
For use in Italy 246959-061
For use in Denmark 246959-081
For use in Switzerland 246959-AG1
For use in Brazil 246959-201
For use in Japan 246959-291
For use in South Korea 246959-AD1
For use in Israel 246959-BB1
Screw Kit, includes: 535870-001

° Phillips PM3.0%4.0 screw

e  Phillips PM2.0x3.0 screw

e  Phillips PM2.5x9.0 captive screw

e  Phillips PM2.5%11.0 captive screw

e  Phillips PM3.0x8.0 screw

° Phillips PM2.0x4.0 screw

° Phillips PM2.5%3.0 screw

e  Phillips PM2.5x3.0 broadhead screw
e  Phillips PM2.5x7.0 screw

e  Phillips PM2.5x6.0 screw

e  Phillips PM2.5x4.5 screw
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Sequential part number listing

Spare part
number

Description

246959-001

Power cord for use in the United States

246959-011

Power cord for use in Australia and New Zealand

246959-021

Power cord for use in Europe, the Middle East, and Africa

246959-031

Power cord for use in the United Kingdom

246959-061

Power cord for use in Italy

246959-081

Power cord for use in Denmark

246959-201

Power cord for use in Brazil

246959-291

Power cord for use in Japan

246959-AD1

Power cord for use in South Korea

246959-AG1

Power cord for use in Switzerland

246959-BB1

Power cord for use in Israel

449137-001

RTC battery

463955-001

90-W Slimline AC adapter (for use in all countries and regions except India)

463956-001

90-W Slimline NPFC AC adapter (for use in India)

463958-001

65-W AC adapter

480985-001

Intel Wi-Fi Link 5100 802.11a/b/g/n WLAN module for use in all countries and regions except Pakistan, Russia,
and the Ukraine

482957-001

Intel Wi-Fi Link 5100 802.11a/b/g WLAN module

483113-001

HP Integrated Bluetooth 2.0 module for use in all countries and regions except Japan and Asia Pacific (does
not include the Bluetooth module cable)

483377-001

HP Mobile Broadband Module

483377-002

HP Mobile Broadband Module

504593-003

Broadcom BCM4312 802.11b/g WLAN module for use in Antigua and Barbuda, Barbados, Belize, Canada,
the Cayman Islands, Guam, Puerto Rico, Trinidad and Tobago, the U.S. Virgin Islands, and the United States
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Spare part Description
number

504593-004 Broadcom BCM4312 802.11b/g WLAN module for use in Afghanistan, Albania, Algeria, Andorra, Angola,
Antigua and Barbuda, Argentina, Armenia, Aruba, Australia, Austria, Azerbaijan, the Bahamas, Bahrain,
Bangladesh, Barbados, Belarus, Belgium, Belize, Benin, Bermuda, Bhutan, Bolivia, Bosnia and Herzegovina,
Botswana, Brazil, the British Virgin Islands, Brunei, Bulgaria, Burkina Faso, Burundi, Cameroon, Cape Verde,
the Central African Republic, Chad, Chile, the People's Republic of China, Colombia, Comoros, the Congo,
Costa Rica, Croatia, Cyprus, the Czech Republic, Denmark, Djibouti, Dominica, the Dominican Republic, East
Timor, Ecuador, Egypt, El Salvador, Equitorial Guinea, Eritrea, Estonia, Ethiopia, Fiji, Finland, France, French
Guiana, Gabon, Gambia, Georgia, Germany, Ghana, Gibraltar, Greece, Grenada, Guadeloupe, Guatemala,
Guinea, Guinea-Bissau, Guyana, Haiti, Honduras, Hong Kong, Hungary, Iceland, India, Ireland, Israel, Italy,
the Ivory Coast, Jamaica, Jordan, Kazakhstan, Kenya, Kiribati, Kyrgyzstan, Laos, Latvia, Lebanon, Lesotho,
Liberia, Liechtenstein, Lithuania, Luxembourg, Macedonia, Madagascar, Malawi, Malaysia, the Maldives, Mali,
Malta, the Marshall Islands, Martinique, Mauritania, Mauritius, Mexico, Micronesia, Monaco, Mongolia,
Montenegro, Morocco, Mozambique, Namibia, Nauru, Nepal, the Nether Antilles, the Netherlands, New
Zealand, Nicaragua, Niger, Nigeria, Norway, Oman, Pakistan, Palau, Panama, Papua New Guinea, Paraguay,
Peru, the Philippines, Poland, Portugal, the Republic of Moldova, Romania, Russia, Rwanda, Samoa, San
Marino, Sao Tome and Principe, Saudi Arabia, Senegal, Serbia, the Seychelles, Sierra Leone, Singapore,
Slovakia, Slovenia, the Solomon Islands, Somalia, South Africa, South Korea, Spain, Sri Lanka, St. Kitts and
Nevis, St. Lucia, St. Vincent and the Grenadines, Suriname, Swaziland, Sweden, Switzerland, Taiwan,
Tajikistan, Tanzania, Togo, Tonga, Trinidad and Tobago, Tunisia, Turkey, Turkmenistan, Tuvalu, Uganda,
Ukraine, the United Arab Emirates, the United Kingdom, Uruguay, Uzbekistan, Vanuatu, Venezuela, Vietnam,
Yemen, Zaire, Zambia, and Zimbabwe

504664-001 Broadcom 4322 802.11a/b/g/n WLAN module for use in Antigua and Barbuda, Barbados, Belize, Canada, the
Cayman Islands, Guam, Puerto Rico, Trinidad and Tobago, the U.S. Virgin Islands, and the United States

504664-002 Broadcom 4322 802.11a/b/g/n WLAN module for use in Afghanistan, Albania, Algeria, Andorra, Angola,
Antigua and Barbuda, Argentina, Armenia, Aruba, Australia, Austria, Azerbaijan, the Bahamas, Bahrain,
Bangladesh, Barbados, Belarus, Belgium, Belize, Benin, Bermuda, Bhutan, Bolivia, Bosnia and Herzegovina,
Botswana, Brazil, the British Virgin Islands, Brunei, Bulgaria, Burkina Faso, Burundi, Cameroon, Cape Verde,
the Central African Republic, Chad, Chile, the People's Republic of China, Colombia, Comoros, the Congo,
Costa Rica, Croatia, Cyprus, the Czech Republic, Denmark, Djibouti, Dominica, the Dominican Republic, East
Timor, Ecuador, Egypt, El Salvador, Equitorial Guinea, Eritrea, Estonia, Ethiopia, Fiji, Finland, France, French
Guiana, Gabon, Gambia, Georgia, Germany, Ghana, Gibraltar, Greece, Grenada, Guadeloupe, Guatemala,
Guinea, Guinea-Bissau, Guyana, Haiti, Honduras, Hong Kong, Hungary, Iceland, India, Ireland, Israel, Italy,
the Ivory Coast, Jamaica, Jordan, Kazakhstan, Kenya, Kiribati, Kyrgyzstan, Laos, Latvia, Lebanon, Lesotho,
Liberia, Liechtenstein, Lithuania, Luxembourg, Macedonia, Madagascar, Malawi, Malaysia, the Maldives, Mali,
Malta, the Marshall Islands, Martinique, Mauritania, Mauritius, Mexico, Micronesia, Monaco, Mongolia,
Montenegro, Morocco, Mozambique, Namibia, Nauru, Nepal, the Nether Antilles, the Netherlands, New
Zealand, Nicaragua, Niger, Nigeria, Norway, Oman, Pakistan, Palau, Panama, Papua New Guinea, Paraguay,
Peru, the Philippines, Poland, Portugal, the Republic of Moldova, Romania, Russia, Rwanda, Samoa, San
Marino, Sao Tome and Principe, Saudi Arabia, Senegal, Serbia, the Seychelles, Sierra Leone, Singapore,
Slovakia, Slovenia, the Solomon Islands, Somalia, South Africa, South Korea, Spain, Sri Lanka, St. Kitts and
Nevis, St. Lucia, St. Vincent and the Grenadines, Suriname, Swaziland, Sweden, Switzerland, Taiwan,
Tajikistan, Tanzania, Togo, Tonga, Trinidad and Tobago, Tunisia, Turkey, Turkmenistan, Tuvalu, Uganda,
Ukraine, the United Arab Emirates, the United Kingdom, Uruguay, Uzbekistan, Vanuatu, Venezuela, Vietnam,
Yemen, Zaire, Zambia, and Zimbabwe

507952-001 Intel Core2 Duo T9600 2.8-GHz processor (6-MB, L2 cache, 1066-MHz FSB)

507954-001 Intel Core2 Duo T9400 2.53-GHz processor (6-MB, L2 cache, 1066-MHz FSB)

507960-001 Intel Core2 Duo P8700 2.53-GHz processor (3-MB, L2 cache, 1066-MHz FSB)

507961-001 Intel Core2 Duo P8600 2.40-GHz processor (3-MB, L2 cache, 1066-MHz FSB)

507966-001 Intel Core2 Duo P7370 2.0-GHz processor (3-MB L2 cache, 1066-MHz FSB)

510100-001 Modem module for use in all countries and regions except Australia and New Zealand

510100-011 Modem module for use in Australia and New Zealand

513598-001 Intel Core2 Duo T6570 2.1-GHz processor (2-MB L2 cache, 800-MHz FSB)
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Spare part
number

Description

513599-001

Intel Pentium Dual-Core T4200 2.0-GHz processor (1-MB L2 cache, 800-MHz FSB)

518434-001

Broadcom 4322 AGN 802.11a/b/g WLAN module for use in Antigua and Barbuda, Barbados, Belize, Canada,
the Cayman Islands, Guam, Puerto Rico, Trinidad and Tobago, the U.S. Virgin Islands, and the United States

518434-002

Broadcom 4322 AGN 802.11a/b/g WLAN module for use in Afghanistan, Albania, Algeria, Andorra, Angola,
Antigua and Barbuda, Argentina, Armenia, Aruba, Australia, Austria, Azerbaijan, the Bahamas, Bahrain,
Bangladesh, Barbados, Belarus, Belgium, Belize, Benin, Bermuda, Bhutan, Bolivia, Bosnia and Herzegovina,
Botswana, Brazil, the British Virgin Islands, Brunei, Bulgaria, Burkina Faso, Burundi, Cameroon, Cape Verde,
the Central African Republic, Chad, Chile, the People's Republic of China, Colombia, Comoros, the Congo,
Costa Rica, Croatia, Cyprus, the Czech Republic, Denmark, Djibouti, Dominica, the Dominican Republic, East
Timor, Ecuador, Egypt, El Salvador, Equitorial Guinea, Eritrea, Estonia, Ethiopia, Fiji, Finland, France, French
Guiana, Gabon, Gambia, Georgia, Germany, Ghana, Gibraltar, Greece, Grenada, Guadeloupe, Guatemala,
Guinea, Guinea-Bissau, Guyana, Haiti, Honduras, Hong Kong, Hungary, Iceland, India, Ireland, Israel, ltaly,
the Ivory Coast, Jamaica, Jordan, Kazakhstan, Kenya, Kiribati, Kyrgyzstan, Laos, Latvia, Lebanon, Lesotho,
Liberia, Liechtenstein, Lithuania, Luxembourg, Macedonia, Madagascar, Malawi, Malaysia, the Maldives, Mali,
Malta, the Marshall Islands, Martinique, Mauritania, Mauritius, Mexico, Micronesia, Monaco, Mongolia,
Montenegro, Morocco, Mozambique, Namibia, Nauru, Nepal, the Nether Antilles, the Netherlands, New
Zealand, Nicaragua, Niger, Nigeria, Norway, Oman, Pakistan, Palau, Panama, Papua New Guinea, Paraguay,
Peru, the Philippines, Poland, Portugal, the Republic of Moldova, Romania, Russia, Rwanda, Samoa, San
Marino, Sao Tome and Principe, Saudi Arabia, Senegal, Serbia, the Seychelles, Sierra Leone, Singapore,
Slovakia, Slovenia, the Solomon Islands, Somalia, South Africa, South Korea, Spain, Sri Lanka, St. Kitts and
Nevis, St. Lucia, St. Vincent and the Grenadines, Suriname, Swaziland, Sweden, Switzerland, Taiwan,
Tajikistan, Tanzania, Togo, Tonga, Trinidad and Tobago, Tunisia, Turkey, Turkmenistan, Tuvalu, Uganda,
Ukraine, the United Arab Emirates, the United Kingdom, Uruguay, Uzbekistan, Vanuatu, Venezuela, Vietnam,
Yemen, Zaire, Zambia, and Zimbabwe

519898-001

Intel Celeron M 585 2.16-GHz processor (1-MB, L2 cache, 667-MHz FSB)

532324-001

Intel Celeron Dual-Core T1600 1.66-GHz processor (1-MB L2 cache, 667-MHz FSB)

534084-001

Intel Celeron Dual-Core T1700 1.83-GHz processor (1-MB L2 cache, 667-MHz FSB)

534419-001

Intel Celeron 900 2.2-GHz processor (1-MB, L2 cache, 667-MHz FSB)

535593-001

90-W Slimline PFC AC adapter (for use in India)

535753-001

8-cell, 63-Wh Li-ion battery for use in computers with 15-in displays

535756-001

System board for use in computers with DDR2 memory and discrete graphics subsystem memory that include
a WWAN module (includes replacement thermal material)

535766-001

Fan

535767-001

Heat sink for use in computers with discrete graphics subsystems

535780-001

Plastics Kit (see Plastics Kit on page 44 for more Plastics Kit spare part information)

535793-001

Rubber Kit (contains 8 computer feet and 8 display bezel screw covers)

535797-001

Webcam module

535835-001

Intel Core2 Duo T5870 2.0-GHz processor (2-MB L2 cache, 800-MHz FSB)

535843-001

14.0-in WXGA HD AntiGlare display assembly for use in black computers

535844-001

14.0-in WXGA HD BrightView display assembly for use in black computers

535846-001

14.0-in WXGA HD AntiGlare display assembly for use in black computers equipped with a webcam

535847-001

14.0-in WXGA HD BrightView display assembly for use in black computers equipped with a webcam

535849-001

15.6-in WXGA HD AntiGlare display assembly for use in black computers

535850-001

15.6-in WXGA HD BrightView display assembly for use in black computers
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Spare part Description

number

535851-001 15.6-in WXGA HD AntiGlare display assembly for use on black computers with a webcam

535852-001 15.6-in WXGA HD AntiGlare display assembly for use in black computers with a webcam and a WWAN module

535853-001 15.6-in WXGA HD BrightView display assembly for use in black computers equipped with a webcam

535854-001 15.6-in WXGA HD BrightView display assembly for use in black computers equipped with a webcam and
WWAN module

535855-001 15.6-in WXGA HD+ AntiGlare display assembly for use in black computers equipped with a webcam

535856-001 15.6-in WXGA HD+ AntiGlare display assembly for use in black computers with a webcam and a WWAN
module

535857-001 System board for use only with computers with DDR2 memory with UMA graphics subsystem memory and
GL40 system boards that include a WWAN module (includes replacement thermal material)

535858-001 System board for use in computers with DDR2 memory with GL47 system boards thatinclude a WWAN module
(includes replacement thermal material)

535859-001 Heat sink for use in computers with UMA graphics subsystems (includes replacement thermal material)

535860-001 Switch cover for use in black computers with 14-in displays

535861-001 Switch cover for use in black computers with 15-in displays

535862-001 Optical drive connector

535863-001 Base enclosure for use in computers with 14-in displays

535864-001 Base enclosure for use in computers with 15-in displays

535865-001 Top cover for use in computers with 14-in displays

535866-001 Top cover for use in computers with 15-in displays

535867-001 Palm rest for use in black computers with 14-in displays (includes TouchPad)

535868-001 Palm rest for use in black computers with 15-in displays (includes TouchPad)

535870-001 Screw Kit

535871-001 Display Hinge Kit for use in computers with 14-in displays

535872-001 Display Hinge Kit for use in computers with 15-in displays

536410-001 Keyboard for use in the United States on computers with 14-in displays

536410-121 Keyboard for use in French Canada on computers with 14-in displays

536410-161 Keyboard for use in Latin America on computers with 14-in displays

536410-201 Keyboard for use in Brazil on computers with 14-in displays

536410-281 Keyboard for use in Thailand on computers with 14-in displays

536410-291 Keyboard for use in Japan on computers with 14-in displays

536410-AB1 Keyboard for use in Taiwan on computers with 14-in displays

536410-AD1 Keyboard for use in South Korea on computers with 14-in displays

536411-001 160-GB, 5400-rpm hard drive (includes hard drive bracket)

536412-001 160-GB, 5400-rpm hard drive (includes hard drive bracket)
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Spare part Description
number

536413-001 320-GB, 5400-rpm hard drive (includes hard drive bracket)

536414-001 500-GB, 5400-rpm hard drive (includes hard drive bracket)

536415-001 DVD-ROM Drive (includes bezel)

536416-001 DVD+RW Double-Layer Drive with LightScribe (includes bezel)

536417-001 Blu-ray Disc ROM Drive with SuperMulti DVD+R/RW Double-Layer (includes bezel)

536418-001 6-cell 47-Wh Li-ion battery for use in computers with 15-in displays

536420-001 Speakers for use in computers with 14-in displays

536421-001 Display bezel for use in computers with 15-in displays and a webcam
536422-001 Display bezel for use in computers with 14-in displays without a webcam
536423-001 Display bezel for use in computers with 14-in displays and a webcam
536424-001 Display bezel for use in computers with 15-in displays without a webcam

536425-001 Display enclosure for use in black computers with 14-in displays

536426-001 Display enclosure for use in black computers with 15-in displays

536427-001 Memory module, 1-GB, (PC2-6400, 800-MHz, DDR2)

536428-001 Memory module, 2-GB (PC2-6400, 800-MHz, DDR2)

536429-001 Display cable for use in computers with 14-in displays

536430-001 Display Cable Kit for use in computers with 14-in displays

536431-001 Display cable for use in computers with 15-in HD displays

536433-001 Display Cable Kit for use in computers with 15-in displays

536537-001 Keyboard for use in the United States on computers with 15-in displays

536537-031 Keyboard for use in the United Kingdom on computers with 15-in displays

536537-041 Keyboard for use in Germany on computers with 15-in displays

536537-051 Keyboard for use in France on computers with 15-in displays

536537-061 Keyboard for use in Italy on computers with 15-in displays

536537-071 Keyboard for use in Spain on computers with 15-in displays

536537-081 Keyboard for use in Denmark on computers with 15-in displays

536537-091 Keyboard for use in Norway on computers with 15-in displays

536537-121 Keyboard for use in French Canada on computers with 15-in displays

536537-131 Keyboard for use in Portugal only on computers with 15-in displays

536537-141 Keyboard for use in Turkey only on computers with 15-in displays

536537-161 Keyboard for use in Latin America on computers with 15-in displays

536537-171 Keyboard for use in Saudi Arabia on computers with 15-in displays

536537-201 Keyboard for use in Brazil on computers with 15-in displays
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Spare part Description

number

536537-211 Keyboard for use in Hungary on computers with 15-in displays

536537-221 Keyboard for use in the Czech Republic on computers with 15-in displays

536537-231 Keyboard for use in Slovakia on computers with 15-in displays

536537-251 Keyboard for use in Russia on computers with 15-in displays

536537-261 Keyboard for use in Bulgaria on computers with 15-in displays

536537-281 Keyboard for use in Thailand on computers with 15-in displays

536537-291 Keyboard for use in Japan on computers with 15-in displays

536537-A41 Keyboard for use in Europe on computers with 15-in displays

536537-AB1 Keyboard for use in Taiwan on computers with 15-in displays

536537-AD1 Keyboard for use in South Korea on computers with 15-in displays

536537-B31 Keyboard for International use on computers with 15-in displays

536537-B71 Keyboard for use in Finland on computers with 15-in displays

536537-BA1 Keyboard for use in Slovenia on computers with 15-in displays

536537-BB1 Keyboard for use in Israel on computers with 15-in displays

536537-BG1 Keyboard for use in Switzerland on computers with 15-in displays

536537-DD1 Keyboard for use in Iceland on computers with 15-in displays

536537-DJ1 Keyboard for use in Greece on computers with 15-in displays

536538-001 Cable Kit for use in computers with 14-in displays

536539-001 Cable Kit for use in computers with 15-in displays

536598-001 Speakers for use in computers with 15-in displays

536599-001 SIM

537921-001 HP Integrated Bluetooth 2.1 module

538971-001 160-GB, 7200-rpm hard drive (includes hard drive bracket)

538972-001 160-GB, 7200-rpm hard drive (includes hard drive bracket)

572032-001 6-cell, 47-Wh Li-ion battery for use in computers with 14-in displays

572520-001 Intel Wi-Fi Link 1000, 802.11b/g/n WLAN module for use in Andorra, Antigua and Barbuda, Argentina, Aruba,
Australia, Austria, Azerbaijan, the Bahamas, Barbados, Belgium, Bolivia, Bosnia and Herzegovina, Brazil,
Brunei, Bulgaria, Canada, Cayman Islands, Chile, China, Colombia, Costa Rica, Croatia, Cyprus, the Czech
Republic, Denmark, the Dominican Republic, Ecuador, Egypt, El Salvador, Estonia, Finland, France, French
Guiana, Guadeloupe, Guam, Georgia, Germany, Ghana, Greece, Guatemala, Haiti, Honduras, Hong Kong,
Hungary, Iceland, India, Indonesia, Ireland, Israel, Italy, Ivory Coast, Jamaica, Japan, Jordan, Kenya, Kuwait,
Kyrgyzstan, Latvia, Lebanon, Liechtenstein, Lithuania, Luxembourg, Malawi, Malaysia, Malta, Martinique,
Mauritius, Mexico, Monaco, Montenegro, Morocco, the Nether Antilles, the Netherlands, New Zealand,
Nicaragua, Nigeria, Nigeria, Oman, Pakistan, Panama, Paraguay, Peru, the Philippines, Poland, Portugal,
Puerto Rico, Quatar, Romania, San Marino, Saudi Arabia, Senegal, Singapore, Slovakia, Slovenia, South
Africa, South Korea, Spain, Sri Lanka, Sweden, Switzerland, Taiwan, Tanzania, Thailand, Trinidad and
Tobago, Turkey, United Arab Emirates, the United Kingdom, the United States, Uruguay, the U.S. Virgin
Islands, Venezuela, and Vietnam

572709-001 14.0-in WXGA HD AntiGlare display assembly for use in red computers
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Spare part
number

Description

572710-001

14.0-in WXGA HD BrightView display assembly for use in red computers

572712-001

14.0-in WXGA HD AntiGlare display assembly for use in red computers equipped with a webcam

572713-001

14.0-in WXGA HD BrightView display assembly for use in red computers equipped with a webcam

572715-001

15.6-in HD WXGA AntiGlare display assembly for use in red computers (1366x768 resolution)

572716-001

15.6-in HD WXGA BrightView display assembly for use in red computers (1366x768 resolution)

572717-001

15.6-in WXGA HD AntiGlare display assembly for use on red computers equipped with a webcam (1366x768
resolution)

572718-001

15.6-in WXGA HD AntiGlare display assembly for use in red computers with a webcam and a WWAN module
(1366%768 resolution)

572719-001

15.6-in HD WXGA BrightView display assembly for use in red computers equipped with a webcam (1366x768
resolution)

572720-001

15.6-in HD WXGA BrightView display assembly for use in red computers with a webcam and WWAN module
(1366x768 resolution)

572721-001

15.6-in WXGA HD+ AntiGlare display assembly for use in red computers equipped with a webcam (1600%900
resolution)

572722-001

15.6-in WXGA HD+ AntiGlare display assembly for use in red computers with a webcam and a WWAN module
(1600%900 resolution)

572723-001

Display enclosure for use in red computers with 14-in displays

572724-001

Display enclosure for use in red computers with 15-in displays

572725-001

Switch cover for use in red computers with 14-in displays

572726-001

Switch cover for use in red computers with 15-in displays

572727-001

Palm rest for use in red computers with 14-in displays (includes TouchPad)

572728-001

Palm rest for use in red computers with 15-in displays (includes TouchPad)

572925-001

Intel Celeron Dual-Core T3100 1.8-GHz processor (1-MB L2 cache, 800-MHz FSB)

572926-001

Intel Celeron Dual-Core T3000 1.9-GHz processor (1-MB L2 cache, 800-MHz FSB)

572927-001

Intel Core2 Duo T6670 2.2-GHz processor (2-MB L2 cache, 800-MHz FSB)

572929-001

Intel Pentium Dual-Core T4300 2.1-GHz processor (1-MB L2 cache, 800-MHz FSB)

572930-001

Intel Core2 Duo P7570 2.26-GHz processor (3-MB L2 cache, 1066-MHz FSB)

574508-001

System board for use only in computers with DDR2 memory with discrete graphics subsystem memory that
do not include a WWAN module

574509-001

System board for use only in computers with DDR2 memory with UMA graphics subsystem memory and GL40
system boards that do not include a WWAN module

574510-001

System board for use only in computers with DDR2 memory with UMA graphics subsystem memory and GL47
system boards that do not include a WWAN module

574513-001

Power button board for use in computers with 15-in displays

574514-001

Power button board for use in computers with 14-in displays

575194-001

320-GB, 7200-rpm hard drive

575195-001

500-GB, 7200-rpm hard drive
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Spare part Description
number

583077-001 System board for use in computers with DDR3 memory and discrete graphics that do not include a WWAN
module

583078-001 GL40 system board for use in computers with DDR3 memory and UMA graphics subsystem memory that do
not include a WWAN module

583079-001 GM45 system board for use in computers with DDR3 memory and UMA graphics subsystem memory that do
not include a WWAN module

583080-001 GL40 system board for use in computers with DDR3 memory and UMA graphics subsystem memory that
include a WWAN module

583081-001 GM45 system board for use in computers with DDR3 memory and UMA graphics subsystem memory that
include a WWAN module

583082-001 System board for use in computers with DDR3 memory and discrete graphics that include a WWAN module

584296-001 Intel Pentium Dual-Core T4400 2.2-GHz processor (1-MB L2 cache, 800-MHz FSB)

587830-001 Memory module, 1-GB, (PC3-10600, 1333-MHz, DDR3)

587831-001 Memory module, 2-GB, (PC3-10600, 1333-MHz, DDR3)
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4 Removal and replacement procedures

Preliminary replacement requirements

Tools required
You will need the following tools to complete the removal and replacement procedures:
e Flat-bladed screwdriver
e Magnetic screwdriver
e Phillips PO and P1 screwdrivers

° Torx T8 screwdriver

Service considerations

The following sections include some of the considerations that you must keep in mind during
disassembly and assembly procedures.

Bf NOTE: As you remove each subassembly from the computer, place the subassembly (and all
accompanying screws) away from the work area to prevent damage.

Plastic parts

/\ CAUTION: Using excessive force during disassembly and reassembly can damage plastic parts. Use
care when handling the plastic parts. Apply pressure only at the points designated in the maintenance
instructions.
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Cables and connectors

/A CAUTION: When servicing the computer, be sure that cables are placed in their proper locations
during the reassembly process. Improper cable placement can damage the computer.

Cables must be handled with extreme care to avoid damage. Apply only the tension required to unseat
or seat the cables during removal and insertion. Handle cables by the connector whenever possible. In
all cases, avoid bending, twisting, or tearing cables. Be sure that cables are routed in such a way that
they cannot be caught or snagged by parts being removed or replaced. Handle flex cables with extreme
care; these cables tear easily.

Drive handling

/\ CAUTION: Drives are fragile components that must be handled with care. To prevent damage to the
computer, damage to a drive, or loss of information, observe these precautions:

Before removing or inserting a hard drive, shut down the computer. If you are unsure whether the
computer is off or in Hibernation, turn the computer on, and then shut it down through the operating
system.

Before handling a drive, be sure that you are discharged of static electricity. While handling a drive,
avoid touching the connector.

Before removing a diskette drive or optical drive, be sure that a diskette or disc is not in the drive and
be sure that the optical drive tray is closed.

Handle drives on surfaces covered with at least one inch of shock-proof foam.

Avoid dropping drives from any height onto any surface.

After removing a hard drive, an optical drive, or a diskette drive, place it in a static-proof bag.
Avoid exposing a hard drive to products that have magnetic fields, such as monitors or speakers.
Avoid exposing a drive to temperature extremes or liquids.

If a drive must be mailed, place the drive in a bubble pack mailer or other suitable form of protective
packaging and label the package “FRAGILE.”
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Grounding guidelines

Electrostatic discharge damage

Electronic components are sensitive to electrostatic discharge (ESD). Circuitry design and structure
determine the degree of sensitivity. Networks built into many integrated circuits provide some protection,
but in many cases, ESD contains enough power to alter device parameters or melt silicon junctions.

A discharge of static electricity from a finger or other conductor can destroy static-sensitive devices or
microcircuitry. Even if the spark is neither felt nor heard, damage may have occurred.

An electronic device exposed to ESD may not be affected at all and can work perfectly throughout a
normal cycle. Or the device may function normally for a while, then degrade in the internal layers,
reducing its life expectancy.

/A CAUTION: To prevent damage to the computer when you are removing or installing internal
components, observe these precautions:

Keep components in their electrostatic-safe containers until you are ready to install them.
Use nonmagnetic tools.

Before touching an electronic component, discharge static electricity by using the guidelines described
in this section.

Avoid touching pins, leads, and circuitry. Handle electronic components as little as possible.

If you remove a component, place it in an electrostatic-safe container.

The following table shows how humidity affects the electrostatic voltage levels generated by different
activities.

/\ CAUTION: A product can be degraded by as little as 700 V.

Typical electrostatic voltage levels

Relative humidity

Event 10% 40% 55%
Walking across carpet 35,000 V 15,000 V 7,500V
Walking across vinyl floor 12,000 V 5,000V 3,000V
Motions of bench worker 6,000 V 800 V 400 V
Removing DIPS from plastic tube 2,000 V 700 V 400 V
Removing DIPS from vinyl tray 11,500 V 4,000 V 2,000 V
Removing DIPS from Styrofoam 14,500 V 5,000 V 3,500V
Removing bubble pack from PCB 26,500 V 20,000 V 7,000 V
Packing PCBs in foam-lined box 21,000 V 11,000 V 5,000 V
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Packaging and transporting guidelines

Follow these grounding guidelines when packaging and transporting equipment:

To avoid hand contact, transport products in static-safe tubes, bags, or boxes.

Protect ESD-sensitive parts and assemblies with conductive or approved containers or packaging.
Keep ESD-sensitive parts in their containers until the parts arrive at static-free workstations.
Place items on a grounded surface before removing items from their containers.

Always be properly grounded when touching a component or assembly.

Store reusable ESD-sensitive parts from assemblies in protective packaging or nonconductive
foam.

Use transporters and conveyors made of antistatic belts and roller bushings. Be sure that
mechanized equipment used for moving materials is wired to ground and that proper materials are
selected to avoid static charging. When grounding is not possible, use an ionizer to dissipate
electric charges.

Workstation guidelines

Follow these grounding workstation guidelines:

Cover the workstation with approved static-shielding material.

Use a wrist strap connected to a properly grounded work surface and use properly grounded tools
and equipment.

Use conductive field service tools, such as cutters, screwdrivers, and vacuums.

When fixtures must directly contact dissipative surfaces, use fixtures made only of static-safe
materials.

Keep the work area free of nonconductive materials, such as ordinary plastic assembly aids and
Styrofoam.

Handle ESD-sensitive components, parts, and assemblies by the case or PCM laminate. Handle
these items only at static-free workstations.

Avoid contact with pins, leads, or circuitry.

Turn off power and input signals before inserting or removing connectors or test equipment.
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Equipment guidelines
Grounding equipment must include either a wrist strap or a foot strap at a grounded workstation.

e When seated, wear a wrist strap connected to a grounded system. Wrist straps are flexible straps
with a minimum of one megohm £10% resistance in the ground cords. To provide proper ground,
wear a strap snugly against the skin at all times. On grounded mats with banana-plug connectors,
use alligator clips to connect a wrist strap.

e When standing, use foot straps and a grounded floor mat. Foot straps (heel, toe, or boot straps)
can be used at standing workstations and are compatible with most types of shoes or boots. On
conductive floors or dissipative floor mats, use foot straps on both feet with a minimum of one
megohm resistance between the operator and ground. To be effective, the conductive strips must
be worn in contact with the skin.

The following grounding equipment is recommended to prevent electrostatic damage:
e Antistatic tape

e Antistatic smocks, aprons, and sleeve protectors

e Conductive bins and other assembly or soldering aids

e Nonconductive foam

e Conductive tabletop workstations with ground cords of one megohm resistance
e  Static-dissipative tables or floor mats with hard ties to the ground

e Field service kits

e  Static awareness labels

e Material-handling packages

e Nonconductive plastic bags, tubes, or boxes

e Metal tote boxes

e Electrostatic voltage levels and protective materials

The following table lists the shielding protection provided by antistatic bags and floor mats.

Material Use Voltage protection level
Antistatic plastic Bags 1,500 V
Carbon-loaded plastic Floor mats 7,500V
Metallized laminate Floor mats 5,000 V
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Component replacement procedures

This section provides removal and replacement procedures.

There are as many as 121 screws, in 12 different sizes, that must be removed, replaced, or loosened
when servicing the computer. Make special note of each screw size and location during removal and
replacement.

Service tag

When ordering parts or requesting information, provide the computer serial number and model
description provided on the service tag:

(1) Product name: This is the product name affixed to the front of the computer.
(2) Serial number (s/n): This is an alphanumeric identifier that is unique to each product.

(3) Part number/Product number (p/n): This number provides specific information about the product's
hardware components. The part number helps a service technician to determine what components and
parts are needed.

(4) Model description: This is the alphanumeric identifier used to locate documents, drivers, and support
for the computer.

(5) Warranty period: This number describes the duration of the warranty period for this computer.

- product & X000000000 XX0000
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00
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Computer feet

The computer feet are adhesive-backed rubber pads. The feet are included in the Rubber Kit, spare
part number 535793-001. There are 8 rubber feet that attach to the base enclosure in the locations

illustrated below.
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Battery

Description Spare part number
8-cell, 63-Wh Li-on battery for use in computers with 15-in displays 535753-001
6-cell, 47-Wh Li-on battery for use in computers with 15-in displays 536418-001
6-cell, 47-Wh Li-on battery for use in computers with 14-in displays 572032-001

Before disassembling the computer, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

Remove the battery:
1. Turn the computer upside-down on a flat surface with the battery bay toward you.
2. Slide the battery release latches (1) to release the battery.

3.  Remove the battery (2) from the computer.

Install the battery by inserting it into the battery bay until you hear a click.
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Switch cover and keyboard

Description Spare part number

Switch covers

For use in black computers with 15-in displays 535861-001
For use in red computers with 15-in displays 572726-001
For use in black computers with 14-in displays 535860-001
For use in red computers with 14-in displays 572725-001
Keyboards for use in computers with 15-in displays 536537-xxx
Keyboards for use in computers with 14-in displays 536410-xxx

NOTE: For a detailed list of available keyboards, see Sequential part number listing on page 48.

Before removing the switch cover and keyboard, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 63).

Remove the switch cover and keyboard:

1. Position the computer upside-down with the rear toward you.
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2. Toremove the switch cover on 15-in models, remove the following screws:
(1) Two screw covers and two PM2.5x3.0 screws
(2) Five PM2.5x3.0 broadhead screws
(3) Two PM2.0%3.0 screws
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To remove the switch cover on 14-in models, remove the following screws:
(1) Two screw covers and two PM2.5%3.0 screws

(2) Two PM2.5%3.0 broadhead screws

(3) Two PM2.0x3.0 screws

3. Open the computer as far as possible.
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4. Slide the switch cover back (1), and then remove it from the computer (2).

5. On computers with 15-in displays, remove the two Phillips PM2.5%3.0 screws that secure the
keyboard to the computer.

On computers with 14-in displays, remove the three Phillips PM2.5%3.0 screws that secure the
keyboard to the computer.
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6. Slide the keyboard back toward the display (1), and then rotate it forward (2) until it rests upside-
down on the palm rest.

7. Release the zero insertion force (ZIF) connector (1) to which the keyboard cable is attached, and
disconnect the keyboard cable (2) from the system board.

8. Remove the keyboard.

Reverse this procedure to install the switch cover and keyboard.
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Memory module

Bf NOTE: Older models use DDR2 memory, while newer models use DDR3 memory. You cannot use
model numbers to determine the type of memory a model uses.

NOTE: When adding a second memory module, be sure it is the same type and speed as the installed
memory module. DDR2 memory modules cannot be mixed with DDR3 memory modules.

Description Spare part number

For use in models that use DDR2 memory

2-GB (PC2-6400, 800-MHz, DDR2) 536428-001

1-GB (PC2-6400,800-MHz, DDR2) 536427-001

For use in models that use DDR3 memory

2-GB (PC3-10600, 1333-MHz, DDR3) 587831-001

1-GB (PC3-10600, 1333-MHz, DDR3) 587830-001

Before removing the memory module, follow these steps:

1.

4,

5.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

Disconnect all external devices connected to the computer.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

Remove the battery (see Battery on page 63).

Remove the switch cover and keyboard (see Switch cover and keyboard on page 64).

Remove the memory module:

1.
2.

Position the computer right-side up with the front toward you.

Spread the retaining tabs (1) on each side of the memory module slot to release the memory
module. (The edge of the module opposite the slot rises away from the computer.)
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3.

Remove the memory module (2) by pulling the module away from the slot at an angle.

Bf NOTE: Memory modules are designed with a notch (3) to prevent incorrect insertion into the

memory module slot.

Reverse this procedure to install a memory module.

Optical drive

Bf NOTE: All optical drive spare part kits include an optical drive bezel.

Description Spare part number
DVD+RW Double-Layer Drive with LightScribe (includes bezel) 536416-001
Blu-ray Disc ROM Drive with SuperMulti DVD+R/RW Double-Layer (includes bezel) 536417-001
DVD-ROM Drive (includes bezel) 536415-001

Before removing the optical drive, follow these steps:

1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

Disconnect all external devices connected to the computer.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

Remove the battery (see Battery on page 63).

Remove the switch cover and keyboard (see Switch cover and keyboard on page 64).
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Remove the optical drive:
1. Position the computer with the right side toward you.

2. Remove the Phillips PM2.5%7.0 screw (1) that secures the optical drive to the computer.

Bf NOTE: On 15-in models the screw is located in a hole in the top cover. See the first image below.

NOTE: On 14-in models the screw is located directly below the keyboard ZIF connector. See the
second image below.

3. Insert a flat-bladed screwdriver or similar tool into the optical drive tab access (2) and press the
tab to the right to release the optical drive from the computer.
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4. Remove the optical drive (3) from the computer.

B NOTE: 15-in model shown below

B NOTE: 14-in model shown below
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5. Ifitis necessary to replace the optical drive bracket, position the optical drive with the rear toward
you.

6. Remove the two Phillips PM2.0x3.0 screws (1) that secure the optical drive bracket to the optical
drive.

7. Remove the optical drive bracket (2).

- "'.jg#
é/" — )

Reverse this procedure to reassemble and install an optical drive.
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Speakers

Description Spare part number
For use in computers with 15-in displays 536598-001
For use in computers with 14-in displays 536420-001

Before removing the speakers, follow these steps:

1.

4,
5.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

Disconnect all external devices connected to the computer.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

Remove the battery (see Battery on page 63).

Remove the switch cover and keyboard (see Switch cover and keyboard on page 64).

Remove the speakers:

1.
2.

Position the computer right-side up with the front toward you.

Disconnect the speaker cable (1) from the system board.

B NOTE: The two speakers are connected with a single cable.

3.
4,

Remove the four Phillips PM2.5x3.0 screws (2) that secure the speakers to the top cover.

Remove the speaker cable from the clips and routing channel, and then remove the speakers from
the computer (3).

Reverse this procedure to install the speakers.
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WWAN module
Ef NOTE: Only computers with 15-in displays include a WWAN module.

Description Spare part number

HP Mobile Broadband Module 483377-002

/A CAUTION: To prevent an unresponsive system, replace the wireless module only with a wireless
module authorized for use in the computer by the governmental agency that regulates wireless devices
in your country or region. If you replace the module and then receive a warning message, remove the
module to restore computer functionality, and then contact technical support through Help and Support.

Before removing the WWAN module, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 63).

5. Remove the switch cover and keyboard (see Switch cover and keyboard on page 64)

Remove the WWAN module:
1. Position the computer right-side up with the front toward you.

2. Disconnect the WWAN antenna cables (1) from the terminals on the WWAN module.

B NOTE: The red WWAN antenna cable is connected to the WLAN module “Main” terminal. The
blue WWAN antenna cable is connected to the WWAN module “Aux” terminal.

3. Remove the two Phillips PM2.5%3.0 screws (2) that secure the WWAN module to the computer.
(The edge of the module opposite the slot rises away from the computer.)
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4. Remove the WWAN module (3) by pulling the module away from the slot at an angle.

B NOTE: WWAN modules are designed with a notch (4) to prevent incorrect insertion.

Reverse this procedure to install the WWAN module.

Palm rest
Description Spare part number
Palm rest for use in black computers with 15-in displays (includes TouchPad) 535868-001
Palm rest for use in red computers with 15-in displays (includes TouchPad) 572728-001
Palm rest for use in black computers with 14-in displays (includes TouchPad) 535867-001
Palm rest for use in red computers with 14-in displays (includes TouchPad) 572727-001

Before removing the palm rest, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 63).

5. Remove the switch cover and keyboard (see Switch cover and keyboard on page 64)

Remove the palm rest:

1. Position the computer right-side up with the front toward you.
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2. On 15-in models:

a. Remove the two Phillips PM2.5x3.0 broadhead screws (1) that secure the palm rest to the
computer.

b. Slide the palm rest back toward the display (2), and then lift and rotate the front edge (3) to
gain access to the TouchPad cable.

On 14-in models:

a. Remove the three Phillips PM2.5x3.0 broadhead screws (1) that secure the palm rest to the
computer.

b. Slide the palm rest back toward the display (2), and then lift the front edge (3) to gain access
to the TouchPad cable.
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3. Release the ZIF connector (1) to which the TouchPad cable is connected, and then disconnect the
TouchPad cable (2) from the system board.

4. Remove the palm rest.

Reverse this procedure to install the palm rest.
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Hard drive

Bf NOTE: The hard drive spare part kit includes a hard drive bracket.

Description Spare part number
500-GB, 7200-rpm hard drive 575195-001
500-GB, 5400-rpm hard drive 536414-001
320-GB, 7200-rpm hard drive 575194-001
320-GB, 5400-rpm hard drive 536413-001
250-GB, 7200-rpm hard drive 538972-001
250-GB, 5400-rpm hard drive 536412-001
160-GB, 7200-rpm hard drive 538971-001
160-GB, 5400-rpm hard drive 536411-001

Before removing the hard drive, follow these steps:

1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

Disconnect all external devices connected to the computer.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

Remove the battery (see Battery on page 63).
Remove the following components:

a. Switch cover and keyboard (see Switch cover and keyboard on page 64)

b. Palm rest (see Palm rest on page 75)

Remove the hard drive:

1.
2.

Position the computer right-side up with the front toward you.

Remove the two Phillips PM2.0x4.0 screws (1) and loosen the Phillips PM2.5%11.0 captive screw
(2) that secures the hard drive to the computer.

Grasp the Mylar tab on the hard drive and slide the hard drive (3) to the left to disconnect it from
the system board.
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4. Remove the hard drive (4) from the hard drive bay.

5. Ifitis necessary to replace the hard drive bracket, remove the two Phillips PM3.0x4.0 hard drive
bracket screws (1) from each side of the hard drive.

6. Lift the bracket (2) straight up to remove it from the hard drive.

Reverse this procedure to reassemble and install the hard drive.
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WLAN module

Description Spare part number

Intel Wi-Fi Link 5100 802.11a/b/g/n WLAN module for use in all countries and regions except 480985-001
Pakistan, Russia, and the Ukraine

Intel Wi-Fi Link 5100 802.11a/b/g WLAN module 482957-001

Broadcom 4322 802.11a/b/g/n WLAN modules:

e  Foruse in Antigua and Barbuda, Barbados, Belize, Canada, the Cayman Islands, Guam, 504664-001
Puerto Rico, Trinidad and Tobago, the U.S. Virgin Islands, and the United States

e  For use in Afghanistan, Albania, Algeria, Andorra, Angola, Antigua and Barbuda, Argentina, 504664-002
Armenia, Aruba, Australia, Austria, Azerbaijan, the Bahamas, Bahrain, Bangladesh, Barbados,
Belarus, Belgium, Belize, Benin, Bermuda, Bhutan, Bolivia, Bosnia and Herzegovina,
Botswana, Brazil, the British Virgin Islands, Brunei, Bulgaria, Burkina Faso, Burundi,
Cameroon, Cape Verde, the Central African Republic, Chad, Chile, the People's Republic of
China, Colombia, Comoros, the Congo, Costa Rica, Croatia, Cyprus, the Czech Republic,
Denmark, Djibouti, Dominica, the Dominican Republic, East Timor, Ecuador, Egypt, El
Salvador, Equitorial Guinea, Eritrea, Estonia, Ethiopia, Fiji, Finland, France, French Guiana,
Gabon, Gambia, Georgia, Germany, Ghana, Gibraltar, Greece, Grenada, Guadeloupe,
Guatemala, Guinea, Guinea-Bissau, Guyana, Haiti, Honduras, Hong Kong, Hungary, Iceland,
India, Ireland, Israel, ltaly, the Ivory Coast, Jamaica, Jordan, Kazakhstan, Kenya, Kiribati,
Kyrgyzstan, Laos, Latvia, Lebanon, Lesotho, Liberia, Liechtenstein, Lithuania, Luxembourg,
Macedonia, Madagascar, Malawi, Malaysia, the Maldives, Mali, Malta, the Marshall Islands,
Martinique, Mauritania, Mauritius, Mexico, Micronesia, Monaco, Mongolia, Montenegro,
Morocco, Mozambique, Namibia, Nauru, Nepal, the Nether Antilles, the Netherlands, New
Zealand, Nicaragua, Niger, Nigeria, Norway, Oman, Pakistan, Palau, Panama, Papua New
Guinea, Paraguay, Peru, the Philippines, Poland, Portugal, the Republic of Moldova, Romania,
Russia, Rwanda, Samoa, San Marino, Sao Tome and Principe, Saudi Arabia, Senegal, Serbia,
the Seychelles, Sierra Leone, Singapore, Slovakia, Slovenia, the Solomon Islands, Somalia,
South Africa, South Korea, Spain, Sri Lanka, St. Kitts and Nevis, St. Lucia, St. Vincent and the
Grenadines, Suriname, Swaziland, Sweden, Switzerland, Taiwan, Tajikistan, Tanzania, Togo,
Tonga, Trinidad and Tobago, Tunisia, Turkey, Turkmenistan, Tuvalu, Uganda, Ukraine, the
United Arab Emirates, the United Kingdom, Uruguay, Uzbekistan, Vanuatu, Venezuela,
Vietnam, Yemen, Zaire, Zambia, and Zimbabwe

Broadcom BCM4312 802.11b/g WLAN modules:

e  Foruse in Antigua and Barbuda, Barbados, Belize, Canada, the Cayman Islands, Guam, 504593-003
Puerto Rico, Trinidad and Tobago, the U.S. Virgin Islands, and the United States
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Description Spare part number

For use in Afghanistan, Albania, Algeria, Andorra, Angola, Antigua and Barbuda, Argentina, 504593-004
Armenia, Aruba, Australia, Austria, Azerbaijan, the Bahamas, Bahrain, Bangladesh, Barbados,
Belarus, Belgium, Belize, Benin, Bermuda, Bhutan, Bolivia, Bosnia and Herzegovina,
Botswana, Brazil, the British Virgin Islands, Brunei, Bulgaria, Burkina Faso, Burundi,
Cameroon, Cape Verde, the Central African Republic, Chad, Chile, the People's Republic of
China, Colombia, Comoros, the Congo, Costa Rica, Croatia, Cyprus, the Czech Republic,
Denmark, Djibouti, Dominica, the Dominican Republic, East Timor, Ecuador, Egypt, El
Salvador, Equitorial Guinea, Eritrea, Estonia, Ethiopia, Fiji, Finland, France, French Guiana,
Gabon, Gambia, Georgia, Germany, Ghana, Gibraltar, Greece, Grenada, Guadeloupe,
Guatemala, Guinea, Guinea-Bissau, Guyana, Haiti, Honduras, Hong Kong, Hungary, Iceland,
India, Ireland, Israel, Italy, the Ivory Coast, Jamaica, Jordan, Kazakhstan, Kenya, Kiribati,
Kyrgyzstan, Laos, Latvia, Lebanon, Lesotho, Liberia, Liechtenstein, Lithuania, Luxembourg,
Macedonia, Madagascar, Malawi, Malaysia, the Maldives, Mali, Malta, the Marshall Islands,
Martinique, Mauritania, Mauritius, Mexico, Micronesia, Monaco, Mongolia, Montenegro,
Morocco, Mozambique, Namibia, Nauru, Nepal, the Nether Antilles, the Netherlands, New
Zealand, Nicaragua, Niger, Nigeria, Norway, Oman, Pakistan, Palau, Panama, Papua New
Guinea, Paraguay, Peru, the Philippines, Poland, Portugal, the Republic of Moldova, Romania,
Russia, Rwanda, Samoa, San Marino, Sao Tome and Principe, Saudi Arabia, Senegal, Serbia,
the Seychelles, Sierra Leone, Singapore, Slovakia, Slovenia, the Solomon Islands, Somalia,
South Africa, South Korea, Spain, Sri Lanka, St. Kitts and Nevis, St. Lucia, St. Vincent and the
Grenadines, Suriname, Swaziland, Sweden, Switzerland, Taiwan, Tajikistan, Tanzania, Togo,
Tonga, Trinidad and Tobago, Tunisia, Turkey, Turkmenistan, Tuvalu, Uganda, Ukraine, the
United Arab Emirates, the United Kingdom, Uruguay, Uzbekistan, Vanuatu, Venezuela,
Vietnam, Yemen, Zaire, Zambia, and Zimbabwe

Broadcom 4322 AGN 802.11a/b/g WLAN module

For use in Antigua and Barbuda, Barbados, Belize, Canada, the Cayman Islands, Guam, 518434-001
Puerto Rico, Trinidad and Tobago, the U.S. Virgin Islands, and the United States

For use in Afghanistan, Albania, Algeria, Andorra, Angola, Antigua and Barbuda, Argentina, 518434-002
Armenia, Aruba, Australia, Austria, Azerbaijan, the Bahamas, Bahrain, Bangladesh, Barbados,
Belarus, Belgium, Belize, Benin, Bermuda, Bhutan, Bolivia, Bosnia and Herzegovina,
Botswana, Brazil, the British Virgin Islands, Brunei, Bulgaria, Burkina Faso, Burundi,
Cameroon, Cape Verde, the Central African Republic, Chad, Chile, the People's Republic of
China, Colombia, Comoros, the Congo, Costa Rica, Croatia, Cyprus, the Czech Republic,
Denmark, Djibouti, Dominica, the Dominican Republic, East Timor, Ecuador, Egypt, EI
Salvador, Equitorial Guinea, Eritrea, Estonia, Ethiopia, Fiji, Finland, France, French Guiana,
Gabon, Gambia, Georgia, Germany, Ghana, Gibraltar, Greece, Grenada, Guadeloupe,
Guatemala, Guinea, Guinea-Bissau, Guyana, Haiti, Honduras, Hong Kong, Hungary, Iceland,
India, Ireland, Israel, Italy, the Ivory Coast, Jamaica, Jordan, Kazakhstan, Kenya, Kiribati,
Kyrgyzstan, Laos, Latvia, Lebanon, Lesotho, Liberia, Liechtenstein, Lithuania, Luxembourg,
Macedonia, Madagascar, Malawi, Malaysia, the Maldives, Mali, Malta, the Marshall Islands,
Martinique, Mauritania, Mauritius, Mexico, Micronesia, Monaco, Mongolia, Montenegro,
Morocco, Mozambique, Namibia, Nauru, Nepal, the Nether Antilles, the Netherlands, New
Zealand, Nicaragua, Niger, Nigeria, Norway, Oman, Pakistan, Palau, Panama, Papua New
Guinea, Paraguay, Peru, the Philippines, Poland, Portugal, the Republic of Moldova, Romania,
Russia, Rwanda, Samoa, San Marino, Sao Tome and Principe, Saudi Arabia, Senegal, Serbia,
the Seychelles, Sierra Leone, Singapore, Slovakia, Slovenia, the Solomon Islands, Somalia,
South Africa, South Korea, Spain, Sri Lanka, St. Kitts and Nevis, St. Lucia, St. Vincent and the
Grenadines, Suriname, Swaziland, Sweden, Switzerland, Taiwan, Tajikistan, Tanzania, Togo,
Tonga, Trinidad and Tobago, Tunisia, Turkey, Turkmenistan, Tuvalu, Uganda, Ukraine, the
United Arab Emirates, the United Kingdom, Uruguay, Uzbekistan, Vanuatu, Venezuela,
Vietnam, Yemen, Zaire, Zambia, and Zimbabwe
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Description Spare part number

Intel Wi-Fi Link 1000, 802.11b/g/n WLAN module

For use in Andorra, Antigua and Barbuda, Argentina, Aruba, Australia, Austria, Azerbaijan, the 572520-001
Bahamas, Barbados, Belgium, Bolivia, Bosnia and Herzegovina, Brazil, Brunei, Bulgaria,
Canada, Cayman Islands, Chile, China, Colombia, Costa Rica, Croatia, Cyprus, the Czech
Republic, Denmark, the Dominican Republic, Ecuador, Egypt, El Salvador, Estonia, Finland,
France, French Guiana, Guadeloupe, Guam, Georgia, Germany, Ghana, Greece, Guatemala,
Haiti, Honduras, Hong Kong, Hungary, Iceland, India, Indonesia, Ireland, Israel, Italy, Ivory
Coast, Jamaica, Japan, Jordan, Kenya, Kuwait, Kyrgyzstan, Latvia, Lebanon, Liechtenstein,
Lithuania, Luxembourg, Malawi, Malaysia, Malta, Martinique, Mauritius, Mexico, Monaco,
Montenegro, Morocco, the Nether Antilles, the Netherlands, New Zealand, Nicaragua, Nigeria,
Nigeria, Oman, Pakistan, Panama, Paraguay, Peru, the Philippines, Poland, Portugal, Puerto
Rico, Quatar, Romania, San Marino, Saudi Arabia, Senegal, Singapore, Slovakia, Slovenia,
South Africa, South Korea, Spain, Sri Lanka, Sweden, Switzerland, Taiwan, Tanzania,
Thailand, Trinidad and Tobago, Turkey, United Arab Emirates, the United Kingdom, the United
States, Uruguay, the U.S. Virgin Islands, Venezuela, and Vietnam

/A CAUTION: To prevent an unresponsive system, replace the wireless module only with a wireless
module authorized for use in the computer by the governmental agency that regulates wireless devices
in your country or region. If you replace the module and then receive a warning message, remove the
module to restore computer functionality, and then contact technical support through Help and Support.

Before removing the WLAN module, follow these steps:

1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

Disconnect all external devices connected to the computer.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

Remove the battery (see Battery on page 63).

Remove the following components:

a. Switch cover and keyboard (see Switch cover and keyboard on page 64)

b. Palm rest (see Palm rest on page 75)

Remove the WLAN module:

1.
2,

Position the computer right-side up with the front toward you.

Disconnect the WLAN antenna cables (1) from the terminals on the WLAN module.

B NOTE: The black WLAN antenna cable is connected to the WLAN module “Main” terminal. The

3.

white WLAN antenna cable is connected to the WLAN module “Aux” terminal.

Remove the two Phillips PM2.5x3.0 screws (2) that secure the WLAN module to the computer.
(The edge of the module opposite the slot rises away from the computer.)
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4. Remove the WLAN module (3) by pulling the module away from the slot at an angle.

[ NOTE: WLAN modules are designed with a notch (4) to prevent incorrect insertion.

Reverse this procedure to install the WLAN module.
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Display assembly on computers with 15-in displays

B NOTE: Forinformation about removing the display from 14-in models, see Display assembly on
computers with 14-in displays on page 97.

NOTE: The display assembly spare part kit includes 2 WLAN antenna transceivers and cables.

Description Spare part number

For use only with black computers with 15.6-in displays

15.6-in WXGA HD BrightView display assembly 535850-001

15.6-in WXGA HD BrightView display assembly for use in computers equipped with a webcam and 535854-001
WWAN module

15.6-in WXGA HD BrightView display assembly for use on computers equipped with a webcam 535853-001

15.6-in WXGA HD AntiGlare display assembly 535849-001

15.6-in WXGA HD AntiGlare display assembly for use on computers equipped with a webcam 535851-001

15.6-in WXGA HD+ AntiGlare display assembly for use on computers equipped with a webcam 535855-001

15.6-in WXGA HD AntiGlare display assembly for use on computers equipped with a webcam and 535852-001
WWAN

15.6-in WXGA HD+ AntiGlare display assembly for use on computers equipped with a webcam and 535856-001
WWAN

For use only with red computers with 15.6-in displays

15.6-in HD WXGA BrightView display assembly (1366x768 resolution) 572716-001

15.6-in HD WXGA BrightView display assembly for use in computers equipped with a webcam 572719-001
(1366%768 resolution)

15.6-in HD WXGA BrightView display assembly for use in computers with a webcam and WWAN  572720-001
module (1366x768 resolution)

15.6-in HD WXGA AntiGlare display assembly (1366x%768 resolution) 572715-001

15.6-in WXGA HD AntiGlare display assembly for use on computers equipped with a webcam 572717-001
(1366%768 resolution)

15.6-in WXGA HD+ AntiGlare display assembly for use on computers equipped with a webcam 572721-001
(1600%900 resolution)

15.6-in WXGA HD AntiGlare display assembly for use in computers with a webcam and a WWAN  572718-001
module (1366x768 resolution)

15.6-in WXGA HD+ AntiGlare display assembly for use in computers with a webcam and a WWAN  572722-001
module (1600x900 resolution)

Before removing the display assembly, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.
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4.
5.

Remove the battery (see Battery on page 63).

Remove the following components:

a. Switch cover and keyboard (see Switch cover and keyboard on page 64)

b. Speakers (see Speakers on page 73)

c. Palm rest (see Palm rest on page 75)

Remove the display cables:

1.

2
3.
4

Position the computer right-side up with the front toward you.
Open the computer as far as possible.
Disconnect the display panel and webcam cable (1) from the system board.

Remove the microphone module cable from the routing path (2), and then disconnect the cable
(3) from the system board.

Remove the WLAN wireless antenna cables (4) from the tape, clips, and routing channels built into
the top cover.

On models with a WWAN module, remove the WWAN wireless antenna cables (5) from the tape,
clips, and routing channels built into the top cover.

Remove the display assembly:

/\ CAUTION: Support the display assembly when removing the following screws. Failure to support the
display assembly can result in damage to the display assembly and other computer components.

1.

Remove the six Phillips PM2.5%6.0 screws (1) that secure the display assembly to the computer.
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2. Lift the display assembly (2) straight up and remove it.

3. Ifitis necessary to replace the display bezel, display enclosure, or display hinges, remove the eight
rubber screw covers (1) and the eight Phillips PM2.0x6.0 screws (2) that secure the display bezel
to the display assembly. The rubber screw covers are available in the Rubber Kit, spare part number
535793-001.

N o — — — o —

4. Remove the bezel:
a. Flex the top of the bezel until it disengages from the display enclosure (1).
b. Flex the inside bottom of the bezel until it disengages from the display enclosure (2).
c. Flex the outside bottom of the bezel until it disengages from the display enclosure (3).
d. Lift the bottom corners of the bezel until it disengages (4).
e. Lift the bezel at the seam in the hinges until it disengages (5).

f.  Remove the bezel from the display enclosure.
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The display bezel is available using spare part numbers 536423-001 on computers with 14-in
displays and a webcam and 536422-001 on computers with 14-in displays and no webcam.

5. Ifitis necessary to replace the webcam module, gently pull the webcam module away from the
double-sided tape on the display enclosure (1), disconnect the webcam cable from the module

(2), and then remove the webcam. The webcam module can be ordered by using spare part number
535797-001.

Bf NOTE: To replace the webcam module in the display enclosure, align the holes on the webcam
module with the pins on the display enclosure and press onto the double-sided tape.
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6. Ifitis necessary to replace the display hinges, remove the display panel by removing the four
Phillips PM2.5x%4.5 screws (1) that secure the panel to the display enclosure, and then remove the
panel from the enclosure (2).

7. Remove the eight Phillips PM2.0x3.0 screws (1) that secure the display hinges to the display panel,
and then remove the display hinges (2). The left and right display hinges are available in the Display
Hinge Kit, spare part number 535872-001 for computers with 15-in displays.
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8. Ifitis necessary to replace the display/webcam cable, turn the display panel upside-down and peel
back the tape that secures the display cable to the display panel (1), and then disconnect the cable
from the connector on the back of the display panel (2).

Bf NOTE: The display cable and webcam cable are bound together as one cable assembly.

—

9. Gently pull the webcam cable (1) from the clips and routing channels (2) built into the top cover.
The display/webcam cable is included in the Display Cable Kit, spare part number 536433-001 for
computers with 15-in displays.

Reverse this procedure to reassemble and install the display assembily.
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Top cover

Bf NOTE: The top cover removal procedures differ for 15-in computers from those of 14-in computers.

NOTE: You must remove the top cover before you can remove the display assembly on computers
with 14-in displays. You do not have to remove the top cover to remove the display assembly on
computers with 15-in displays.

Description Spare part number
Top cover for use in computers with 15-in displays 535866-001
Top cover for use in computers with 14-in displays 535865-001

Before removing the top cover, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 63).

5. Remove the following components:

a. Switch cover and keyboard (see Switch cover and keyboard on page 64)

b. Speakers (see Speakers on page 73)

c. Optical drive (see Optical drive on page 69)

d. Palm rest (see Palm rest on page 75)

Remove the top cover:

B NOTE: Steps 1 through 5 illustrate how to remove the top cover from computers with 15-in displays.
Steps 6 through 10 illustrate how to remove the top cover from computers with 14-in displays.

1. Position the computer right-side up with the front toward you.
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2. Disconnect the power button board cable from the system board by releasing the ZIF connector
(1), and then disconnecting the cable (2).

4. Remove the two Phillips PM2.0%4.0 screws (1) and the three Phillips PM2.0%2.0 screws (2) that
secure the top cover to the computer.
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5. Flex the front edge of the top cover and lift up (1) until it disengages from the base enclosure,
release the top cover from the sides of the base enclosure (2), and then remove the top cover

(3).

Bf NOTE: Steps 6 through 13 illustrate how to remove the top cover from computers with 14-in
displays. Steps 1 through 5 illustrate how to remove the top cover from computers with 15-in
displays.

6. Position the computer right-side up with the front toward you.
7. Disconnect the display panel cable (1) from the system board.

8. Remove the microphone module cable from the routing path (2), and then disconnect the cable
(3) from the system board.

9. Remove the WLAN wireless antenna cables (4) from the clips and routing channels built into the
top cover.
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10. Remove the 21 PM2.5x6.0 screws that secure the top cover to the computer.

11. Remove the Phillips PM2.0x4.5 screw that secures the top cover to the computer.

T
I
I
I
I

12. Lift the top cover until it disengages from the base enclosure (1). Locations at which the top cover
more securely connects to the base enclosure are indicated by callout (2). If necessary, apply
additional upward pressure at these points to disengage the top cover.

13. Remove the top cover (3).

Reverse this procedure to install the top cover.
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Power button board

Description Spare part number
Power button board for use in computers with 15-in displays (includes cable) 574513-001
Power button board for use in computers with 14-in displays (includes cable) 574514-001

Before removing the power button board, follow these steps:

1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

Disconnect all external devices connected to the computer.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

Remove the battery (see Battery on page 63).

Remove the following components:

a.

b.

Switch cover and keyboard (see Switch cover and keyboard on page 64)

Optical drive (see Optical drive on page 69)

Speakers (see Speakers on page 73)

Palm rest (see Palm rest on page 75)

Hard drive (see Hard drive on page 78)

Top cover (see Top cover on page 90)

Display assembly (see Display assembly on computers with 15-in displays on page 84 or
Display assembly on computers with 14-in displays on page 97)

Remove the power button board:

1.

Position the top cover upside-down with the rear toward you.
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2. Lift the power button board straight up and off the top cover.

B NOTE: Computer with 15-in display shown.

Reverse this procedure to install the power button board.
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RTC battery

Description Spare part number

RTC battery 449137-001

Before removing the RTC battery, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 63).

5. Remove the following components:

a. Switch cover and keyboard (see Switch cover and keyboard on page 64)

b. Palm rest (see Palm rest on page 75)

c. Top cover on 14-in models (see Top cover on page 90)

Remove the RTC battery:
1. Position the computer right-side up with the front toward you.

2. Remove the RTC battery from the socket on the system board.

Reverse this procedure to install the RTC battery.
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Display assembly on computers with 14-in displays

Bf NOTE: Forinformation about removing the display from 15-in models, see Display assembly on
computers with 15-in displays on page 84.

NOTE: The display assembly spare part kit includes 2 WLAN antenna transceivers and cables.

Description Spare part number

For use only with black computers with 14.0-in displays

14.0-in WXGA HD BrightView display assembly 535844-001

14.0-in WXGA HD BrightView display assembly for use in computers equipped with a webcam 535847-001

14.0-in WXGA HD AntiGlare display assembly 535843-001

14.0-in WXGA HD AntiGlare display assembly for use in computers equipped with a webcam 535846-001

For use only with red computers

14.0-in WXGA HD BrightView display assembly 572710-001

14.0-in WXGA HD BrightView display assembly for use in computers equipped with a webcam 572713-001

14.0-in WXGA HD AntiGlare display assembly 572709-001

14.0-in WXGA HD AntiGlare display assembly for use in computers equipped with a webcam 572712-001

Before removing the 14-in display assembly, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 63).

5. Remove the following components:

a. Switch cover and keyboard (see Switch cover and keyboard on page 64)

b. Optical drive (see Optical drive on page 69)

c. Speakers (see Speakers on page 73)

d. Top cover (see Top cover on page 90)

e. Palm rest (see Palm rest on page 75)
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Remove the display assembly:
1. Position the computer right-side up with the front toward you.

2. Open the computer as far as possible.

/A CAUTION: Support the display assembly when removing the following screws. Failure to support
the display assembly can result in damage to the display assembly and other computer
components.

3.  Remove the four Phillips PM2.5%4.5 screws (1) that secure the display assembly to the computer.

Bf NOTE: When replacing the display assembly, only replace the four bottom screws. The top screw
on each side is replaced when you install the top cover.

4. Lift the display assembly up and off the computer (2).

5. Ifitis necessary to replace the display bezel, display enclosure, or display hinges, remove the eight
rubber screw covers (1) and the eight Phillips PM2.5%6.0 screws (2) that secure the display bezel
to the display assembly. The rubber screw covers are available in the Rubber Kit, spare part number
535793-001.

E o — — — o —
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Remove the bezel:

a. Flex the top of the bezel until it disengages from the display enclosure (1).

b. Flex the inside bottom of the bezel until it disengages from the display enclosure (2).
c. Flex the outside bottom of the bezel until it disengages from the display enclosure (3).
d. Lift the bottom corners of the bezel until it disengages (4).

e. Lift the bezel at the seam in the hinges until it disengages (5).

f.  Remove the bezel from the display enclosure.

) L

The display bezel is available using spare part numbers 536423-001 on computers with 14-in
displays and a webcam and 536422-001 on computers with 14-in displays and no webcam.

If it is necessary to replace the webcam module, gently pull the webcam module away from the
double-sided tape on the display enclosure (1) and disconnect the webcam cable from the module
(2). The webcam module can be ordered by using spare part number 535797-001.

Bf NOTE: To replace the webcam module in the display enclosure, align the holes on the webcam
module with the pins on the display enclosure and press onto the double-sided tape.
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8. Ifitis necessary to replace the display hinges, remove the two Phillips PM2.5x4.5 screws (1) that
secure the panel to the display enclosure. Then lift the bottom of the panel (2) to remove it from
the enclosure.

9. Remove the six Phillips PM2.0x%3.0 screws (1) that secure the display hinges to the display panel,
and then remove the display hinges (2). The left and right display hinges are available in the Hinge
Kit, spare part number 535871-001 for computers with 14-in displays.
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10. Ifitis necessary to replace the webcam cable, gently pull the webcam cable (1) from the clips and
routing channels (2) built into the top cover, and then remove the cable (3). The webcam cable is
included in the Display Cable Kit, spare part number 536430-001 for computers with 14-in displays.

Reverse this procedure to install the display assembly.
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Bluetooth module

Bf NOTE: The Bluetooth module spare part kit does not include a Bluetooth module cable. The Bluetooth
module cable is included in the Cable Kit, spare part number 536539-001 for computers with 15-in
displays, 536538-001 for computers with 14-in displays. See Cable Kit on page 45 for more Cable Kit
spare part number information.

Description Spare part number

HP Integrated Bluetooth 2.0 module for use in all countries and regions except Japan and Asia 483113-001
Pacific countries and regions

HP Integrated Bluetooth 2.1 module for use in all countries and regions except Japan and Asia 537921-001
Pacific countries and regions

Before removing the Bluetooth module, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 63).

5. Remove the following components:

a. Switch cover and keyboard (see Switch cover and keyboard on page 64)

b. Top cover (see Top cover on page 90)

c. Palm rest (see Palm rest on page 75)

d. Hard drive (see Hard drive on page 78)

Remove the Bluetooth module:
1. Position the computer right-side up with the front toward you.
2. Disconnect the Bluetooth module cable (1) from the system board.

3.  Remove the Bluetooth module cable (2) from the routing path.
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4. Remove the Bluetooth module (3) from the base enclosure.

Reverse this procedure to install the Bluetooth module.

Modem module

Description Spare part number
For use in all countries and regions except Australia and New Zealand 510100-001
For use only in Australia and New Zealand 510100-011

Before removing the modem module, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 63).

5. Remove the following components:

a. Switch cover and keyboard (see Switch cover and keyboard on page 64)

b. Optical drive (see Optical drive on page 69)

c. Speakers (see Speakers on page 73)

d. Palm rest (see Palm rest on page 75)

e. Top cover (see Top cover on page 90)
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Remove the modem module:

1.

2
3.
4

5.

Position the computer right-side up with the front toward you.
Remove the two Phillips PM2.5%3.0 screws (1) that secure the modem module to the system board.
Lift the modem module (2) straight up to disconnect it from the system board.

Remove the tape (3) that secures the cable to the modem module, and then disconnect the modem
module cable (4).

Remove the modem module.

Reverse this procedure to install the modem module.

USB connector assembly

Bf NOTE: The USB connector assembly is included in the Misc Cable Kit, spare part number 536539-001
for computers with 15-in displays or 536538-001 for computers with 14-in displays.

Before removing the USB connector assembly, follow these steps:

1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

Disconnect all external devices connected to the computer.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

Remove the battery (see Battery on page 63).

Remove the following components:

a. Switch cover and keyboard (see Switch cover and keyboard on page 64)

b. Optical drive (see Optical drive on page 69)

c. Speakers (see Speakers on page 73)

d. Palm rest (see Palm rest on page 75)
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e. Hard drive (see Hard drive on page 78)

f. Display assembly (see Display assembly on computers with 15-in displays on page 84 or
Display assembly on computers with 14-in displays on page 97)

g. Top cover (see Top cover on page 90)

Remove the USB connector assembly:
1. Position the computer right-side up with the right side toward you.

2. Disconnect the cable from the system board (1) and remove the cable from the routing path in the
base enclosure (2).

3. Remove the Phillips PM2.5%x3.0 screw (3) and the Phillips PM2.5x7.0 screw (4) that secure the
USB connector assembly to the base enclosure.

4. Remove the USB connector assembly (5) from the base enclosure.

Reverse this procedure to install the USB connector assembly.
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Heat sink and fan

Bf NOTE: The heat sink spare part kit includes replacement thermal material.

Description Spare part number
Heat sink for use in computers with UMA graphics subsystems 535859-001
Heat sink for use in computers with discrete graphics subsystems 535767-001
Fan 535766-001

Before removing the heat sink, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 63).

5. Remove the following components:

a.
b.
c.
d.

e.

Switch cover and keyboard (see Switch cover and keyboard on page 64)

Speakers (see Speakers on page 73)

Optical drive (see Optical drive on page 69)

Palm rest (see Palm rest on page 75)

Top cover (see Top cover on page 90)

Remove the heat sink:

Bf NOTE: Steps 1 through 3 apply to computers with discrete subsystem memory on the system board.
Steps 4 through 6 apply to computers with UMA subsystem memory. Step 7 shows how to remove the
fan from the heat sink.

1. Position the computer right-side up with the front toward you.

2. Following the sequence stamped into the heat sink, loosen the seven screws (1), (2), (3), (4), (5),
(6), (7) around the processor.
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3. Disconnect the fan cable from the system board (8), and then remove the heat sink (9).

Bf NOTE: The thermal material must be thoroughly cleaned from the surfaces of the system board
(1), (2), and (3), and the heat sink components (4), (5), and (6) each time the heat sink is removed.
Replacement thermal material is included with all heat sink, system board, and processor spare
part kits.

@[
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Bf NOTE: Steps 4 through 6 apply to computers with UMA subsystem memory. Steps 1 through 3
apply to computers with discrete subsystem memory. Step 7 shows how to remove the fan from
the heat sink.

4. Position the computer right-side up with the front toward you.

5. Following the sequence stamped into the heat sink, loosen the five screws (1), (2), (3), (4), (5)
around the processor.
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6. Disconnect the fan cable from the system board (6), and remove the heat sink (7).

Bf NOTE: The thermal material must be thoroughly cleaned from the surfaces of the system board
(1) and (2) and the heat sink components (3) and (4) each time the heat sink is removed.
Replacement thermal material is included with all heat sink, system board, and processor spare
part kits.
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7. Ifitis necessary to remove the fan from the heat sink, remove the three Phillips PM2.0x3.0 screws
(1) that secure the fan to the heat sink, and then remove the fan from the heat sink (2).

/
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Reverse this procedure to install the heat sink and fan.
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Processor

Bf NOTE: The processor spare part kit includes replacement thermal material.

Description Spare part number

Intel Core2 Duo processors

T5870 2.0-GHz processor (2-MB L2 cache, 800-MHz FSB) 535835-001
T6570 2.1-GHz processor (2-MB L2 cache, 800-MHz FSB) 513598-001
T6670 2.2-GHz processor (2-MB L2 cache, 800-MHz FSB) 572927-001
T9400 2.53-GHz processor (6-MB L2 cache, 1066-MHz FSB) 507954-001
T9600 2.8-GHz processor (6-MB L2 cache, 1066-MHz FSB) 507952-001
P7370 2.0-GHz processor (3-MB L2 cache, 1066-MHz FSB) 507966-001
P7570 2.2-GHz processor (2-MB L2 cache, 800-MHz FSB) 572930-001
P8600 2.4-GHz processor (3-MB L2 cache, 1066-MHz FSB) 507961-001
P8700 2.53-GHz processor (3-MB L2 cache, 1066-MHz FSB) 507960-001

Intel Celeron M Processors

585 2.16-GHz processor (1-MB L2 cache, 667-MHz FSB) 519898-001

900 2.2-GHz processor (1-MB L2 cache, 667-MHz FSB) 534419-001

Intel Pentium Dual-Core processors

T4200 2.0-GHz processor (1-MB L2 cache, 800-MHz FSB) 513599-001
T4300 2.1-GHz processor (1-MB L2 cache, 800-MHz FSB) 572929-001
T4400 2.2-GHz processor (1-MB L2 cache, 800-MHz FSB) 584296-001

Intel Celeron Dual-Core processors

T1600 1.66-GHz processor (1-MB L2 cache, 667-MHz FSB) 532324-001
T1700 1.83-GHz processor (1-MB L2 cache, 667-MHz FSB) 534084-001
T3000 1.8-GHz processor (1-MB L2 cache, 800-MHz FSB) 572925-001
T3100 1.9-GHz processor (1-MB L2 cache, 800-MHz FSB) 572926-001

Before removing the processor, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.
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4. Remove the battery (see Battery on page 63).

5.  Remove the following components:

a. Switch cover and keyboard (see Switch cover and keyboard on page 64)

b. Optical drive (see Optical drive on page 69)

c. Speakers (see Speakers on page 73)

d. Palm rest (see Palm rest on page 75)

e. Top cover (see Top cover on page 90)
Remove the processor:
1. Position the computer right-side up with the front toward you.

2. Use aflat-bladed screwdriver to turn the processor locking screw (1) one-half turn counterclockwise
until you hear a click.

3.  Lift the processor (2) straight up and remove it.

Bf NOTE: When you install the processor, the gold triangle (3) on the processor must be aligned
with the triangle (4) embossed on the processor socket.

Reverse this procedure to install the processor.
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System board

Bf NOTE: The system board spare part kit includes replacement thermal material.

Description Spare part number

System board for use in computers with DDR2 memory that include a WWAN module:

GL47 system board with UMA graphics subsystem memory 535858-001
GL40 system board with UMA graphics subsystem memory 535857-001
System board with discrete graphics subsystem memory 535756-001

System board for use in computers with DDR2 memory that do not include a WWAN module:

GL47 system board with UMA graphics subsystem memory 574510-001
GL40 system board with UMA graphics subsystem memory 574509-001
System board with discrete graphics subsystem memory 574508-001

System board for use in computers with DDR3 memory that include a WWAN module:

GM45 system board with UMA graphics subsystem memory 583081-001
GL40 system board with UMA graphics subsystem memory 583080-001
System board with discrete graphics subsystem memory 583082-001

System board for use in computers with DDR3 memory that do not include a WWAN module:

GM45 system board with UMA graphics subsystem memory 583079-001
GL40 system board with UMA graphics subsystem memory 583078-001
System board with discrete graphics subsystem memory 583077-001

Before removing the system board, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 63).

5. Remove the following components:

a. Switch cover and keyboard (see Switch cover and keyboard on page 64)

b. Speakers (see Speakers on page 73)

c. WWAN module (see WWAN module on page 74)

d. Palm rest (see Palm rest on page 75)

e. WLAN module (see WLAN module on page 80)

f. Hard drive (see Hard drive on page 78)
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Optical drive (see Optical drive on page 69)

Display assembly (see Display assembly on computers with 15-in displays on page 84 or
Display assembly on computers with 14-in displays on page 97)

Top cover (see Top cover on page 90)

When replacing the system board, be sure that the following components are removed from the defective
system board and installed on the replacement system board:

Memory module (see Memory module on page 68)

WLAN module (see WLAN module on page 80)

WWAN module (see WWAN module on page 74)

Modem module (see Modem module on page 103)

Processor (see Processor on page 110)

Remove the system board:

1.
2,

Position the computer right-side up with the front toward you.

Disconnect the following cables from the system board:

(1) Bluetooth module cable

(2) USB connector module cable
(3) RJ-45 cable

(4) SIM board

(5) Power cable

Lift the rear edge of the system board (1) until it rests at an angle.
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4. Remove the system board from the base enclosure (2).

5. (15-in models only) If it is necessary to remove the optical drive connector from the system board,
pull the optical drive board straight off the connector on the system board. The optical drive board
is available using spare part number 535862-001.

. i

Reverse this procedure to install the system board.

SIM

Description Spare part number

SIM 536599-001

Before removing the SIM, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.
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3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 63).

5. Remove the following components:

a. Switch cover and keyboard (see Switch cover and keyboard on page 64)

b. Optical drive (see Optical drive on page 69)

c. Speakers (see Speakers on page 73)

d. WWAN module (see WWAN module on page 74)

e. Palmrest (see Palm rest on page 75)

f.  WLAN module (see WLAN module on page 80)

g. Hard drive (see Hard drive on page 78)

h. Top cover (see Top cover on page 90)

i. Display assembly (see Display assembly on computers with 15-in displays on page 84 or
Display assembly on computers with 14-in displays on page 97)

j. System board (see System board on page 112)

Remove the SIM:
1. Position the computer right-side up with the front toward you.
2.  Remove the two Phillips PM2.5%3.0 screws (1) that secure the SIM to the system board.

3.  Remove the SIM (2) by pulling the module straight up and off the computer.

Reverse this procedure to install the SIM.
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5 Computer Setup

Computer Setup in Windows Vista and Windows XP
Starting Computer Setup

Computer Setup is a preinstalled, ROM-based utility that can be used even when the operating system
is not working or will not load.

Ef NOTE: Some of the Computer Setup menu items listed in this guide may not be supported by your
computer.

NOTE: An external keyboard or mouse connected to a USB port can be used with Computer Setup
only if USB legacy support is enabled.

To start Computer Setup, follow these steps:

1. Turnon or restart the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.

2. Press f10 to enter BIOS Setup.

Using Computer Setup

Navigating and selecting in Computer Setup

The information and settings in Computer Setup are accessed from the File, Security, Diagnostics, and
System Configuration menus.

To navigate and select in Computer Setup, follow these steps:

1. Turnon or restart the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.

e To select a menu or a menu item, use the tab key and the keyboard arrow keys and then
press enter, or use a pointing device to click the item.

e To scroll up and down, click the up arrow or the down arrow in the upper-right corner of the
screen, or use the up arrow key or the down arrow key.

e To close open dialog boxes and return to the main Computer Setup screen, press esc, and
then follow the on-screen instructions.
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B NOTE: You can use either a pointing device (TouchPad, pointing stick, or USB mouse) or the
keyboard to navigate and make selections in Computer Setup.

2. Press f10 to enter BIOS Setup.
3. Select the File, Security, Diagnostics, or System Configuration menu.
To exit Computer Setup menus, choose one of the following methods:

e To exit Computer Setup menus without saving your changes, click the Exit icon in the lower-left
corner of the screen, and then follow the on-screen instructions.

Use the tab key and the arrow keys to select File > Ignore changes and exit, and then press
enter.

e To save your changes and exit Computer Setup menus, click the Save icon in the lower-left corner
of the screen, and then follow the on-screen instructions.

Use the tab key and the arrow keys to select File > Save changes and exit, and then press
enter.

Your changes go into effect when the computer restarts.

Restoring factory settings in Computer Setup

Bf NOTE: Restoring defaults will not change the hard drive mode.

To return all settings in Computer Setup to the values that were set at the factory, follow these steps:

1. Turnon orrestart the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.

Press 10 to enter BIOS Setup.
Use a pointing device or the arrow keys to select File > Restore defaults.

Follow the on-screen instructions.

o » 0 N

To save your changes and exit, click the Save icon in the lower-left corner of the screen, and then
follow the on-screen instructions.

Use the arrow keys to select File > Save changes and exit, and then press enter.

Your changes go into effect when the computer restarts.

B NOTE: Your password settings and security settings are not changed when you restore the factory
settings.
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Computer Setup menus

The menu tables in this section provide an overview of Computer Setup options.

Ef NOTE: Some of the Computer Setup menu items listed in this chapter may not be supported by your

computer.
File menu

Select To do this

System Information e View identification information for the computer and the

batteries in the system.

e View specification information for the processor, cache
and memory size, system ROM, video revision, and
keyboard controller version.

Set System Date and Time Set or change the date and time on the computer.

Restore defaults Replace the configuration settings in Computer Setup with the
original factory settings. (Hard drive mode, password settings,
and security settings are not changed when you restore the
factory settings.)

Ignore changes and exit Cancel any changes entered during the current session. Then
exit and restart the computer.

Save changes and exit Save any changes entered during the current session. Then

exit and restart the computer. Your changes go into effect
when the computer restarts.
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Security menu

Bf NOTE: Some of the menu items listed in this section may not be supported by your computer.

Select To do this

Setup BIOS Administrator Password Set up a BIOS administrator password.

User Management (requires a BIOS administrator password) e  Create a new BIOS user account.

e View a list of ProtectTools users.

Password Policy (requires a BIOS administrator password) Revise password policy criteria.

HP SpareKey Enable/disable HP SpareKey (disabled by default).

Always Prompt for HP SpareKey Enroliment Enable/disable HP SpareKey enroliment (disabled by default).
Allow Reset of HP ProtectTools security keys Enable/disable reset of HP ProtectTools security keys.
Change Password Enter, change, or delete a BIOS administrator password.

HP SpareKey Enrollment Enroll or reset HP SpareKey, which is a set of security

questions and answers used if you forget your password.

DriveLock Passwords e Enable/disable DriveLock on any computer hard drive
(enabled by default).

e  Change a DrivelLock user password or master password.

NOTE: DrivelLock settings are accessible only when you
enter Computer Setup by turning on (not restarting) the

computer.
Automatic DriveLock Enable/disable Automatic DriveLock support.
Disk Sanitizer Run Disk Sanitizer to destroy all existing data on the primary

hard drive or the drive in the upgrade bay.

CAUTION: Ifyourun Disk Sanitizer, the data on the selected
drive is destroyed permanently.

System IDs Enter a user-defined computer asset tracking number and
ownership tag.
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Diagnostics menu

Select

To do this

System Diagnostics Menu

e  System Information—Displays the following information:

° Identification information for the computer and the
batteries in the system.

° Specification information for the processor, cache
and memory size, system ROM, video revision, and
keyboard controller version.

e  Start-up Test—Verifies the system components needed
for starting the computer.

e  Run-In Test—Runs a comprehensive check on system
memory.

e Hard Disk Test—Runs a comprehensive self-test on any
hard drive in the system.

e  Error Log—Displays a log file if any errors have
occurred.
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System Configuration menu

Bf NOTE: Some of the listed System Configuration options may not be supported by your computer.

Select To do this
Language Change the Computer Setup language.
Boot Options e  Seta Startup Menu delay (in seconds).

e Enable/disable Custom Logo (disabled by default).

e Enable/disable Display Diagnostic URL (enabled by
default).

e Enable/disable CD-ROM boot (enabled by default).
e Enable/disable SD Card boot (enabled by default).
e Enable/disable floppy boot (enabled by default).

e Enable/disable PXE Internal NIC boot (disabled by
default).

e  Set the Express Boot Popup delay in seconds.

e  Set the boot order.

Device Configurations e  Enable/disable USB legacy support (enabled by default).
When enabled, USB legacy support allows the
following:

° Use of a USB keyboard in Computer Setup even
when a Windows® operating system is not running.

o Startup from bootable USB devices, including a hard
drive, diskette drive, or optical drive connected by a
USB port to the computer.

e Enable/disable fan always on while connected to an AC
outlet (disabled by default).

e Enable/disable Data Execution Prevention (select models
only; disabled by default). When enabled, the processor
can disable some virus code execution, which helps to
improve computer security.

e  SATA (Serial Advanced Technology Attachment) device
mode. The following options are available:

° AHCI (Advanced Host Controller Interface)
o IDE (Integrated Drive Electronics)

NOTE: Auvailability of the options above varies by
computer model.

e Enable/disable HP QuickLook 2 (enabled by default).

e Enable/disable Virtualization Technology (select models
only; disabled by default).

e Enable/disable Dual Core CPU (enabled by default).

e Enable/Disable Unified Extensible Firmware Interface
(UEFI) mode (enabled by default).
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Select

To do this

Built-In Device Options

Enable/disable the wireless button state (enabled by
default).

Enable/disable embedded WWAN device radio (enabled
by default).

Enable/disable embedded Bluetooth® device radio
(enabled by default).

Enable/disable the Network Interface Controller (LAN)
(enabled by default).

Set the wake on LAN state. Options include the
following:

° Disabled
° Boot to Network (set by default)
° Follow Boot Order

Enable/disable the optical disc drive (enabled by
default).

Enable/disable the microphone.
Enable/disable a modem device (enabled by default).

Enable/disable the embedded WLAN device (enabled by
default).

Enable/disable LAN/WLAN switching (disabled by
default).

Enable/disable the integrated camera (select models
only; enabled by default).

Port Options (all are enabled by default)

NOTE: All port options are enabled by default.

Enable/disable the ExpressCard slot.
Enable/disable the flash media reader.
Enable/disable the USB port.

CAUTION: Disabling the USB port also disables

MultiBay devices and ExpressCard devices on the
advanced port replicator.

Set Security Level

Change, view, or hide security levels for all BIOS menu items.

Restore Security Defaults

Restore the default security settings.
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Computer Setup in Linux

Starting Computer Setup

Computer Setup is a preinstalled, ROM-based utility that can be used even when the operating system
is not working or will not load.

Bf NOTE: Some of the Computer Setup menu items listed in this guide may not be supported by your
computer.

NOTE: Pointing devices are not supported in Computer Setup. You must use the keyboard to navigate
and make selections.

NOTE: An external keyboard connected by USB can be used with Computer Setup only if USB legacy
support is enabled.

To start Computer Setup, follow these steps:
1. Turn on or restart the computer.

2. Before your operating system opens and while the “F10=ROM Based Setup” message is displayed
in the lower-left corner of the screen, press f10.

Computer Setup in Linux 123



Using Computer Setup

Navigating and selecting in Computer Setup

The information and settings in Computer Setup are accessed from the File, Security, Diagnostics, and
System Configuration menus.

1. Open Computer Setup by turning on or restarting the computer, and then pressing f10 while the
"F10 = ROM Based Setup" message is displayed in the lower-left corner of the screen.

Because Computer Setup is not operating system based, it does not support the TouchPad.
Navigation and selection are by keystroke:

e To choose a menu or a menu item, use the arrow keys.
e To select an item, press enter.
e To close open dialog boxes and return to the main Computer Setup screen, press esc.
e  To view navigation information, press f1.
e To change the language, press f2.
2. Select the File, Security, Diagnostics, or System Configuration menu.
3. To exit Computer Setup, choose one of the following methods:

e To exit Computer Setup without saving your preferences, use the arrow keys to select File
> Ignore Changes And Exit. Then follow the instructions on the screen.

e To save your preferences and exit Computer Setup, use the arrow keys to select File > Save
Changes And Exit. Then follow the instructions on the screen.

Your preferences go into effect when the computer restarts.

Restoring factory settings in Computer Setup
To return all settings in Computer Setup to the values that were set at the factory, follow these steps:

1. Open Computer Setup by turning on or restarting the computer, and then pressing f10 while the
"F10 = ROM Based Setup" message is displayed in the lower-left corner of the screen.

2. Use the arrow keys to select File > Restore Defaults, and then press enter.
3. When the confirmation dialog box opens, press f10.

4. To save your preferences and exit Computer Setup, use the arrow keys to select File > Save
Changes And Exit. Then follow the instructions on the screen.

Your preferences go into effect when the computer restarts.

Bf NOTE: Your password settings and security settings are not changed when you restore the factory
settings.
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Computer Setup menus

The menu tables in this section provide an overview of Computer Setup options.

Bf NOTE: Some of the Computer Setup menu items listed in this chapter may not be supported by your

computer.
File menu

Select To do this

System information e View identification information for the computer.

e View specification information for the processor, cache
and memory size, and system ROM.

Restore Defaults Replace the configuration settings in Computer Setup with the
original factory settings. (Password settings and security
settings are not changed when you restore the factory
settings.)

Ignore Changes And Exit Cancel any changes entered during the current session. Then
exit and restart the computer.

Save Changes And Exit Save any changes entered during the current session. Then

exit and restart the computer. Your changes go into effect
when the computer restarts.
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Security menu

Bf NOTE: Some of the menu items listed in this section may not be supported by your computer.

Select

To do this

Setup Password

Enter, change, or delete a setup password.

Power-On Password

Enter, change, or delete a power-on password.

Password Options

e Enable/disable stringent security.

e Enable/disable the password requirement on computer
restart.

DriveLock Passwords

e  Enable/disable DriveLock on any computer hard drive.

e Enter, change, or disable DriveLock on an optional
MultiBay hard drive.

NOTE: DriveLock settings are accessible only when you
enter Computer Setup by turning on (not restarting) the
computer.

System IDs

Enter a user-defined computer asset tracking number and
ownership tag.

Disk Sanitizer

Run Disk Sanitizer to destroy all existing data on the primary
hard drive. The following options are available:

e Fast: Runs the Disk Sanitizer erase cycle once.
e  Optimum: Runs the Disk Sanitizer erase cycle 3 times.

e  Custom: Allows you to select the desired number of Disk
Sanitizer erase cycles from a list.

CAUTION: If you run Disk Sanitizer, the data on the primary
hard drive is destroyed permanently.

Diagnostics menu

Select

To do this

HDD Self-Test Options

Run a comprehensive self-test on any hard drive in the system
or on any optional MultiBay hard drive.

Memory Check

Run a comprehensive check on system memory.
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System Configuration menu

Bf NOTE: Some of the listed System Configuration options may not be supported by your computer.

Select To do this
Language Change the Computer Setup language.
Boot options e Setanf9, f10, and f12 delay when starting up.

Enable/disable CD-ROM boot.
Enable/disable floppy boot.
Enable/disable internal network adapter boot.

Enable/disable MultiBoot, which sets a boot order that
can include most boot devices in the system.

Set the Express Boot Popup delay in seconds.
Set the boot order.

o 1st boot device: USB CD-ROM

o 2nd boot device: USB floppy

° 3rd boot device: USB SuperDisk

o 4th boot device: Notebook hard drive

o 5th boot device: USB hard disk

° 6th boot device: Network controller

Device Configurations °

Swap the functions of the fn key and left ctrl key.

Enable/disable USB legacy support. When enabled, USB
legacy support allows the following:

° Use of a USB keyboard in Computer Setup even
when a your operating system is not running.

o Startup from bootable USB devices, including a hard
drive, diskette drive, or optical drive connected by a
USB port to the computer.

Enable/disable BIOS DMA data transfers.

Enable/disable fan always on while connected to an AC
outlet.

Enable/disable data execution prevention.
Enable/disable LAN power saving mode.
Enable/disable SATA Native Mode.
Enable/disable Dual Core CPU.

Enable/disable HDD translation mode.
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Select

To do this

Built-in device options

e Enable/disable embedded WLAN Device Radio.

e Enable/disable embedded Bluetooth Device Radio.
e Enable/disable Network Interface Controller (NIC)
e Enable/disable LAN/WLAN Switching.

e Enable/disable Wake on LAN.

e Enable/disable the integrated camera (webcam)

Port options

e Enable/disable USB port.

e Enable/disable ExpressCard slot.
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6 Specifications

Computer specifications

Metric uU.s.
Dimensions — 15-in
Depth 24.96 cm 9.83 in
Width 37.18 cm 14.6 in
Height (front to rear) 3.15t0 3.63 cm 1.24t01.43in
Dimensions — 14-in
Depth 23.24 cm 9.15in
Width 33.60 cm 13.21in
Height (front to rear) 3.10 to 3.58 cm 1.22t01.41in
Weight — 15-in (equipped with optical drive, WXGA display =~ < 2.59 kg <5.7 Ibs
assembly, 1 memory module, hard drive, and 6-cell battery)
Weight — 14-in (equipped with optical drive, WXGA display =~ < 2.27 kg <5.01lbs
assembly, 1 memory module, hard drive, and 6-cell battery)
Input power
Operating voltage 18.5Vdc@4.74 A-90 W
Operating current 474 A
Temperature
Operating (not writing to optical disc) 0°C to 35°C 32°F to 95°F
Operating (writing to optical disc) 5°C to 35°C 41°F to 95°F
Nonoperating -20°C to 60°C -4°F to 140°F
Relative humidity
Operating 10% to 90%
Nonoperating 5% to 95%
Maximum altitude (unpressurized)
Operating -15 m to 3,048 m -50 ft to 10,000 ft
Nonoperating -15mto 12,192 m -50 ft to 40,000 ft

Shock
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Metric u.s.

Operating 125 g, 2 ms, half-sine

Nonoperating 200 g, 2 ms, half-sine

Random vibration

Operating

0.75 g zero-to-peak, 10 Hz to 500 Hz, 0.25 oct/min sweep rate

Nonoperating

1.50 g zero-to-peak, 10 Hz to 500 Hz, 0.5 oct/min sweep rate

NOTE: Applicable product safety standards specify thermal limits for plastic surfaces. The computer operates well within this

range of temperatures.

14.1-in WXGA display specifications

Metric u.s.
Dimensions
Height 27.94 cm 11.0in
Width 20.83 cm 8.2in
Diagonal 35.56 cm 14.1in

Number of colors

Up to 16.8 million

Contrast ratio

250:1 (typical)

Brightness

180 nits (typical)

Pixel resolution

Pitch 0.279 x 0.279 mm
Format 1280 x 800
Configuration RGB vertical stripe
Backlight Edge lit
Character display 80 x 25

Total power consumption 4 W

Viewing angle

+/-40° horizontal, +20/-40° vertical (typical)
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15.6-in WXGA display specifications

Metric u.s.
Dimensions
Height 20.7 cm 8.1in
Width 33.1cm 13.0in
Diagonal 39.1cm 15.6in
Number of colors Up to 16.8 million
Contrast ratio 300:1 (typical)
Brightness 200 nits (typical)
Pixel resolution
Pitch 0.259 x 0.259 mm
Format 1280 x 800
Configuration RGB vertical stripe
Backlight CCFL
Character display 80 x 25
Total power consumption 4.0W
Viewing angle +/-30° horizontal, +10/—40° vertical (typical)
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Hard drive specifications

500-GB* 320-GB* 250-GB* 160-GB*
Dimensions
Height 9.5 mm 9.5 mm 9.5 mm 9.5 mm
Width 70 mm 70 mm 70 mm 70 mm
Weight 101g 101g 101g 101g
Interface type SATA SATA SATA SATA
Transfer rate 100 MB/sec 100 MB/sec 100 MB/sec 100 MB/sec
Security ATA security ATA security ATA security ATA security
Seek times (typical read, including setting)
Single track 3 ms 3ms 3 ms 3ms
Average 13 ms 13 ms 13 ms 13 ms
Maximum 24 ms 24 ms 24 ms 24 ms
Logical blocks 1,048,576,000 625,141,400 488,376,280 312,560,640
Disc rotational speed 5400 rpm 5400 rpm 7200 and 5400 7200 rpm and
rpm 5400 rpm
Operating temperature 5°C to 55°C (41° 5°C to 55°C (41° 5°C to 55°C (41° 5°C to 55°C (41°
F to 131°F) F to 131°F) F to 131°F) F to 131°F)

*1 GB = 1 billion bytes when referring to hard drive storage capacity. Actual accessible capacity is less. Actual drive
specifications may differ slightly.

NOTE: Certain restrictions and exclusions apply. Contact technical support for details.
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DVD-ROM Drive specifications

Applicable disc DVD-ROM (DVD-5, DVD-9, DVD-10, DVD-18, CD-ROM (Mode 1 and 2), CD Digital Audio,
CD-XA ready (Mode 2, Form 1 and Form 2), CD-I (Mode 2, Form 1 and Form 2), CD-R, CD-
RW, Photo CD (single and multisession), CD-Bridge

Access time CD DVD
Random <100 ms <125 ms
Cache buffer 512 KB

Data transfer rate

CD-R (24X) 3600 KB/s (150 KB/s at 1X CD rate)
CD-RW (10X) 1500 KB/s (150 KB/s at 1X CD rate)
CD-ROM (24X) 3600 KB/s (150 KB/s at 1X CD rate)
DVD (8X) 10,800 KB/s (1,352 KB/s at 1X DVD rate)
Multiword DMA mode 2 16.6 MB/s
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DVD*RW Double-Layer Combo Drive specifications

Applicable disc

Read:

CD-DA, CD+(E)G, CD-MIDI, CD-TEXT, CD-
ROM, CD-ROM XA, MIXED MODE CD, CD-l,
CD-I Bridge (Photo-CD, Video CD), Multisession

Write:

CD-R and CD-RW

DVD+R, DVD+RW, DVD-R, DVD-

CD (Photo-CD, CD-EXTRA, Portfolio, CD-R,CD- RW, DVD-RAM
RW), CD-R, CD-RW, DVD-ROM (DVD-5,
DVD-9, DVD-10, DVD-18), DVD-R, DVD-RW,
DVD+R, DVD+RW, DVD-RAM
Access time CD DVD
Random <175 ms <230 ms
Cache buffer 2 MB

Data transfer rate

24X CD-ROM 3,600 KB/sec
8X DVD-ROM 10,800 KB/sec
24X CD-R 3,600 KB/sec
16X CD-RW 2,400 KB/sec
8X DVD+R 10,800 KB/sec
4X DVD+RW 5,400 KB/sec
8X DVD-R 10,800 KB/sec
4X DVD-RW 5,400 KB/sec
2.4X DVD+R(9) 2,700 KB/sec
5X DVD-RAM 6,750 KB/sec

Transfer mode

Multiword DMA Mode
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Blu-ray Disc ROM Drive with SuperMulti DVDXR/RW
Double-Layer specifications

Applicable disc

Read:

Write:

CD-DA, CD+(E)G, CD-MIDI, CD-TEXT,
CD-ROM, CD-ROM XA,

MIXED MODE CD, CD-I, CD-I Bridge
(Photo-CD, Video CD), Multisession CD
(Photo-CD, CD-EXTRA, Portfolio, CD-
R, CD-RW), CD-R, CD-RW, DVD-
ROM (DVD-5, DVD-9, DVD-10,
DVD-18), DVD-R, DVD-RW, DVD+R,
DVD+RW, DVD-RAM, HD-

ROM (Single Layer), HD-ROM (Dual
Layer), HD DVD-R, HD DVD-R for
Dual Layer, HD DVD-RW, BD-ROM,
BD-R, BR-RE

CD-R and CD-RW DVD+R, DVD+R (9),
DVD+RW, DVD-R, DVD-R (9), DVD-RW,
DVD-RAM

Access time (o] DVD HD
Random 170 ms 170 ms 230 ms
Cache buffer 8 MB

Data transfer rate

24X CD-ROM 3,600 KB/sec
8X DVD-ROM 10,800 KB/sec
24X CD-R 3,600 KB/sec
16X CD-RW 2,400 KB/sec
8X DVD+R 10,800 KB/sec
4X DVD+RW 5,400 KB/sec
8X DVD-R 10,800 KB/sec
4X DVD-RW 5,400 KB/sec
2.4X DVD+R(9) 2,700 KB/sec
5X DVD-RAM 6,750 KB/sec
1X BD-ROM 4,500 KB/sec
1X BD-R read 4,500 KB/sec

1X BD-RE read

4,500 KB/sec

Transfer mode

Multiword DMA Mode
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System DMA specifications, Windows Vista and XP

Hardware DMA

System function

DMA4

Direct memory access controller

*ExpressCard controller can use DMA 1, 2, or 5.

System interrupt specifications, Windows Vista

Hardware IRQ

System function

ISAO System timer
ISA1 Standard 101-/102-Key or Microsoft Natural Keyboard
ISA8 System CMOS/real-time clock

ISA100 - ISA119

Microsoft ACPI-Compliant System

ISA12

Synaptics PS/2 TouchPad

ISA120 - ISA129

Microsoft ACPI-Compliant System

ISA13

Numeric data processor

ISA130 - ISA139

Microsoft ACPI-Compliant System

ISA14

ATA Channel 0

ISA140 - ISA149

Microsoft ACPI-Compliant System

ISA15

ATA Channel 1

ISA150 - ISA190

Microsoft ACPI-Compliant System

ISA23 HP Mobile Data Protection Sensor

ISA81 - ISA99 Microsoft ACPI-Compliant System

PCI16 Intel ICH9 Family USB Universal Host Controller — 2937
PCI16 Mobile Intel 4 Series Express Chipset Family

PCI17 Broadcom 802.11b/g WLAN

PCI17 High Definition Audio Controller

PCI17 Intel ICH9 Family USB Universal Host Controller — 2938
PCI17 Marvell Yukon 88E8072 PCI-E Gigabit Ethernet Controller
PCI18 Intel ICH9 Family USB Universal Host Controller — 2939
PCI18 Intel ICH9 Family USB Universal Host Controller — 2936
PCI18 Standard Dual Channel PCI IDE Controller

PCI19 Intel ICH9 Family USB2 Enhanced Host Controller — 293C
PCI-2 Intel ICH9 Family PCI Express Root Port 1 - 2940

PCI20 Intel ICH9 Family Universal Host Controller — 2934

PCI20 Intel ICH9 Family USB2 Enhanced Host Controller — 293A
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Hardware IRQ System function

PCI22 Intel ICH9 Family Universal Host Controller — 2935
PCI-3 Intel ICH9 Family PCI Express Root Port 2 - 2942
PCI-4 Intel ICH9 Family PCI Express Root Port 3 - 2944
PCI-5 Intel ICH9 Family PCI Express Root Port 5 - 2948
PCI-6 Intel ICH9 Family PCI Express Root Port 6 - 294A

System interrupt specifications, Windows XP

Hardware IRQ System function

ISAO System timer

ISA1 Standard 101-/102-Key or Microsoft Natural Keyboard
ISA8 System CMOS/real-time clock

ISA9 Microsoft ACPI-Compliant System

ISA12 Synaptics PS/2 TouchPad

ISA13 Numeric data processor

ISA23 HP Mobile Data Protection Sensor

PCI16 Intel ICH9 Family USB Universal Host Controller — 2937
PCI16 Mobile Intel 4 Series Express Chipset Family

PCI17 Broadcom 4322AG 802.11a/b/g/draft-n Wi-Fi Adapter
PCI17 Intel ICH9 Family PCI Express Root Port 1 - 2940

PCI17 Intel ICH9 Family PCI Express Root Port 5 - 2948

PCI17 Intel ICH9 Family USB Universal Host Controller — 2938
PCI17 Marvell Yukon 88E8072 PCI-E Gigabit Ethernet Controller
PCI17 Microsoft UAA Bus Driver for High Definition Audio

PCI18 Intel ICH9 Family PCI Express Root Port 3 - 2944

PCI18 Intel ICH9 Family USB Universal Host Controller — 2939
PCI18 Intel ICH9 Family USB Universal Host Controller — 2936
PCI19 Intel ICH9 Family USB2 Enhanced Host Controller — 293C
PCI20 Intel ICH9 Family Universal Host Controller — 2934

PCI20 Intel ICH9 Family USB2 Enhanced Host Controller — 293A
PCI21 ICHOM-E/M SATA AHCI Controller

PCI22 Intel ICH9 Family Universal Host Controller — 2935
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System I/O address specifications, Windows Vista

1/0 address (hex)

System function (shipping configuration)

000 - O1F Direct memory access controller

000 - CF7 PCl bus

020 - 021 Programmable interrupt controller

024 - 025 Programmable interrupt controller

028 - 029 Programmable interrupt controller

02C - 02D Programmable interrupt controller

02E - 02F Motherboard resources

030 - 031 Programmable interrupt controller

034 - 035 Programmable interrupt controller

038 - 039 Programmable interrupt controller

03C - 03D Programmable interrupt controller

040 - 043 System timer

04E - 04F Motherboard resources

050 - 053 System timer

060 - 060 Standard 101/102-Key or Microsoft Natural PS/2 Keyboard with HP QLB
061 - 061 Motherboard resources

062 - 062 Microsoft ACPI-Compliant Embedded Controller
063 - 063 Motherboard resources

064 - 064 Standard 101/102-Key or Microsoft Natural PS/2 Keyboard with HP QLB
065 - 065 Motherboard resources

066 - 066 Microsoft ACPI-Compliant Embedded Controller
067 - 067 Motherboard resources

070 -070 Motherboard resources

070 - 077 System CMOS/real time clock

080 - 080 Motherboard resources

081 - 091 Direct memory access controller

092 - 092 Motherboard resources

093 - 09F Direct memory access controller

0AO - 0A1 Programmable interrupt controller

0A4 - 0A5 Programmable interrupt controller

0A8 - 0A9 Programmable interrupt controller

0AC - OAD Programmable interrupt controller

0BO - 0B1 Programmable interrupt controller
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1/0 address (hex)

System function (shipping configuration)

0B2 - 0B3 Motherboard resources

0B4 - 0B5 Programmable interrupt controller

0B8 - 0B9 Programmable interrupt controller

0BC - 0BD Programmable interrupt controller

0CO - ODF Direct memory access controller

OF0 - OFO Numeric data processor

170 - 177 ATA Channel 1

1F0 - 1F7 ATA Channel 0

200 - 27F Motherboard resources

376 - 376 ATA Channel 1

3B0 - 3BB Mobile Intel 4 Series Express Chipset Family

3CO0 - 3DF Mobile Intel 4 Series Express Chipset Family

3F6 - 3F6 ATA Channel 0

400 - 47F Motherboard resources

4D0 - 4D1 Programmable interrupt controller

500 - 57F Motherboard resources

DO0O - FFFF PCl bus

1000 - 1003 Motherboard resources

1010 - 101F Motherboard resources

2000 - 20FF Marvell Yukon 88E8072 PCI-E Gigabit Ethernet Controller
2000 - 2FFF Intel ICH9 Family PCI Express Root Port 6 — 294A
3000 - 4FFF Intel ICH9 Family PCI Express Root Port 6 — 2948

5000 - 6FFF Intel ICH9 Family PCI Express Root Port 6 — 2944

7000 - 701F Intel ICH9 Family USB Universal Host Controller — 2936
7020 - 703F Intel ICH9 Family USB Universal Host Controller — 2935
7040 - 705F Intel ICH9 Family USB Universal Host Controller — 2934
7060 - 707F Intel ICH9 Family USB Universal Host Controller — 2939
7080 - 709F Intel ICH9 Family USB Universal Host Controller — 2938
70A0 - 70BF Intel ICH9 Family USB Universal Host Controller — 2937
70CO0 - 70CF Standard Dual Channel PCI IDE Controller

70D0 - 70DF Standard Dual Channel PCI IDE Controller

70EO - 70EF Standard Dual Channel PCI IDE Controller

70F0 - 70FF Standard Dual Channel PCI IDE Controller

7100 - 7107 Standard Dual Channel PCI IDE Controller

System I/O address specifications, Windows Vista
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1/0 address (hex) System function (shipping configuration)

7108 - 710F Standard Dual Channel PCI IDE Controller
7120 - 7127 Mobile Intel 4 Series Express Chipset Family
7128 -712B Standard Dual Channel PCI IDE Controller
712C - 712F Standard Dual Channel PCI IDE Controller
EF80 - EF9F Motherboard resources

FEOQO - FEOF Motherboard resources

FE80 - FE8F Motherboard resources

FFFF - FFFF Motherboard resources

System 1/O address specifications, Windows XP

1/0 address (hex) System function (shipping configuration)
000 - 01F Direct memory access controller

000 - CF7 PCI bus

020 - 021 Programmable interrupt controller

024 - 025 Programmable interrupt controller

028 - 029 Programmable interrupt controller

02C - 02D Programmable interrupt controller

02E - 02F Motherboard resources

030 - 031 Programmable interrupt controller

034 - 035 Programmable interrupt controller

038 - 039 Programmable interrupt controller

03C - 03D Programmable interrupt controller

040 - 043 System timer

04E - 04F Motherboard resources

050 - 053 System timer

060 - 060 Standard 101/102-Key or Microsoft Natural PS/2 Keyboard with HP QLB
061 - 061 Motherboard resources

062 - 062 Microsoft ACPI-Compliant Embedded Controller
063 - 063 Motherboard resources

064 - 064 Standard 101/102-Key or Microsoft Natural PS/2 Keyboard with HP QLB
065 - 065 Motherboard resources

066 - 066 Microsoft ACPI-Compliant Embedded Controller
067 - 067 Motherboard resources
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1/0 address (hex)

System function (shipping configuration)

070 - 070 Motherboard resources

070 - 077 System CMOS/real time clock

080 - 080 Motherboard resources

081 - 091 Direct memory access controller

092 - 092 Motherboard resources

093 - 09F Direct memory access controller

0AO - 0A1 Programmable interrupt controller

0A4 - 0A5 Programmable interrupt controller

0A8 - 0A9 Programmable interrupt controller

0AC - 0AD Programmable interrupt controller

0BO - 0B1 Programmable interrupt controller

0B2 - 0B3 Motherboard resources

0B4 - 0B5 Programmable interrupt controller

0B8 - 0B9 Programmable interrupt controller

0BC - 0BD Programmable interrupt controller

0CO - ODF Direct memory access controller

OF0 - OFO Numeric data processor

200 - 27F Motherboard resources

2E4 - 2E7 ISAPNP Read Data Port

3B0 - 3BB Mobile Intel 4 Series Express Chipset Family

3CO0 - 3DF Mobile Intel 4 Series Express Chipset Family

3F6 - 3F6 ATA Channel 0

400 - 47F Motherboard resources

4D0 - 4D1 Programmable interrupt controller

500 - 57F Motherboard resources

A79 - A79 ISAPNP Read Data Port

DO0O - FFFF PCl bus

1000 - 1003 Motherboard resources

1010 - 101F Motherboard resources

2000 - 20FF Marvell Yukon 88E8072 PCI-E Gigabit Ethernet Controller
2000 - 2FFF Intel ICH9 Family PCI Express Root Port 6 — 294A
3000 - 4FFF Intel ICH9 Family PCI Express Root Port 6 — 2948
5000 - 6FFF Intel ICH9 Family PCI Express Root Port 6 — 2944
7000 - 701F ICH9M-E/M SATA AHCI Controller

System I/O address specifications, Windows XP
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1/0 address (hex)

System function (shipping configuration)

7020 - 703F Intel ICH9 Family USB Universal Host Controller — 2936
7040 - 705F Intel ICH9 Family USB Universal Host Controller — 2935
7060 - 707F Intel ICH9 Family USB Universal Host Controller — 2934
7080 - 709F Intel ICH9 Family USB Universal Host Controller — 2939
70A0 - 70BF Intel ICH9 Family USB Universal Host Controller — 2938
70CO0 - 70DF Intel ICH9 Family USB Universal Host Controller — 2937
70EOQ - 70E7 ICHOM-E/M SATA AHCI Controller

70E8 - 70EF ICHOM-E/M SATA AHCI Controller

70F0 - 70F7 Mobile Intel 4 Series Express Chipset Family

70F8 - 70FB ICHOM-E/M SATA AHCI Controller

70FC - 70FF ICHOM-E/M SATA AHCI Controller

EF80 - EF9F Motherboard resources

FEOQO - FEOF Motherboard resources

FE80 - FE8F Motherboard resources

FFFF - FFFF Motherboard resources

System memory map specifications, Windows Vista

Memory address

System function

000A0000-000BFFFF

Mobile Intel 4 Series Express Chipset Family

000A0000-000BFFFF

PCI Bus

80000000-8FFFFFFF

Mobile Intel 4 Series Express Chipset Family

80000000-DFFFFFFF

PCI Bus

90000000-903FFFFF

Mobile Intel 4 Series Express Chipset Family

90400000-904FFFFF

Mobile Intel 4 Series Express Chipset Family

90500000-905FFFFF

Intel 82801 PCI Bridge — 2448

90600000-90603FFF

Marvell Yukon 88E8072 PCI-E Gigabit Ethernet
Controller

90600000-906FFFFF

Intel ICH9 Family PCI Express Port 6 — 294A

90700000-946FFFFF

Intel ICH9 Family PCI Express Port 5 — 2948

94700000-986FFFFF

Intel ICH9 Family PCI Express Port 3 — 2944

98700000-98703FFF

Broadcom 802.11b/g WLAN

98700000-987FFFFF

Intel ICH9 Family PCI Express Port 2— 2942

98800000-988FFFFF

Intel ICH9 Family PCI Express Port 1 — 2940

98900000-98903FFF

High Definition Audio Controller
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Memory address

System function

98904000-989043FF

Intel ICH9 Family USB2 Enhanced Host Controller —
293A

98904400-989047FF

Intel ICH9 Family USB2 Enhanced Host Controller —
293C

E0000000-EFFFFFFF

Motherboard resources

FO000000-FEDFFFFF

High precision event timer

FEC00000-FECOOFFF

Motherboard resources

FEDO0O000-FEDOO3FF

Motherboard resources

FED10000-FED13FFF

Motherboard resources

FED18000-FED18FFF

Motherboard resources

FED1C000-FED1FFFF

Motherboard resources

FED20000-FED3FFFF

Motherboard resources

FED40000-FED44FFF

Motherboard resources

FED45000-FED8FFFF

Motherboard resources

FEE01000-FFFFFFFF

PCI Bus

FF000000-FFFFFFFF

Intel 82802 Firmware Hub Device

System memory map specifications, Windows XP

Memory address

System function

000A0000-000BFFFF

Mobile Intel 4 Series Express Chipset Family

000A0000-000BFFFF

PCI Bus

40000000-4FFFFFFF

Mobile Intel 4 Series Express Chipset Family

40000000-DFFFFFFF

PCI Bus

50000000-503FFFFF

Mobile Intel 4 Series Express Chipset Family

50400000-504FFFFF

Mobile Intel 4 Series Express Chipset Family

50600000-50603FFF

Marvell Yukon 88E8072 PCI-E Gigabit Ethernet
Controller

50600000-506FFFFF

Intel ICH9 Family PCI Express Port 6 — 294A

50700000-546FFFFF

Intel ICH9 Family PCI Express Port 5 — 2948

54700000-586FFFFF

Intel ICH9 Family PCI Express Port 3 — 2944

58700000-58703FFF

Broadcom 4322AG 802.11a/b/g/draft-n Wi-Fi
Adapter

58700000-587FFFFF

Intel ICH9 Family PCI Express Port 2— 2942

58800000-588FFFFF

Intel ICH9 Family PCI Express Port 1 — 2940

58900000-58903FFF

Microsoft UAA Bus Driver for High Definition Audio
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Memory address

System function

58904000-589047FF

Intel ICM9M-E/M SATA AHCI Controller

58904800-58904BFF

Intel ICH9 Family USB2 Enhanced Host Controller —
293A

58904C00-58904FFF

Intel ICH9 Family USB2 Enhanced Host Controller —
293C

E0000000-EFFFFFFF

Motherboard resources

FO000000-FEDFFFFF

PCI Bus

FECO00000-FECOOFFF

Motherboard resources

FEDO000O-FEDOO3FF

High Precision Event Timer

FED10000-FED13FFF

Motherboard resources

FED18000-FED18FFF

Motherboard resources

FED19000-FED19FFF

Motherboard resources

FED1CO000-FED1FFFF

Motherboard resources

FED20000-FED3FFFF

Motherboard resources

FED40000-FED44FFF

Motherboard resources

FED45000-FED8FFFF

Motherboard resources

FEEO01000-FFFFFFFF

PCI Bus

FF000000-FFFFFFFF

Intel 82802 Firmware Hub Device
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7 Screw listing

This chapter provides specification and reference information for the screws used in the computer. All
screws listed in this section are available in the Screw Kit, spare part number 535870-001.

Torx T8M2.5%6.0 screw

=@®  [fom

mm Lol ol

Color Quantity Length Thread Head diameter

1

Silver 19 6.0 mm 2.5mm 5.0 mm

Where used: 19 screws that secure the top cover to computers equipped with 15-in displays
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Torx T8M2.5%4.0 screw

SON

mm ool

Color Quantity Length Thread Head diameter

Silver 2 4.0 mm 2.5 mm 5.0 mm

Where used: 2 screws that secure the top cover to computers equipped with 15-in displays
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Phillips PM2.0%2.0 screw

=® b

mm Lot

Color Quantity Length Thread Head diameter

Black 3 2.0 mm 2.0 mm 5.0 mm

Where used: 3 screws that secure the top cover to the computer

Phillips PM2.0%3.0 screw

=® [o

mm Lot

Color Quantity Length Thread Head diameter

Silver 19 3.0 mm 2.0 mm 5.0 mm

Phillips PM2.0%x2.0 screw 147
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-

Where used: 2 screws that secure the optical drive bracket to the optical drive

Where used: 6 screws that secure the display hinges to the 14-in display assembly
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Where used: 3 screws that secure the fan to the heat sink

Phillips PM2.0x3.0 screw

® [

annnmnmnmm

Color Quantity Length Thread Head diameter

Black 2 3.0 mm 2.0 mm 5.0 mm

Where used: 2 screws that secure the switch cover to computers with 14-in displays

Phillips PM2.0%3.0 screw 149



Phillips PM2.5%6.0 screw

.W

3 ()

Color Quantity Length Thread Head diameter

Black 15 (15-in models) or 30 6.0 mm 2.5mm 5.0 mm
(14-in models)

Where used:
(1) Six screws that secure the 15-in display to the computer

(2) One screw that secures the optical drive to the computer
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Where used: 8 screws that secure the display bezel to the display enclosure

Where used: 21 screws that secure the top cover to the base enclosure on computers with 14-in
displays

Phillips PM2.5%11.0 captive screw

annnmnmnmm

Color Quantity Length Thread Head diameter

Black 1 11.0 mm 2.5 mm 5.0 mm

Where used: One captive screw (secured by a C-clip) that secures the hard drive to the computer
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Phillips PM3.0%4.0 screw

=@ [m

mm Loohotondonl

Color Quantity Length Thread Head diameter

Silver 4 4.0 mm 3.0 mm 5.0 mm

Where used: 4 screws that secure the hard drive bracket to the hard drive
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Phillips PM2.0%4.0 screw

SON

mm Lol

Color Quantity Length Thread

Head diameter

Silver 4 4.0 mm 2.0 mm

5.0 mm

Where used: 2 screws that secure the hard drive to the computer

L
1

Where used: 2 screws that secure the top cover to the computer
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Phillips PM2.5%3.0 screw

=® [p

mm Lol

Color Quantity Length Thread Head diameter

Black 17 (15-in models) or 18 3.0 mm 2.5mm 5.0 mm
(14-in models)

Where used: 2 screws that secure the WLAN module to the system board

Where used: 2 screws that secure the WWAN module to the system board
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Where used: 2 screws that secure the switch cover to the computer

Where used: 2 screws that secure the keyboard to computers with 15-in displays

Phillips PM2.5%3.0 screw 155



Where used: 4 screws that secure the speakers to the computer

Where used: One screw that secures the USB connector assembly to the computer
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Where used: 2 screws that secure the SIM to the computer

Phillips PM2.5%4.5 screw

%@ =

Color Quantity Length Thread Head diameter

Black 4 (15-in models) or 4.5 mm 2.5mm 5.0 mm

7 (14-in models)

Phillips PM2.5%4.5 screw 157



Where used: 4 screws that secure the display assembly to computers with 14-in displays

Where used: 4 screws that secure the display panel to the 15-in display enclosure

T
|
|
|
Bl

Where used: 2 screws that secure the display bezel to the 14-in display enclosure
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Where used: One screw in the right rear that secures the top cover to computers with 14-in displays

Phillips PM2.5%4.5 screw 159



Phillips PM2.5%3.0 broadhead screw

® o

mm Loohotondonl

Color Quantity Length Thread Head diameter

Black 9 (15-in models) or 3.0 mm 2.5mm 7.0 mm

5 (14-in models)

Where used: 2 screws that secure the system board to computers with 15-in displays

Where used: 3 screws that secure the system board to computers with 14-in displays
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Where used: 5 screws that secure the switch cover to computers with 15-in displays

Where used: 2 screws that secure the switch cover and power button board to the computer

Phillips PM2.5%3.0 broadhead screw 161



Phillips PM2.5%7.0 screw

SON I

mm Lol

Color Quantity Length Thread Head diameter

Black 1 7.0 mm 2.5 mm 5.0 mm

Where used: One screw that secures the USB connector assembly to the computer
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Phillips PM2.5%9.0 captive screw

SON

mm oot

Color Quantity Length Thread

Head diameter

Silver 7 (discrete) or 5 (UMA) 9.0 mm 2.5mm

5.0 mm

B 11

2]

Where used: 7 screws that secure the heat sink to the system board for computers with discrete memory
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Where used: 5 screws that secure the heat sink to the system board for computers with UMA memory
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Phillips PM3.0%8.0 screw

=®  [mm

mm Lot

Color Quantity Length Thread Head diameter

Black 1 8.0 mm 3.0 mm 5.0 mm

Where used: One screw that secures the USB connector assembly to the computer

Phillips PM3.0%8.0 screw 165



8 Backup and recovery

Backup and recovery in Windows Vista

Overview

To protect your information, use the Backup and Restore Center to back up individual files and folders,
back up your entire hard drive (select models only), or create system restore points. In case of system
failure, you can use the backup files to restore the contents of your computer.

The Backup and Restore Center provides the following options:
e  Backing up individual files and folders

e Backing up the entire hard drive (select models only)

e  Scheduling automatic backups (select models only)

e Creating system restore points

e Recovering individual files

e Restoring the computer to a previous state

e Recovering information using recovery tools

Bf NOTE: For detailed instructions, perform a search for these topics in Help and Support.

NOTE: In case of system instability, HP recommends that you print the recovery procedures and save
them for later use.

Backing up your information

Recovery after a system failure is as complete as your most current backup. You should create your
initial backup immediately after software setup. As you add new software and data files, you should
continue to back up your system on a regular basis to maintain a reasonably current backup.

You can back up your information to an optional external hard drive, a network drive, or discs.
Note the following when backing up:

e  Store personal files in the Documents folder, and back it up regularly.

e Back up templates that are stored in their associated programs.

e  Save customized settings that appear in a window, toolbar, or menu bar by taking a screen shot
of your settings. The screen shot can be a time-saver if you have to reset your preferences.
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To create a screen shot:

1. Display the screen you want to save.

2. Copy the screen image:
To copy only the active window, press alt+fn+prt sc.
To copy the entire screen, press fn+prt sc.

3.  Open a word-processing document, and then select Edit > Paste.
The screen image is added to the document.

4. Save the document.

e  When backing up to discs, use any of the following types of discs (purchased separately): CD-R,
CD-RW, DVD+R, DVD+R DL, DVD-R, DVD-R DL, or DVD+RW. The discs you use will depend on
the type of optical drive installed in your computer.

Bf NOTE: DVDs and DVDs with double-layer (DL) support store more information than CDs, so
using them for backup reduces the number of recovery discs required.

e When backing up to discs, number each disc before inserting it into the optical drive of the computer.

To create a backup using Backup and Restore Center, follow these steps:

Bf NOTE: Be sure that the computer is connected to AC power before you start the backup process.

NOTE: The backup process may take over an hour, depending on file size and the speed of the
computer.

1. Select Start > All Programs > Maintenance > Backup and Restore Center.

2. Follow the on-screen instructions to back up your entire computer (select models only) or your files.

B NOTE: Windows® includes the User Account Control feature to improve the security of your
computer. You may be prompted for your permission or password for tasks such as installing
software, running utilities, or changing Windows settings. Refer to Help and Support for more
information.

Performing a recovery
In case of system failure or instability, the computer provides the following tools to recover your files:

e Windows recovery tools: You can use the Backup and Restore Center to recover information you
have previously backed up. You can also use Windows Startup Repair to fix problems that might
prevent Windows from starting correctly.

e 11 recovery tools: You can use the f11 recovery tools to recover your original hard drive image.
The image includes the Windows operating system and software programs installed at the factory.

Bf NOTE: If you are unable to boot (start up) your computer, you must purchase a Windows Vista®
operating system DVD to reboot the computer and repair the operating system. For additional
information, refer to the “Using a Windows Vista operating system DVD (purchased separately)” section
in this guide.
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Using the Windows recovery tools
To recover information you previously backed up, follow these steps:
1.  Click Start > All Programs > Maintenance > Backup and Restore Center.

2. Follow the on-screen instructions to recover your entire computer (select models only) or your files.

NOTE: Windows includes the User Account Control feature to improve the security of your computer.
You may be prompted for your permission or password for tasks such as installing software, running
utilities, or changing Windows settings. Refer to Help and Support for more information.

To recover your information using Startup Repair, follow these steps:

/A CAUTION: Using Startup Repair completely erases hard drive contents and reformats the hard drive.
All files you have created and any software installed on the computer are permanently removed. When
reformatting is complete, the recovery process restores the operating system, as well as the drivers,
software, and utilities from the backup used for recovery.

1. If possible, back up all personal files.

2. If possible, check for the presence of the Windows partition and the HP Recovery partition. To find
the partitions, select Start > Computer.

B NOTE: If the Windows partition and the HP Recovery partition have been deleted, you must
recover your operating system and programs using the Windows Vista operating system DVD and
the Driver Recovery disc (both purchased separately). For additional information, refer to the “Using
a Windows Vista operating system DVD (purchased separately)” section in this guide.

3. Restart the computer, and then press f8 before the Windows operating system loads.
4. Select Repair your computer.

5. Follow the on-screen instructions.

B NOTE: Foradditionalinformation on recovering information using the Windows tools, perform a search
for these topics in Help and Support.

Using f11

/A CAUTION: Usingf11 completely erases hard drive contents and reformats the hard drive. All files you
have created and any software installed on the computer are permanently removed. The 11 recovery
tool reinstalls the operating system and HP programs and drivers that were installed at the factory.
Software not installed at the factory must be reinstalled.

To recover the original hard drive image using 11, follow these steps:
1. If possible, back up all personal files.

2. If possible, check for the presence of the HP Recovery partition. To find the partition, select
Start > Computer.

Bf NOTE: If the HP Recovery partition has been deleted, you must recover your operating system
and programs using the Windows Vista operating system DVD and the Driver Recovery disc (both
purchased separately). For additional information, refer to the “Using a Windows Vista operating
system DVD (purchased separately)” section in this guide.

3. Turnon orrestart the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.
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4. Press 11 while the “Press <F11> for recovery” message is displayed on the screen.

5. Follow the on-screen instructions.

Using a Windows Vista operating system DVD (purchased separately)

If you are unable to boot (start up) your computer, you must purchase a Windows Vista operating system
DVD to reboot the computer and repair the operating system. Make sure that your most recent backup
(stored on discs or on an external drive) is easily accessible. To order a Windows Vista operating system
DVD, go to http://www.hp.com/support, select your country or region, and follow the on-screen
instructions. You can also order the DVD by calling technical support. For contact information, refer to
the Worldwide Telephone Numbers booklet included with the computer.

/\ CAUTION: Using a Windows Vista operating system DVD completely erases hard drive contents and
reformats the hard drive. All files you have created and any software installed on the computer are
permanently removed. When reformatting is complete, the recovery process helps you restore the
operating system, as well as drivers, software, and utilities.

To initiate recovery using a Windows Vista operating system DVD, follow these steps:

= NOTE: This process takes several minutes.

1. If possible, back up all personal files.

2. Restart the computer, and then insert the Windows Vista operating system DVD into the optical
drive before the Windows operating system loads.

When prompted, press any keyboard key.
Follow the on-screen instructions.
Click Next.

Select Repair your computer.

N o g M v

Follow the on-screen instructions.
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Backup and recovery in Windows XP

Overview

To protect your information, use the Windows® Backup utility (select models only) to back up files and
folders or create recovery points. In case of system failure, you can use the backup files to restore your
computer.

Windows provides the following options:

e  Backing up individual files and folders
e Backing up all files and folders

e  Scheduling automatic backups

e Creating recovery points

e Recovering information

= NOTE: For detailed instructions, perform a search for these topics in Help and Support.

NOTE: In case of system instability, HP recommends that you print the recovery procedures and save
them for later use.

Backing up your information

Recovery after a system failure is as complete as your most current backup. You should create your
initial backup immediately after software setup. As you add new software and data files, you should
continue to back up your system on a regular basis to maintain a reasonably current backup.

You can back up individual files or folders to an optional external hard drive or to a network drive.
Note the following when backing up:

e  Store personal files in the My Documents folder, and back it up periodically.

e Back up templates stored in their associated programs.

e  Save customized settings that appear in a window, toolbar, or menu bar by taking a screen shot
of your settings. The screen shot can be a time saver if you have to reset your preferences.

To copy the screen and paste it into a word-processing document:
a. Display the screen you want to save.
b. Copy the screen image:
To copy only the active window, press alt+fn+prt sc.
To copy the entire screen, press fn+prt sc.
c. Open a word-processing document, click Edit > Paste.
The screen image is added to the document.
d. Save the document.

To create a backup using the Windows Backup utility (select models only), follow these steps:
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B NOTE: Be sure that the computer is connected to AC power before you start the backup process.

NOTE: The backup process may take over an hour, depending on file size and the speed of the
computer.

1.
2,

Click Start > All Programs > Accessories > System Tools > Backup.

Follow the on-screen instructions.

Performing a recovery

In case of system failure or instability, the computer provides the following tools to recover your files:

Windows recovery tools (select models only): You can use the Windows Backup utility to recover
information you have previously backed up.

Operating System and Driver Recovery discs (included with your computer): You can use the discs
to recover your operating system and programs installed at the factory.

Recovering your information

To recover information you previously backed up, follow these steps:

1.
2,

3.
4.

If possible, back up all personal files.

Click Start > All Programs > Accessories > System Tools > Backup.
The Backup or Restore Wizard opens.

Click Restore files and settings, and then click Next.

Follow the on-screen instructions.

B NOTE: For additional information on initiating a recovery in Windows, perform a search for this topic
in Help and Support.

Recovering the operating system and programs

/A CAUTION: The recovery process reformats and completely erases the hard drive. All files you have
created and any software installed on the computer are permanently removed. The recovery process
reinstalls the original operating system, software, and drivers. Software, drivers, and updates not
installed by HP must be manually reinstalled.

To recover your operating system and programs, follow these steps:

1.

2
3
4.
5
6

If possible, back up all personal files.

Insert the Operating System disc into the optical drive.

Shut down the computer.

Turn on the computer.

Follow the on-screen instructions to install the operating system.

After the operating system is installed, remove the Operating System disc and insert the Driver
Recovery disc.

Follow the on-screen instructions to install the drivers and programs.
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9 Connector pin assignments

Audio-in (microphone)

Pin Signal
1 Audio signal in
2 Audio signal in
3 Ground

Audio-out (headphone)

Pin Signal

1 Audio out, left channel
2 Audio out, right channel
3 Ground
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External monitor

®OO00®
®000 W
©000G

Pin Signal

1 Red analog

2 Green analog
3 Blue analog

4 Not connected
5 Ground

6 Ground analog
7 Ground analog
8 Ground analog
9 +5VDC

10 Ground

11 Monitor detect
12 DDC 2B data
13 Horizontal sync
14 Vertical sync
15 DDC 2B clock
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HDMI

1917151311 &9 7 5 3 1

NrATATATAVATATATATAS

1816 1412 10 8 & 4 2

Pin Signal

1 Transition minimized differential signal (TMDS) data 2+
2 TMDS data 2 shield

3 TMDS data 2—

4 TMDS data 1+

5 TMDS data 1 shield

6 TMDS data 1-

7 TMDS data 0+

8 TMDS data 0 shield

9 TMDS data 0—

10 TMDS clock+

11 TMDS clock shield

12 TMDS clock-

13 Consumer electronic control (CEC)
14 Not connected

15 DDC clock

16 DDC data

17 Ground

18 +5V power

19 Hot plug detect
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RJ-11 (modem)

123456

Pin

Signal

Unused

Tip

Ring

Unused

Unused

o | 0| A~ | W N |-

Unused
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RJ-45 (network)

LLTETTT
12345678
g —

Pin Signal
1 Transmit +
2 Transmit -
3 Receive +
4 Unused
5 Unused
6 Receive -
7 Unused
8 Unused

Universal Serial Bus

1 2 3 4
I-_-_-_-.I

Pin Signal
1 +5VDC
2 Data -
3 Data +
4 Ground
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10 Power cord set requirements

The wide range input feature of the computer permits it to operate from any line voltage from 100 to 120
volts AC or from 220 to 240 volts AC.

The 3-conductor power cord set included with the computer meets the requirements for use in the
country or region where the equipment is purchased.

Power cord sets for use in other countries and regions must meet the requirements of the country or
region where the computer is used.

Requirements for all countries and regions

The requirements listed below are applicable to all countries and regions:
e The length of the power cord set must be at least 1.5 m (5.0 ft) and no more than 2.0 m (6.5 ft).

e All power cord sets must be approved by an acceptable accredited agency responsible for
evaluation in the country or region where the power cord set will be used.

e The power cord sets must have a minimum current capacity of 10 amps and a nominal voltage
rating of 125 or 250 V AC, as required by the power system of each country or region.

e The appliance coupler must meet the mechanical configuration of an EN 60 320/IEC 320 Standard
Sheet C13 connector for mating with the appliance inlet on the back of the computer.
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Requirements for specific countries and regions

Country/region Accredited agency Applicable note number
Australia EANSW 1
Austria OVE 1
Belgium CEBC 1
Canada CSA 2
Denmark DEMKO 1
Finland FIMKO 1
France UTE 1
Germany VDE 1
Italy IMQ 1
Japan METI 3
The Netherlands KEMA 1
Norway NEMKO 1
The People's Republic of China CCC 5
South Korea EK 4
Sweden SEMKO 1
Switzerland SEV 1
Taiwan BSMI 4
The United Kingdom BSI 1
The United States uL 2
1. The flexible cord must be Type HO5VV-F, 3-conductor, 1.0-mm? conductor size. Power cord set fittings (appliance coupler

and wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it
will be used.

The flexible cord must be Type SPT-3 or equivalent, No. 18 AWG, 3-conductor. The wall plug must be a two-pole grounding
type with a NEMA 5-15P (15 A, 125 V) or NEMA 6-15P (15 A, 250 V) configuration.

The appliance coupler, flexible cord, and wall plug must bear a “T” mark and registration number in accordance with the
Japanese Dentori Law. The flexible cord must be Type VCT or VCTF, 3-conductor, 1.00-mm? conductor size. The wall
plug must be a two-pole grounding type with a Japanese Industrial Standard C8303 (7 A, 125 V) configuration.

The flexible cord must be Type RVV, 3-conductor, 0.75-mm? conductor size. Power cord set fittings (appliance coupler
and wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it
will be used.

The flexible cord must be Type VCTF, 3-conductor, 0.75-mm? conductor size. Power cord set fittings (appliance coupler
and wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it
will be used.
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11 Recycling

Battery

When a battery has reached the end of its useful life, do not dispose of the battery in general household
waste. Follow the local laws and regulations in your area for computer battery disposal.

Display

/A WARNING! The backlight contains mercury. Exercise caution when removing and handling the
backlight to avoid damaging this component and causing exposure to the mercury.

/A CAUTION: The procedures in this chapter can result in damage to display components. The only
components intended for recycling purposes are the liquid crystal display (LCD) panel and the backlight.
When you remove these components, handle them carefully.

Bf NOTE: Materials Disposal. This HP product contains mercury in the backlight in the display assembly
that might require special handling at end-of-life. Disposal of mercury may be regulated because of
environmental considerations. For disposal or recycling information, contact your local authorities, or
see the Electronic Industries Alliance (EIA) Web site at http://www.eiae.org.

This section provides disassembly instructions for the display assembly. The display assembly must be
disassembled to gain access to the backlight (1) and the liquid crystal display (LCD) panel (2).

9 -

Bf NOTE: The procedures provided in this chapter are general disassembly instructions. Specific details,
such as screw sizes, quantities, and locations, and component shapes and sizes, can vary from one
computer model to another.
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Perform the following steps to disassemble the display assembly:

1. Remove all screw covers (1) and screws (2) that secure the display bezel to the display assembly.

2. Lift up and out on the left and right inside edges (1) and the top and bottom inside edges (2) of the
display bezel until the bezel disengages from the display assembly.

3.  Remove the display bezel (3).
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Disconnect all display panel cables (1) from the display inverter and remove the inverter (2).

Remove all screws (1) that secure the display panel assembly to the display enclosure.

Remove the display panel assembly (2) from the display enclosure.

!
i-

Turn the display panel assembly upside-down.

Remove all screws that secure the display panel frame to the display panel.

Use a sharp-edged tool to cut the tape (1) that secures the sides of the display panel to the display
panel frame.
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10. Remove the display panel frame (2) from the display panel.

11. Remove the screws (1) that secure the backlight cover to the display panel.

12. Lift the top edge of the backlight cover (2) and swing it outward.

o

=3

13. Remove the backlight cover.

14. Turn the display panel right-side up.
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15. Remove the backlight cables (1) from the clip (2) in the display panel.

16. Turn the display panel upside-down.

/A WARNING! The backlight contains mercury. Exercise caution when removing and handling the
backlight to avoid damaging this component and causing exposure to the mercury.

17. Remove the backlight frame from the display panel.
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18. Remove the backlight from the backlight frame.

19. Disconnect the display panel cable (1) from the LCD panel.
20. Remove the screws (2) that secure the LCD panel to the display rear panel.
21. Release the LCD panel (3) from the display rear panel.

22. Release the tape (4) that secures the LCD panel to the display rear panel.

24. Recycle the LCD panel and backlight.
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Index

A
AC adapter, identifying 22, 33
AC adapter, spare part numbers
50
antenna, disconnecting 74, 82
applications key, Windows 15,
16
audio, product description 5
audio-in (microphone) jack
identifying 17, 29
pin assignments 172
audio-out (headphone) jack
identifying 17, 29
pin assignments 172

B
backing up
Windows Vista 166
Windows XP 170
Backup and Restore Center
167
base enclosure, spare part
number 42, 51
battery
removal 63
spare part number
52, 53, 63
battery bay 20, 31
battery light, identifying
battery release latches,
identifying 20, 31
battery, identifying 22, 33
bays, battery 20, 31
BIOS administrator
password 119
Blu-ray Disc ROM Combo Drive
removal 69
spare part number
52, 69
specifications 135

166,

42, 50,

18, 29

42, 46,

Bluetooth module
removal iii
spare part number 48, iii
Bluetooth module cable,
illustrated 45
boot options 121, 127
boot order 121, 127
built-in device
Bluetooth device radio 122
embedded WLAN 122
integrated camera 122
LAN/WLAN switching 122
microphone 122
modem 122
Network Interface Controller
(LAN) 122
optical disc drive 122
options 122
Wake on LAN 122
wireless button 122
WWAN device radio 122
buttons
Info Center 14, 26
power 14, 26
QuickLook 14, 26
TouchPad 12, 24
wireless 17

C
Cable Kit

contents 45

spare part number 45, 53
cables, service considerations 57
caps lock light, identifying 13, 25
chipset, product description 2
components

additional hardware 22, 33

bottom 20, 31

display 11, 23

front 17, 28

left-side 19, 30
right-side 18, 29
top 12, 24

wireless antennas 21, 32
computer feet

locations 62

spare part number 62
Computer Setup

accessing 116, 123

Diagnostics menu 120, 126

File menu 118, 125

navigating and selecting 116,

124

restoring factory settings 117,
124
Security menu 119, 126

System Configuration

menu 121, 127

using 116, 124
computer specifications 129
connector, power 18, 29
connectors, service
considerations 57
cord, power 22, 33

D
device configurations 121
Diagnostics menu 120, 126
discs

Driver Recovery 171

Operating System 171
Disk Sanitizer 119
diskette drive

precautions 57

product description 5
display assembly

removal iii, 84

spare part numbers 35, 36,

50, iii, 84
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display bezel
removal 86, 98
spare part number 86, 99
Display Cable Kit, spare part
number 52
display component recycling 179
Display Hinge Kit, spare part

number 51, 88, 100
display panel
removal 88, 100

spare part number 51
display specifications 130, 131
drive light, identifying 17, 28
DriveLock

automatic 119

password 119
Driver Recovery disc 171
drives

boot order 121, 127

optical 18, 29

preventing damage 57
Dual Core CPU 121
DVD-ROM Drive

removal 69

spare part number

52, 69

specifications 133

DVD£RW Double-Layer Drive with
LightScribe

precautions 57

removal 69

spare part number 42, 46,

52, 69

specifications 134

42, 46,

E

electrostatic discharge 58

errorlog 120

esc key, identifying
28

Ethernet, product description 5

Execution Disable 121

ExpressCard assembly, spare part
number 37

ExpressCard slot bezel,
illustrated 44

ExpressCard slot, identifying 19,
30

external media cards, product
description 6

15, 16, 27,
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external monitor port
identifying 19, 30
pin assignments 173

F
f11 recovery 168
fan
removal 109
spare part number
109

37, 50,

feet
locations 62
spare part number 62
File menu 118, 125
fn key, identifying 15, 16, 27,
28
function keys, identifying
27, 28

15, 16,

G

graphics, product description 2

grounding equipment and
methods 60

H
hard disk test 120
hard drive
precautions 57
product description 5
removal iii
spare part numbers 42, 46,
51, 52, 53, iii
specifications 132
hard drive bracket, removal 79
hard drive recovery 168
HDMI port, pin assignments 174
headphone (audio-out) jack
pin assignments 172
heat sink
removal 106
spare part number
51, 106
hinge, spare part number 88,
100
HP Mobile Broadband Module
spare part number 48
HP QuickLook 2 121
HP SpareKey enrollment 119

37, 50,

I

I/0O address specifications
Windows Vista 138
Windows XP 140

Info Center/QuickLook button,
identifying 14, 26

Info Center/QuickLook light,
identifying 13, 25

internal display switch,
identifying 11, 14, 23, 26

internal microphone,
identifying 11, 23

interrupt specifications
Windows Vista 136
Windows XP 137

J
jacks
audio-in (microphone) 17, 29
audio-out (headphone) 17,
29
RJ-11 (modem)
RJ-45 (network)

18, 29
19, 30

K

keyboard
product description 7
removal 64

spare part number 37, 51,
52, 64
keypad keys, identifying 15, 16,
27, 28
keys

esc 15, 16, 27, 28

fn 15, 16, 27, 28

function 15, 16, 27, 28
keypad 15, 16, 27, 28
Windows applications 15, 16
Windows logo 15, 16

L

language, changing in Computer
Setup 121

latches, battery release 20, 31

legacy support, USB 116, 121,
123, 127
lights

battery 18, 29

caps lock 13, 25

drive 17, 28

Info 13



Info Center/QuickLook 25
optical drive 18, 29
power 13, 25
QuickLook 13
QuickLook/Info Center 25
webcam 11, 23
wireless 17, 28

M
mass storage devices, spare part
numbers iii
Media Card Reader,
identifying 17, 28
memory map specifications
Windows Vista 142
Windows XP 143
memory module
product description 3
removal iii
spare part numbers 52, 55,
iii
microphone (audio-in) jack
identifying 17, 29
pin assignments 172
model name 1
modem jack, pin
assignments 175
modem module
product description 5
removal 103
spare part numbers 37, 103
monitor port
external 19, 30
pin assignments 173

N
network jack, pin
assignments 176

(0]

Operating System disc 171

operating system, product

description 7

optical drive
identifying 18, 29
precautions 57
product description 5
removal 69
spare part number 42, 46,

69

specifications 133, 134, 135

optical drive bezel, illustrated 44
optical drive connector
removing 114

spare part number
114
optical drive light, identifying 18,
29

39, 51,

P
packing guidelines 59
palm rest
removal 75
spare part numbers 51, 54,
75
panels, product description 2
passwords 119, 126
pin assignments
audio-in jack 172
audio-out (headphone)
jack 172
external monitor port 173
HDMI 174
headphone (audio-out)
jack 172
microphone (audio-in)
jack 172
modem jack 175
monitor port 173
network jack 176
RJ-11 175
RJ-45 (network) jack 176
Universal Serial Bus (USB)

port 176
plastic parts 56
Plastics Kit

contents 44
spare part number 44, 50
pointing devices, product
description 7
port options
ExpressCard slot 122
flash media reader 122
USB port 122
ports
external monitor
HDMI 19, 30
product description 6
USB 18, 19, 29, 30

19, 30

power button board

removal 94

spare part number 94
power button board cable,
illustrated 45
power button, identifying 14, 26
power cable, illustrated 45
power connector, identifying 18,
29
power cord

set requirements 177

spare part numbers 47, 48
power cord, identifying 22, 33
power light, identifying 13, 25
power requirements, product
description 7
processor

product description 1

removal iii

spare part numbers 38, 39,

49, 50, 54, iii, 110
product description

audio 5

chipset 2

diskette drive 5

Ethernet 5

external media cards 6

graphics 2

hard drives 5

keyboard 7

memory module 3

modem module 5

operating system 7

optical drives 5

panels 2

pointing devices 7

ports 6

power requirements 7

processors 1

product name 1

security 7

serviceability 10

wireless 5
product name 1

Q

QuickLook/Info Center button,
identifying 14, 26

QuickLook/Info Center light,
identifying 13, 25
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R
recovery partition 168
release latches, battery 20, 31
removal/replacement
preliminaries 56
procedures 61
restore security defaults 122
restore the factory settings 118
restoring the hard drive 168
RJ-11 (modem) jack
identifying 18, 29
pin assignments 175
RJ-11(modem) jack cable,
illustrated 45
RJ-45 (network) jack
identifying 19, 30
pin assignments 176
RJ-45 (network) jack cable
illustrated 45
RTC battery
removal 96
spare part number
96
Rubber Kit, spare part
number 42, 50
run-in test 120

41, 48,

S
SATA (Serial Advanced
Technology Attachment) devices
AHCI (Advanced Host Controller
Interface) 121
IDE (Integrated Drive
Electronics) 121
Screw Kit
contents 145

spare part number 47, 51
screw listing 145
scroll zone, TouchPad 12, 24

security cable slot, identifying 19,
30
Security menu
allow reset of HP ProtectTools
security keys 119
always prompt for HP SpareKey
enrollment 119
Automatic DriveLock 119
change password 119
Disk Sanitizer 119
DriveLock 119
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HP Sparekey 119

HP Sparekey enrollment 119

password policy 119

set up BIOS administrator

password 119

System IDs 119

user management 119
security, product description 7
service considerations 56
service tag, location 34, 61
serviceability, product

description 10

set security level 122

setup utility
Diagnostics menu 120, 126
File menu 118, 125

navigating and selecting 116,
124

restoring factory settings 117,
124

Security menu 119, 126

System Configuration
menu 121, 127

SIM
removal 114

spare part number 41, 53,
114
slots
ExpressCard 19, 30
security cable 19, 30
speakers
identifying 14, 26
removal 73
spare part number 37, 52,
53, 73
specifications

Blu-ray Disc ROM Combo
Drive 135

computer 129

display 130, 131

DVD-ROM Drive 133

DVDzRW Double-Layer Drive
with LightScribe 134

hard drive 132

I/O addresses, Windows
Vista 138

I/O addresses, Windows
XP 140

interrupts, Windows Vista 136

interrupts, Windows XP 137

memory map, Windows
Vista 142
memory map, Windows
XP 143
optical drive 133, 134, 135
system DMA 136
start-up test 120
static-shielding materials 60
stringent security 126
switch cover
removal 64
spare part number
54, 64
switch, wireless 28
system board
removal iii
spare part numbers 37, 50,
51, 54, iii
System Configuration menu
127
system date and time 118
System Diagnostics menu 120
system DMA 136
system fan 121, 127
system IDs 119
system information 118, 125
system memory map 142, 143

36, 51,

121,

T
thermal material,
replacement 107, 108
tools required 56
top cover
removal iii
spare part number
TouchPad buttons,
identifying 12, 24
TouchPad cable, illustrated 45
TouchPad scroll zone,
identifying 12, 24
TouchPad, identifying 12, 24
transporting guidelines 59

37, 51, iii

U
Unified Extensible Firmware
Interface (UEFI) mode 121
USB cable,
illustrated 45
spare part number 45



USB connector assembly
removal 104
spare part number 104
USB legacy support 116, 121,
123, 127
USB port
identifying 18, 19, 29, 30
pin assignments 176

\"
vents, identifying 19, 30
Virtualization Technology 121

w
webcam light, identifying 11, 23
webcam module, spare part
number 50
webcam, identifying 11, 23
Windows applications key,
identifying 15, 16
Windows Backup utility 170, 171
Windows logo key, identifying 15,
16
Windows recovery 167, 171
Windows Vista operating system
DVD 169
wireless antenna,
disconnecting 74, 82
wireless light, identifying 17, 28
wireless switch, identifying 17,
28
wireless, product description 5
WLAN antennas, identifying 21,
32
WLAN module
removal iii
spare part numbers 39, iii
workstation guidelines 59
WWAN antennas, identifying 21,
32
WWAN module
removal 74
spare part number 74
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